Dolphin® 9500 Series
Microsoft® Windows Mobile® 5.0

User’s Guide
# Table of Contents

## Chapter 1 - Agency Approvals

- Compliance Label Locations ................................................................................................................... 1-1
- Laser Safety Label ................................................................................................................................. 1-1
- Regulatory and Safety Approvals for all Dolphin 9500 Series Terminals ................................................. 1-2
- FCC Compliance ................................................................................................................................. 1-3

## Chapter 2 - Getting Started

- Overview ............................................................................................................................................... 2-1
- Using the Dolphin Terminal for the First Time ..................................................................................... 2-2
- Resetting the Terminal .......................................................................................................................... 2-6
  - Soft Reset (Warm Boot) ......................................................................................................................... 2-6
  - Hard Reset (Cold Boot) ......................................................................................................................... 2-6
- Suspend Mode ...................................................................................................................................... 2-6

## Chapter 3 - Hardware Overview

- Dolphin 9500 Series Terminals .............................................................................................................. 3-1
- Dolphin 9500 Series Models and Options ............................................................................................. 3-1
- Dolphin 9500 Series Peripherals .......................................................................................................... 3-2
- Dolphin 9500 Series Accessories ........................................................................................................ 3-3
- Front Panel Features ............................................................................................................................. 3-4
- Back Panel Features .............................................................................................................................. 3-6
- Side Panel Features ............................................................................................................................... 3-10
- Bottom Panel Features ......................................................................................................................... 3-11
  - Mechanical Connector ....................................................................................................................... 3-11
- Dolphin 9501 and Dolphin 9551 .......................................................................................................... 3-11
- Using the Touch Panel .......................................................................................................................... 3-12
  - Installing Your Screen Protector ....................................................................................................... 3-12
- Batteries ................................................................................................................................................ 3-14
  - Main Battery Pack .............................................................................................................................. 3-14
  - Internal Backup Battery ...................................................................................................................... 3-14
- Managing Battery Power ....................................................................................................................... 3-15
  - Default Critical and Low Battery Points ............................................................................................ 3-15
  - Checking Battery Power ..................................................................................................................... 3-16
- Storing Batteries ................................................................................................................................... 3-16
  - Guidelines for Battery Use and Disposal ........................................................................................... 3-16
- Dolphin 9500 Series Technical Specifications ..................................................................................... 3-17

## Chapter 4 - Using Dolphin Mobile Computers

- Today Screen .......................................................................................................................................... 4-1
- Navigation Bar and Start Menu ............................................................................................................. 4-1
- Using the Image Engine ........................................................................................................................ 4-2
  - Dolphin 9500/9550 Image Engine Specifications ........................................................................ 4-2
  - Bar Code Symbologies Supported ..................................................................................................... 4-3
  - Decoding ............................................................................................................................................. 4-4
  - Capturing Images ............................................................................................................................... 4-6
- Pop-Up Menus ....................................................................................................................................... 4-7
- Selecting Programs ............................................................................................................................... 4-7
- Using the Soft Input Panel (SIP) ........................................................................................................... 4-8

---

*Dolphin® 9500 Series User's Guide*  
iii
Chapter 5 - Using Dolphin Keyboards

Keyboard Options .................................................................................................................. 5-1
   Common Buttons .............................................................................................................. 5-1
   Keyboard Combinations ................................................................................................. 5-1
Using the Function Keys ........................................................................................................ 5-2
Using the Navigation Keys ..................................................................................................... 5-3
Using the Modifier Keys ......................................................................................................... 5-3
35-Key Numeric/Alpha Keyboard .......................................................................................... 5-5
   35-Key Blue Key Combinations ...................................................................................... 5-6
   35-Key Alpha Mode Key Combinations ........................................................................... 5-6
43-Key Alpha/Numeric Keyboard ............................................................................................ 5-7
   43-Key Blue Key Combinations ...................................................................................... 5-8
   43-Key Red Key Combinations ...................................................................................... 5-8
   43-Key Num Lock Key Combinations ............................................................................. 5-9
56-Key Full Alpha/Numeric Keyboard ..................................................................................... 5-10
   56-Key Blue Key Combinations ...................................................................................... 5-10
   56-Key Red Key Combinations ...................................................................................... 5-11
   56-Key SFT Key Combinations ...................................................................................... 5-12
General Windows Keyboard Shortcuts .................................................................................. 5-13

Chapter 6 - Settings

Overview .................................................................................................................................. 6-1
   Personal Tab ..................................................................................................................... 6-2
   Buttons ............................................................................................................................. 6-3
   Input Panel Options .......................................................................................................... 6-4
   Headset Control ................................................................................................................ 6-5
   Menus–Modifying the Start Menu ..................................................................................... 6-6
   Notifications .................................................................................................................... 6-7
System Tab ............................................................................................................................. 6-8
   About ............................................................................................................................... 6-8
   Backlight ......................................................................................................................... 6-8
   Clock ............................................................................................................................... 6-9
   Memory ............................................................................................................................ 6-10
   Power ............................................................................................................................... 6-12
   Remove Programs .......................................................................................................... 6-13
   Screen .............................................................................................................................. 6-14
Connections Tab .................................................................................................................... 6-16
   Connections Manager ................................................................................................. 6-16
   Task Tab .......................................................................................................................... 6-17
   Advanced Tab .................................................................................................................. 6-18
Creating a Wireless Network Connection .......................................................................... 6-18
   Network Cards .............................................................................................................. 6-18

Chapter 7 - Communications

Drawing on the Screen ............................................................................................................. 4-10
Communication Options.................................................................................................................. 7-1
Microsoft ActiveSync v4.1 or Higher ................................................................................................. 7-1
RAS (Remote Access Services) ........................................................................................................ 7-1
Installing Additional Software .......................................................................................................... 7-1
Using ActiveSync ............................................................................................................................ 7-2
Establishing ActiveSync Communication ......................................................................................... 7-2
Adding Programs to the Terminal Using ActiveSync ...................................................................... 7-5
Using Infrared ................................................................................................................................ 7-6
Using an ISP .................................................................................................................................... 7-8
Adding Programs Directly from the Internet .................................................................................... 7-8
Radio Options .................................................................................................................................. 7-9
Using the Radio Manager ................................................................................................................. 7-9
Enabling Radios and Radio Combinations ...................................................................................... 7-9
Com Port Assignment Table ............................................................................................................. 7-11

Chapter 8 - Wireless LAN (WLAN) Communications with 802.11b

Overview .......................................................................................................................................... 8-1
Enabling the 802.11b Radio Driver ................................................................................................. 8-1
Configuration Utility Options........................................................................................................... 8-1
802.11b Settings ............................................................................................................................... 8-2
Removing the 802.11b Wireless Security Supplement ................................................................. 8-2
Accessing 802.11b Settings .............................................................................................................. 8-2
Status Tab ..................................................................................................................................... 8-2
Config Tab ..................................................................................................................................... 8-4
Status Icons .................................................................................................................................... 8-6
Advanced Tab ................................................................................................................................. 8-10
About Tab ..................................................................................................................................... 8-10
Using the Status Icon ....................................................................................................................... 8-11
802.11b Wireless Security Supplement .......................................................................................... 8-12
Opening the Client .......................................................................................................................... 8-12
Main Screen .................................................................................................................................. 8-13
Configuring the Client ..................................................................................................................... 8-16
Configuring a Network Profile ........................................................................................................ 8-23
Logging ........................................................................................................................................ 8-26
Installing Certificates with CertAdd ............................................................................................... 8-26
Advice and Workarounds ................................................................................................................. 8-28

Chapter 9 - Wireless PAN (WPAN) Communications with Bluetooth

Overview .......................................................................................................................................... 9-1
Enabling the Bluetooth Radio ......................................................................................................... 9-1
Setting Up Your Bluetooth Card ..................................................................................................... 9-1
Assign COM Ports ........................................................................................................................... 9-1
Object Sharing ............................................................................................................................... 9-2
Discover Bluetooth Device(s) .......................................................................................................... 9-2
Bond With Discovered Device(s) .................................................................................................... 9-3
Set Up Your Favorite Device ........................................................................................................... 9-5
Turn Radio Transmitter ON/OFF ...................................................................................................... 9-7
Bluetooth ActiveSync .................................................................................................................... 9-7
Bluetooth LAN Access ................................................................................................................................. 9-8
OBEX ............................................................................................................................................................... 9-10
Enable File Sharing ........................................................................................................................................ 9-18
Connecting to a Bluetooth Modem .................................................................................................................. 9-18

Chapter 10 - Wireless WAN (WWAN) Communications with GSM/GPRS

Overview .......................................................................................................................................................... 10-1
   Enabling the GSM/GPRS Radio .................................................................................................................. 10-1
   GSM Radios .............................................................................................................................................. 10-1
   Dual-Band Antenna .................................................................................................................................. 10-1
   SIM Card Installation ................................................................................................................................ 10-2
   Audio Modes ............................................................................................................................................. 10-3
   Keyboard Combinations for Calls ............................................................................................................ 10-3
   Volume Control ........................................................................................................................................... 10-3
   Using uPhone ............................................................................................................................................ 10-4
      Icons and Bubble Messages ...................................................................................................................... 10-4
   Using the Dialler ....................................................................................................................................... 10-6
      Making a Call ........................................................................................................................................ 10-6
      Receiving a Call ................................................................................................................................... 10-7
      Ending a Call ......................................................................................................................................... 10-8
      Call Waiting ........................................................................................................................................... 10-8
      Making Conference Calls ....................................................................................................................... 10-8
      Touchtones .......................................................................................................................................... 10-9
      Tools Menu ............................................................................................................................................ 10-9
      Ringtone Configuration ............................................................................................................................ 10-10
   Phonebook ............................................................................................................................................... 10-11
   Charging ................................................................................................................................................... 10-11
   USSD ........................................................................................................................................................ 10-12
   Call Log ..................................................................................................................................................... 10-12
   uPhone Configuration ............................................................................................................................... 10-14
   SMS Manager ......................................................................................................................................... 10-19
      Sending an SMS Message ......................................................................................................................... 10-20
   GPRS Settings ........................................................................................................................................ 10-22

Chapter 11 - Dolphin 9501 and Dolphin 9551

Overview ......................................................................................................................................................... 11-1
   Laser Engine Specifications ......................................................................................................................... 11-1
   Front and Bottom Panel Features .............................................................................................................. 11-2
   Dolphin 9501 Side Panel ............................................................................................................................. 11-2
   Dolphin 9501 Back Panel ........................................................................................................................... 11-2
      Dolphin 9501 Hand Strap and Stylus ..................................................................................................... 11-3
   Dolphin 9551 Side Panel ........................................................................................................................... 11-4
   Dolphin 9551 Back Panel ........................................................................................................................... 11-4

Chapter 12 - Dolphin HomeBase

Overview ......................................................................................................................................................... 12-1
   Dolphin HomeBase Parts and Functions .................................................................................................. 12-2
   Powering the HomeBase ........................................................................................................................... 12-4
HomeBase Serial Connector................................................................. 12-4
Charging the Main Battery ................................................................. 12-5
  To Power a Terminal and Charge its Main Battery ................. 12-5
  Charging a Spare Battery in the Auxiliary Battery Well ........ 12-5
Communications ............................................................................. 12-6
  To Install the HomeBase for Communication ...................... 12-6
  Establishing Communication with the HomeBase .................. 12-6
  Communicating with the Dolphin Terminal ......................... 12-6
RS-232 Communications Cables ...................................................... 12-7
Mounting the HomeBase ................................................................. 12-8

Chapter 13 - Dolphin Mobile Base

Overview .......................................................................................... 13-1
Mobile Base Parts and Functions ................................................... 13-2
Powering the Dolphin Terminal ..................................................... 13-4
Charging the Dolphin Terminal ...................................................... 13-4
Installing the Dolphin Mobile Base .............................................. 13-5
Establishing Communication with the Mobile Base .................. 13-7
  To Install the Mobile Base for Communication ................. 13-7
  Establishing ActiveSync Communication with the Mobile Base .... 13-7

Chapter 14 - Dolphin ChargeBase

Overview .......................................................................................... 14-1
Dolphin ChargeBase Parts and Functions ..................................... 14-1
Supplying Power to the ChargeBase ............................................ 14-3
Inserting and Removing Terminals ............................................. 14-3
Charging Terminals in the ChargeBase ....................................... 14-4
Mounting the ChargeBase ............................................................. 14-4

Chapter 15 - Dolphin QuadCharger

Overview .......................................................................................... 15-1
Dolphin QuadCharger Parts and Functions .................................. 15-2
Supplying Power to the QuadCharger ......................................... 15-3
Inserting and Removing Battery Packs ...................................... 15-4
Charging Batteries in the QuadCharger ...................................... 15-4
Using the Battery Analyzer ......................................................... 15-5
Mounting the QuadCharger ......................................................... 15-6
Troubleshooting ............................................................................. 15-8

Chapter 16 - Customer Support

Product Service and Repair ............................................................. 16-1
  Online Product Service and Repair Assistance .................. 16-1
Technical Assistance ..................................................................... 16-2
  Online Technical Assistance ................................................. 16-2
  For Further Information ...................................................... 16-2
Limited Warranty ......................................................................... 16-3
Agency Approvals

The Dolphin 9500 Series consists of the following terminals:

Dolphin 9500  For details, see Dolphin 9500 on page 3-6.
Dolphin 9550  For details, see Dolphin 9550 on page 3-8.
Dolphin 9501  For details, see Dolphin 9501 Side Panel on page 11-2.
Dolphin 9551  For details, see Dolphin 9551 Side Panel on page 11-4.

Compliance Label Locations

Dolphin terminals meet or exceed the requirements of all applicable standards organizations for safe operation. However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency guidelines that follow. Please read these guidelines carefully before using your Dolphin mobile computer.

Dolphin 9500

Dolphin 9550

Dolphin 9501/9551 Embedded Safety Information Text

Dolphin 9501/9550/9551 terminals have the following safety information embedded in the plastic in different locations on the terminal:

FOR HOME OR OFFICE USE
Tested to Comply With FCC Standards
This Class B digital apparatus complies with Canadian ICES-003. Cet appareil numerique de la Classe B est conforme a la norme NMB-003 du Canada.
No user serviceable parts. Opening voids warranty
US and foreign patents pending.
Made in USA of US & imported parts.

Laser Safety Label

If the following label is attached to your product, it indicates the product contains a laser engine or laser aimer:

Laser Eye Safety Statement: This device has been tested in accordance with EN60825-1: 1993+A1+A2 and 21 CFR 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001. LASER LIGHT, DO NOT STARE INTO BEAM, CLASS 2 LASER PRODUCT, 1.0 mW MAX OUTPUT: 650nM.

Caution—use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

LED Safety Statement

This device has been tested in accordance with IEC60825-1 LED safety, and has been certified to be under the limits of a Class 1 LED device.
Regulatory and Safety Approvals for all Dolphin 9500 Series Terminals

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S.A.</td>
<td>FCC Part 15, Class B</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003</td>
</tr>
<tr>
<td>European Community</td>
<td>EN 55022 (CISPR 22) Class B</td>
</tr>
<tr>
<td></td>
<td>EN60950:2000</td>
</tr>
<tr>
<td></td>
<td>EN60825-1:1994 + A11 + A2</td>
</tr>
<tr>
<td></td>
<td>EN55024:1998</td>
</tr>
</tbody>
</table>

The CE Mark on the product indicates that the system has been tested to and conforms with the provisions noted within the 89/336/EEC Electromagnetic Compatibility Directive and the 73/23/EEC and 93/68/EEC Low Voltage Directive.

For further information, please contact:
Hand Held Products, Inc.
Nijverheidsweg 9
5627 BT Eindhoven
The Netherlands

Hand Held Products shall not be liable for use of our product with equipment (i.e., power supplies, personal computers, etc.) that is not CE marked and does not comply with the Low Voltage Directive.
FCC Compliance

Dolphin terminals meet or exceed all applicable standards and have been manufactured to the highest level of quality.

Dolphin 9500 Series Batch Terminal

Dolphin 9500 Series Batch terminals comply with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Dolphin 9500 Series RF Terminal with 802.11b, Bluetooth, and/or GSM (MC-45 and MC-75) Radios

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user may find the following booklet helpful: “Something About Interference.” This is available at FCC local regional offices. Our company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the substitution or attachment of connecting cables and equipment other than those specified by our company. The correction is the responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Note: Dolphin 9550, Dolphin 9501, and Dolphin 9551 terminals do not support GSM radios.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter. To maintain compliance with FCC RF exposure guidelines for body-worn operation, do not use accessories that contain metallic components.

When using accessories where the terminal is worn on the body, the terminal’s touch panel must face away from the body.

CAUTION! Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the equipment.

Canadian Compliance

This Class B digital apparatus complies with Canadian ICES-003. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) installed outdoors is subject to licensing.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.
RF, Regulatory, and Safety Agency Approvals for 802.11b and Bluetooth

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Approvals</td>
<td></td>
</tr>
<tr>
<td>U.S.A.</td>
<td>FCC Part 15.247</td>
</tr>
<tr>
<td>Canada</td>
<td>RSS 210</td>
</tr>
</tbody>
</table>

RF, Regulatory, and Safety Agency Approvals for GSM (MC-45 and MC-75)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Approvals</td>
<td></td>
</tr>
<tr>
<td>U.S.A.</td>
<td>FCC Part 24</td>
</tr>
<tr>
<td>Canada</td>
<td>RSS 133</td>
</tr>
</tbody>
</table>

Dolphin 9500 Series 802.11b and/or Bluetooth R&TTE Compliance Statement

Dolphin RF terminals are in conformity with all essential requirements of the R&TTE Directive (1999/5/EC). This equipment has been assessed to the following standards as applicable:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
</table>
| R&TTE     | EN 300 328-2:2000  
            | EN 301 489-1 (2002-08)  
            | EN 301 489-17 (2002-08)  
            | EN 60950:2000  
            | EN 50361:2001 |

This product is marked with CE 0681 or CE 0682 in accordance with the Class II product requirements specified in the R&TTE Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community.

PAN European Frequency Range: 2.402–2.480 GHz

Authorization for use in France is restricted as follows:
- Indoor use: Maximum power (EIRP*) of 100 mW for the entire 2.400–2.4835 GHz
- Outdoor use: Maximum power (EIRP*) of 100 mW for the 2400-2454 MHz band and maximum power (EIRP*) of 10 mW for the 2.454–2.483 GHz band.

Dolphin 9500 Terminal GSM (MC-45 and MC-75) R&TTE Compliance Statement

Note: Dolphin 9550, Dolphin 9501, and Dolphin 9551 terminals do not support GSM radios.

The Hand Held Products Dolphin 9500RF terminals are in conformity with all essential requirements of the R&TTE Directive (1999/5/EC). This equipment has been assessed to the following standards as applicable:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
</table>
| R&TTE     | EN301511:2000  
            | EN301489-1(2002-08)  
            | EN 301 489-7 (2002-08)  
            | EN 60950:2000  
            | EN 50361:2001 |
For European Community Users


Waste Electrical and Electronic Equipment Information

This product has required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of the materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed of along with municipal waste and invites you to use the appropriate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You may also contact your supplier for more information on the environmental performances of this product.

Pacemakers, Hearing Aids and Other Electrically Powered Devices

Most manufacturers of medical devices adhere to the IEC 601-1-2 standard. This standard requires devices to operate properly in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. The maximum allowable field strength emitted by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. Therefore, the Dolphin RF has no effect on medical devices that meet the IEC specification.

Microwaves

The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven. Therefore, if you use a microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, both your microwave and your wireless network will continue to function. The Dolphin Batch terminal does not contain a radio, and therefore, is not affected by microwave ovens.
Getting Started

Congratulations on the purchase of your Dolphin mobile computer! You have made a wise choice in selecting the Dolphin, a device known worldwide for its ergonomic form factor, light-weight, rugged design and single-handed data collection capabilities.

Overview

Dolphin terminals are Windows Mobile-based with a unique, ergonomic shape designed for single-handed use and 64 MB RAM and 64 MB non-volatile Flash memory. To install additional memory, you can use the Secure Digital (SD) memory interface. The industrial, mechanical connector supports serial RS-232 up to 115 Kbps and USB communications up to 12 Mbps. The IrDA port enables you to exchange data with IrDA compliant devices, such as portable printers. For additional functionality, an integrated digital imager is available for imaging and decoding.

Ergonomics

The patented shape of Dolphin terminals fits into either hand comfortably with major function keys that are easy to access. The adjustable hand strap on the back panel ensures a secure grip enabling true, one-handed operation. The integrated pistol-grip handle on the Dolphin 9550 provides intuitive point-and-shoot scanning over extended periods of use.

Rugged Design

Dolphin terminals are the most durable mobile computers on the market. Their rugged design can withstand repeated five-foot drops onto a concrete floor, extreme temperatures, and high humidity, moisture, and dust conditions. The terminals are independently tested to meet IP64 specifications.

Mobile Computing Features

- Low-power, high-resolution digital image engine for omni-directional and auto-discrimination decoding of most bar code symbologies; see Bar Code Symbologies Supported on page 4-3.
- Integrated 802.11b, GSM/GPRS, and Bluetooth™ wireless radios for real-time data collection applications.
- Intel® X-Scale 400MHz RISC microprocessor for fast processing.
- Microsoft Windows Mobile 5.0 platform, which makes the device easy to program with standard programming tools.
- 64 MB RAM & 64 MB Flash memory configurations for ample and secure data storage.
- Secure Digital (SD) memory interface enables additional memory installation.

Additional Features

- Long-lasting Lithium Ion (Li-ion) batteries
- Large, easy-to-read 1/4 VGA (240 x 320) color touch panel that can display text or graphics
- Three keyboard options: 43-key alpha/numeric, 35-key numeric/alpha, and 56-key full alpha/numeric
- Industrial-grade connector that supports serial and USB communications, as well as power in and out
- Full suite of compatible peripheral devices
- Decoding of stacked linear and matrix codes with Optical Character Recognition (OCR) functionality
- Digital picture capability
- Audio jack for headset use
- IrDA port for fast infrared communications
- Speaker and microphone for advanced audio functionality
Using the Dolphin Terminal for the First Time

1. Unpack the Carton and Verify its Contents (see page 2-2)
2. Install the Main Battery Pack (see page 2-2)
3. Charge the Main and Backup Batteries (see page 2-2)
4. Initialize the Mobile Computer (see page 2-3)
5. Let Autoinstall Run (see page 2-4)
6. Set the Time and Date (see page 2-4)
7. Verify Imaging and Decoding with Demos (see page 2-4)

Step 1. Unpack the Carton and Verify its Contents

Verify that the carton contains the following items:
- Dolphin 9500 Series mobile computer (the terminal)
- Main battery pack (7.4v Li-ion)
- Microsoft Companion CD
- Dolphin 9500 Quick Start Guide

Note: If you ordered accessories for your terminals, verify that they are also included with the order.

Be sure to keep the original packaging in the event that the Dolphin terminal should need to be returned for service. For details, see Product Service and Repair on page 16-1.

Hand Strap

The Dolphin 9500 ships with the hand strap installed and fastened to the bottom panel with a clip; see Bottom Panel Features on page 3-11. To install the battery pack, you must detach the hand strap.

To detach the hand strap, push the hand strap clip down and away from the terminal. Move the strap up and away from the bottom panel.

To re-attach the hand strap, slide the clip back into place on the bottom panel.

The Dolphin 9501 has a special hand strap; see Dolphin 9501 Hand Strap and Stylus on page 11-3.

Step 2. Install the Main Battery Pack

Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.

1. Unpack the Li-ion battery pack. Hold the terminal with the front panel (keyboard) facing down.

2. Take the battery and insert the end without the locking tab into the top of the battery well and push down with a hinging motion until the locking tab snaps.

To Remove the Main Battery Pack

Put the terminal in suspend mode (see page 2-6). Press the locking tab on the battery pack away from the bottom panel, and pull the battery pack up with a hinging motion.

Step 3. Charge the Main and Backup Batteries

The power supply for the Dolphin mobile computer consists of two types of battery power: the main battery pack installed on the back panel and the backup battery that resides inside the terminal.

The main battery powers the terminal. The internal backup battery charges off the main battery and maintains the application data stored in RAM and system clock for up to 30 minutes when the terminal’s main battery pack is completely discharged or removed.
Before Initial Use

The terminals are shipped with both batteries discharged of all power. Charge the main battery pack for a minimum of four hours before initial use.

Time to Charge

Four hours for the main battery pack, eight hours for the internal backup battery the first time.

Use only Dolphin 9500 Series peripherals, power cables, and power adapters. Use of peripherals, cables, or power adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

Charging with Dolphin Peripherals

When the battery is installed in the terminal, you can insert the terminal into any one of the following peripherals to charge the main battery pack:

- Dolphin HomeBase (see page 12-1)
- Dolphin Mobile Base (see page 13-1)
- Dolphin ChargeBase (see page 14-1)
- Dolphin Net Base
- Dolphin Charging/Communication Cable

To fully charge the Li-ion battery before installing it in the terminal, use the

- Dolphin QuadCharger (see page 15-1)
- Auxiliary Battery Well of the Dolphin HomeBase (see page 12-5)

Step 4. Initialize the Mobile Computer

1. Wake the terminal by pressing the POWER or SCAN key. The decode LED lights and the scan LED blinks for approximately three seconds. Do NOT press any keys while the terminal is initializing.

2. The terminal initializes and the splash screen displays for a few seconds. The Build numbers indicate the software version.

3. The system performs a hard reset. When the display activates again, follow the instructions that appear.

Step 5. Align the Screen

You are prompted to align the screen by tapping the target five times. Use the stylus provided by Hand Held Products.

- Alignment should always be performed with a stylus designed for touch panel applications. The small point is required for accurate calibration.
- Press the stylus firmly into the center of the cross-hair target once and release. Do not “double-tap” the target.
- You can re-align the screen at any time by going to Start > Settings > System tab > Screen.
Step 6. Let Autoinstall Run

For each program that loads, a status bar indicates that the program is loading. Autoinstall occurs after each hard reset. Do NOT touch the keyboard or the screen while programs are loading. All configurations of the Dolphin terminal install Demos and Power Tools. If the terminal is configured with a wireless radio, the appropriate radio drivers and utilities for each radio install.

After Autoinstall is complete, the terminal performs a soft reset automatically. When it finishes booting up after the soft reset, the Today screen appears; see Today Screen on page 4-2.

Step 7. Set the Time and Date

You need to re-set the time and date after every hard reset of the terminal. It is a good idea to set the time and date now before you begin using the device.

On the Today screen, tap the line that displays the time and date,

[Image]

The Clock Settings screen appears.

[Image]

The time zone defaults to GMT-5 Eastern US; tap the arrow to the right of GMT-5 Eastern US to select another time zone. Set the correct time and date in the remaining fields and tap OK to save.

Step 8. Verify Imaging and Decoding with Demos

Dolphin terminals come loaded with Demos you can use to verify imaging and decoding.

Verify Imaging

The Image Demo enables you to use the imager to capture an image on the Dolphin 9500 and Dolphin 9550.

1. Tap Start > Demos > Imaging Demo. The image demo opens.
2. Point the terminal at an object and press the SCAN key. A preview of the object appears on the terminal screen.
3. Release the SCAN key. The image is captured. By default, the image saves to the My Device\My Documents folder as “imagedemo.jpg.” To save to a different location, tap File > Save As and select a new location.
4. Press the ESC key to close the demo.

For more information about taking an image, see Using the Image Engine on page 4-4.
Verify Decoding

The Scan Demo enables you to decode a sample bar code.

1. Tap **Start > Demos > Scan Demo**.

2. Aim the terminal at a bar code and press the SCAN key. The scan LED lights red and an aimer beam or bracket projects out from the scanner.

   (The format of the aimer depends on the image engine installed in the terminal; 5000 and 5100 image engines project a green aimer beam and 5300 image engine projects an LED aiming bracket.)

3. When a good scan is obtained, the decode LED lights solid green and the terminal beeps. The bar code readout appears on the screen.

4. Press the ESC key to close the demo.

Sample Bar Codes

You can use the following bar codes to verify decoding:

<table>
<thead>
<tr>
<th>Sample 128</th>
<th>Sample PDF417</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Sample 128" /></td>
<td><img src="image2.png" alt="Sample PDF417" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Code 128</th>
<th>PDF417 Test Message</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Code 128" /></td>
<td><img src="image4.png" alt="PDF417 Test Message" /></td>
</tr>
</tbody>
</table>

*Note: The Dolphin 9551 supports only 1D symbologies; use Code 128 to verify scanning.*

For more information, see **Decoding** on page 4-4.
**Resetting the Terminal**

There are two ways to reset the terminal: a soft and a hard reset.

**Soft Reset (Warm Boot)**

A soft reset re-boots the device without losing RAM data. You would perform a soft reset when

- the terminal fails to respond.
- after installing some software applications.
- after making changes to certain system settings, such as network cards.

1. Press and hold the Control and the Shift keys for approximately five seconds.
2. The decode and scan LEDs flash for approximately three seconds as the terminal resets.
3. When the reset is complete, the Today screen displays.

**Hard Reset (Cold Boot)**

A hard reset resets the operating system, restores the terminal back to factory defaults, and resets the terminal after a bootloader, keyboard, and kernel upgrade.

A **hard reset erases all of the data stored in RAM memory and all RAM installed applications!**

1. Press and hold the Control and the Escape keys for approximately five seconds.
2. The decode and scan LEDs light for approximately three seconds.
3. The terminal re-initializes; see Initialize the Mobile Computer on page 2-8.

**Suspend Mode**

The terminal goes into suspend mode automatically when the terminal is inactive for a programmed period of time; see Power on page 6-12.

To put the Dolphin terminal into suspend mode manually, press and hold the Power key until the screen goes blank.
To wake the Dolphin terminal from suspend mode, press the Power or SCAN key.
Hardware Overview

Dolphin 9500 Series Terminals

There are four terminals in the Dolphin 9500 Series:

**Dolphin 9500**
The Dolphin 9500 terminal offers an ergonomic form factor and is the only terminal of the series that can be configured with a GSM radio. For details, see Dolphin 9500 on page 3-6.

**Dolphin 9550**
The Dolphin 9550 terminal provides an integrated pistol grip handle for high-volume scanning applications. For details, see Dolphin 9550 on page 3-8.

**Dolphin 9501**
The Dolphin 9501 terminal offers the same flashlight form factor as the Dolphin 9500 with the added functionality of a laser scanner. For details, see Dolphin 9501 Side Panel on page 11-2.

**Dolphin 9551**
The Dolphin 9551 terminal offers the same convenience of the integrated pistol-grip handle with the added functionality of a laser scanner. For details, see Dolphin 9551 Side Panel on page 11-4.

All models can be configured with the available options, except for GSM. Only the Dolphin 9500 terminal can be equipped with a GSM radio.

Dolphin 9500 Series Models and Options

**Dolphin 9500 Series Batch**
These terminals are optimal for fast, effective batch processing.

**Dolphin 9500 Series WLAN (802.11b)**
These terminals integrate the functionality of the Batch terminals with an integrated, IEEE 802.11b direct sequence radio that enables communication with a host computer through a wireless local area network (WLAN).

**Dolphin 9500 Series WPAN (Bluetooth)**
These terminals allow Bluetooth communications to Bluetooth enabled devices such as printers, mobile phones, access points, Bluetooth-enabled PCs, etc.

**Dolphin 9500 WWAN (GSM/GPRS)**
These terminals offer all the benefits of the Dolphin 9500 Series with the additional capabilities of GSM/GPRS technology. The Dolphin 9500 terminal is the only one of the Dolphin 9500 Series that supports GSM/GPRS.

**Dolphin 9500 Series WLAN and WPAN (802.11b and Bluetooth)**
These terminals feature integrated 802.11b and Bluetooth radios, which means that your terminal contains the capabilities of both radios. You can operate the radios simultaneously or switch between them.

**Dolphin 9500 WWAN and WLAN (GSM/GPRS and 802.11b)**
These terminals feature the functionality of both GSM/GPRS and 802.11b radio and network technologies.

**Dolphin 9500 WWAN and WPAN (GSM/GPRS and Bluetooth)**
These terminals feature the functionality of both GSM/GPRS and Bluetooth radio and network technologies.

**Dolphin 9500 WWAN, WLAN, and WPAN (GSM/GPRS, 802.11b, and Bluetooth)**
These terminals feature the functionality of GSM/GPRS, 802.11b, and Bluetooth radio and network technologies.
**Dolphin 9500 Series Peripherals**

Each of the following items is sold separately to enhance the capabilities of your Dolphin terminal.

**Dolphin HomeBase™**

The Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communications, which enable it to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its main battery pack charges in less than four hours. In addition, the HomeBase contains an auxiliary battery well that charges a spare Li-ion battery.

For more information, see Dolphin HomeBase on page 12-1.

**Dolphin Mobile Base™**

The Dolphin Mobile Base charging and communication cradle is designed specifically for in-premise and in-transit data collection applications. It features a flexible mounting bracket, a cigarette lighter adapter or power cable to adapt it to your environment. When a terminal is seated in the Mobile Base, its main battery pack charges in less than four hours. The serial connector supports RS-232 communication and power out to peripheral devices, such as hand held scanners.

For more information, see Dolphin Mobile Base on page 13-1.

**Dolphin ChargeBase**

The Dolphin ChargeBase is a four-slot charging cradle that holds, powers, and charges a terminal in each slot.

For more information, see Dolphin 9500 Series ChargeBase on page 14-1.

**Dolphin Net Base**

The Dolphin Net Base is a four-slot charging/communication cradle that holds, powers, charges, and communicates with the terminal in each slot. Ethernet communication occurs via statically and dynamically-assigned IP addresses.

For more information about the Dolphin Net Base, please consult the Dolphin 9500 Series Net Base Quick Start Guide.

**Dolphin QuadCharger™**

The Dolphin QuadCharger is a four-slot charging station for Dolphin Li-ion battery packs. It can charge each battery in less than four hours. The fourth slot features a battery analyzer that completely resets and re-calibrates a battery and displays its resulting capacity.

For more information, see Dolphin 9500 Series QuadCharger on page 15-1.
Dolphin 9500 Series Accessories

Each of the following items is sold separately to enhance your Dolphin 9500 Series terminal’s capabilities.

Note: When using accessories where the terminal is worn on the body, the terminal’s touch panel must face away from the body.

Dolphin Mobile Charger

The Dolphin Mobile Charger is a charging cable that connects the terminal directly to a 12 Volt DC power source, such as a cigarette lighter port inside a vehicle, eliminating the need for a cradle. The cable powers the terminal and charges its main battery in less than four hours. Intelligent battery technology on-board the terminal ensures proper charging. The Dolphin Mobile Charger is an ideal low-cost charging solution for in-transit mobile applications.

Dolphin Mobile Mount

The Dolphin Mobile Mount, which holds a Dolphin 9500 terminal securely in place inside a vehicle, is an ideal, low-cost alternative to the Dolphin Mobile Base when communications are not required. When used in conjunction with the Dolphin Mobile Charger, the Dolphin Mobile Mount creates a complete mounting and charging solution for in-transit applications. The entire kit includes an adjustable vehicle mounting bracket.

Charging/Communication Cables

Dolphin charging/communication cable kits are an all-in-one solution for mobile applications. Each cable kit powers the terminal, charges its main battery, and communicates with host or peripheral devices without the need for a cradle. Cable kits can support RS-232 or USB communications and are available with U.K. or European power cords.

Protective Holster

Holsters provide convenient storage for terminals and protect them from damage in mobile environments. Both holsters feature a front pocket that holds an extra battery, a side pocket to hold an extra stylus, and a belt loop to secure the holster to a belt.

Protective Enclosure

Protective enclosures help seal and protect terminals from damage while providing full access to all terminal parts and features. Dolphin 9500 Series enclosures feature a swivel clip on the back that enables you to secure the enclosure to a belt. Enclosures also come with an adjustable shoulder strap for added convenience.

Stylus Kits

There are two Dolphin 9500 stylus kits: one contains three styli and the other includes additional coiled tethers to secure the stylus to the terminal, which helps prevent loss. The Dolphin 9550 kit contains loops you can attach to the end of each stylus for easy access to the stylus stored in the pistol grip of the Dolphin 9550.

Li-ion Battery Pack

The 7.4v, 14.8 watt hour Li-ion rechargeable battery pack provides the main power supply for Dolphin 9500 Series terminals.
Front Panel Features

This section describes features on the front panel on Dolphin 9500 Series terminals.
LEDs

The two light emitting diodes (LEDs) located at the top of the LCD display flash and illuminate during resets and scanning/imaging. Both can be programmed by various software applications.

**Scan LED** - Located in the upper right corner, this LED lights red when you press the SCAN key.

**Decode LED** - Located in the upper left corner, this LED lights green when a scanned bar code is successfully decoded.

Touch Panel Display

Dolphin terminals feature a color 3.5" liquid crystal display (LCD) touch panel covered with an industrial, protective lens for greater durability. The video graphic array (VGA) resolution is 1/4 (240 X 320 pixel).

The color LCD is 16 bits/pixel and uses thin film transistor (TFT) technology. The backlight for the touch panel lights when the screen is touched, but not when the Backlight key is pressed. For more information, see Backlight on page 6-8.

The touch panel can be activated by the stylus (included with the terminal) or a finger. For more information, see Using the Touch Panel on page 3-12.

SCAN Key

The SCAN key is centrally located for easy access with the right or left hand. When pressed, the SCAN key activates the scanner/imager. The SCAN key also functions as an on or system wakeup control for the terminal.

Navigation Keys

The centrally-located navigation keys enable you to move and position the cursor through software programs. The up and down arrows are programmed to perform specific functions when pressed in combination with the Blue and Red modifier keys.

Keyboard

The Dolphin terminal features three keyboard options: 35-key numeric/alpha keyboard, 43-key numeric/alpha keyboard, and 56-key full alpha/numeric keyboard. For a complete overview of each keyboard, see Using Dolphin Keyboards on page 5-1.
Back Panel Features

Dolphin 9500

The following graphic describes features on the back panel of the Dolphin 9500 terminal.
Image Engine Window

Dolphin terminals have an optional image engine that reads and decodes linear, stacked linear (PDF417), and 2D matrix bar code symbologies. With the latest CMOS-based technology, the engine works like a digital camera and enables digital image capture, signature capture, and reading of OCR characters.

Digital images taken with Dolphin terminals have a maximum image size of 640 x 480 pixels and may have up to a 256 grayscale image definition. Files formats supported for image storage include Bitmap (.bmp), JPEG (.jpg) and Portable Network Graphics (.png).

For a view of the image engine window, see Image Engine Window on page 3-8.

Speaker

Dolphin terminals have an integrated speaker that sounds audio signals as you scan bar code labels and enter data. The operating frequency range is 500Hz at 71 dB up to 80 dB. The speaker can also be used for playing sounds (e.g., WAV or MP3 files) as well as voice communication in handset mode in a terminal equipped with a GSM/GPRS radio. For more information about handset use, see Audio Modes on page 10-3.

Hand Strap Attachment

The Dolphin 9500 and Dolphin 9551 have an adjustable, elastic hand strap to provide a comfortable, secure grip on the terminal. It is attached to the terminal with a clip on the bottom panel; see Hand Strap Clip on page 3-11. If desired, the strap may be adjusted or removed.

Microphone

Dolphin terminals feature an integrated microphone that provides audio input to the terminal when a headset is not plugged into the Audio Jack, page 3-10. When a headset is plugged in, the terminal defaults to the microphone on the headset. For more information, see Headset Control on page 6-5.

Battery/Battery Well

The Battery Well is a recessed area on the back of the Dolphin that holds the Li-Ion battery pack. For more information, see Batteries on page 3-14.

Stylus and Fastener

The stylus is used to operate the touch panel. The back panel features this storage slot to hold the stylus when not in use. There is also a fastener on the back panel for stylus tethers.

Stylus tethers can be purchased separately to help you keep the stylus attached to the terminal when not in the slot to prevent loss. A stylus tether is a coiled elastic cord with one end to attach to the stylus and another to attach fasten to the back panel.
**Dolphin 9550**

This section describes the back panel of the Dolphin 9550. It contains the same features as the Dolphin 9500 described in the previous section with the additions of:

- a pistol-grip handle to hold and maneuver the terminal with greater ease,
- a scanner/imager trigger on the handle that activates the scan, and
- rubber bumpers that enable the terminal to rest safely and securely when not in use.

The following is a graphic of the 9550 back panel.

![Dolphin 9550 Back Panel Diagram]

**Image Engine Window**

This is the front view of the window. For more information, see Image Engine Window on page 3-7.

**Scan Trigger**

The scan trigger provides ergonomic scan activation for scan-intensive applications.

**Pistol Grip Handle**

The comfortable, ergonomic handle is integrated into the back panel to enhance the terminals durability in rugged, real-world settings. The handle cannot be removed from the terminal and features rubber surface details to improve handle grip, comfort, and shock absorption.

**Wrist Lanyard Fastener**

This fastener is for the wrist lanyards available for Dolphin 9550/9551 terminals.
Rubber Bumpers

The following graphic shows the Dolphin 9550 in a nose-down position, resting on its rubber bumpers.

Stylus

The stylus is used to operate the touch panel display. The Dolphin 9550 stores the stylus inside the pistol-grip handle.
Side Panel Features

The following graphic shows the left, side panel:

IrDA Port

The IrDA port communicates with IrDA-enabled devices such as PCs, printers, modems, or other Dolphin terminals. The maximum data transfer speed is 115kbps.

SD Memory

The access door provides user access to the industry-standard SD memory interface. You can open the access door to insert SD memory cards to expand the terminal's memory capacity.

When the access door is fastened securely and properly, the memory interface is sealed against moisture and particle intrusion, read/write data is stored securely, and the terminal's environmental rating is preserved.

The SD memory interface does not support SDIO.

For more information, see Memory on page 6-10.

Audio Jack

The 2.5mm audio jack supports both speaker (stereo) and microphone (mono) headsets.
Bottom Panel Features

Mechanical Connector

The bottom panel features a custom, industrial-grade connector with 17 pins. When seated in a Dolphin 9500 Series peripheral, the terminal is powered, the main battery charged, and communication occurs via this connector. All Dolphin 9500 Series peripherals are designed to work exclusively with this connector.

The 17-pin connector can communicate with Dolphin 9500 Series peripherals via RS-232 or USB. For RS-232, the maximum communication speed is 115 Kbps with seven baud rate settings. For USB, the communication speed is up to 12 Mbps. If the peripheral unit is connected to a PC, this connector also transmits data.

Powering Out

The mechanical connector also provides power out (to peripheral devices) 5V at 500mA. This means that, with the proper Hand Held Products' cable, the terminal can power another device. By default, power out is disabled. To enable power out, alter the registry as follows:

```
[HKEY_LOCAL_MACHINE\Drivers\BuiltIn\Serial4]
Conn5Venable=1
```

Dolphin 9501 and Dolphin 9551

See Dolphin 9501 and Dolphin 9551 on page 11-1.
Using the Touch Panel

Hand Held Products defines proper use of the terminal touch panel as using a screen protector and proper stylus. Screen protectors maintain the ongoing integrity (i.e., prevent scratching) of the touch panel, which is why their use is recommended for applications that require a high to medium level of interface with the touch panel, such as signature capture for proof of delivery.

Hand Held Products continues to advocate the use of screen protectors on all Dolphin devices. We recommend implementing a screen protector replacement program to ensure that screen protectors are replaced periodically when signs of damage/wear are noticeable. For general use, we recommend replacing the screen protector every thirty (30) days. However, replacement cycles vary according to the average level of touch panel use in your application.

Replacement screen protectors can be purchased directly from Hand Held Products. Please contact a Hand Held Products sales associate for details.

Hand Held Products also mandates use of a proper stylus, which is one that has a stylus tip radius of no less than 0.8mm. Use of the Hand Held Products stylus included with the terminal is recommended at all times.

Hand Held Products warranty policy covers wear on the touch panel for the first 12 months provided that a screen protector is applied and an approved stylus is used for the 12 month duration covered by the warranty.

Installing Your Screen Protector

1. Clean the touch panel thoroughly with a clean, non-abrasive, lint-free cloth. Make sure nothing else is still attached to the touch panel.

2. Align the exposed section of the protector with the bottom edge of the touch panel. Make sure that it lies flush with each side of the touch panel. To reposition, lift up gently and reapply.
3. Apply the touch panel protector to your device by sliding the enclosed squeegee across the surface as you peel away the backing.

4. Use the squeegee as necessary to smooth out any air pockets or bumps.
**Batteries**

Dolphin terminals feature intelligent battery technology. There are two types of battery power: the main battery pack installed in the back panel and the backup battery located inside the terminal. They are designed to work together to prevent data loss when the terminal is in use over long periods. Both batteries must be completely charged before using a Dolphin terminal for the first time.

**Main Battery Pack**

![Warning]

*Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.*

The 7.4V, 14.8 watt hour Li-Ion battery pack is the primary power source for the Dolphin. The Li-Ion battery is designed to operate in a temperature range of -10 to 50°C (14 to 122°F). For the location of the Li-Ion battery on the terminal, see Battery/Battery Well on page 3-7.

**Charging Options**

When the Li-ion battery is installed in the terminal, use one of the following peripherals:

- Dolphin HomeBase (see page 12-1)
- Dolphin Mobile Base (see page 13-1)
- Dolphin ChargeBase (see page 14-1) or the Dolphin Net Base
- Dolphin Mobile Charger - connect the charger to the terminal and vehicle power port

*Note: Make sure the mechanical connector on the terminal is properly connected to the peripheral and that the peripheral is connected to the appropriate power supply.*

When the Li-ion battery is not installed in the terminal:

- Place the battery pack in the Dolphin QuadCharger - see Charging Batteries in the QuadCharger on page 15-4.
- Place the battery pack in the Auxiliary Battery Well of the Dolphin HomeBase (see page 12-5)

**Charging Time**

The Li-ion battery pack requires four hours to charge completely.

**Internal Backup Battery**

Located inside the terminal, the backup battery is a 3.6 Volt nickel metal hydride (NiMH) battery.

The internal backup battery prevents the terminal from being reset if you need to remove and replace the main battery pack. It retains RAM data and allows the real-time clock to remain operational for up to 30 minutes when the main battery pack is removed. If the terminal is left without the main battery pack for more than 30 minutes, the internal backup battery needs to be recharged to function according to its specifications.

*Note: Data and programs stored in Flash memory are not lost even if the internal backup battery fails. However, you must reset the real-time clock; see Set the Time and Date on page 2-4.*

**Charging**

The internal backup battery is powered by the main battery pack. Therefore, charging the internal backup battery requires that the main battery pack be installed in the terminal and the terminal be connected to a charging device.

The internal backup battery must be fully charged before using the terminal for the first time. The initial charge cycle takes approximately eight hours. After that, if the internal backup battery becomes fully discharged of power, it requires a minimum of 10 hours of charging time to function normally.

**Guidelines for Use**

Follow these guidelines to maximize the life of the Dolphin’s internal backup battery:

- Keep a charged Li-Ion battery pack in the Dolphin terminal. The internal battery prematurely discharges if there is not at least a partially charged battery in the terminal.
- Keep the Dolphin terminal connected to power when the terminal is not in use.
Managing Battery Power

Data and files saved on Dolphin terminals may be stored in RAM memory, which does not persist through a hard reset. Therefore, to help prevent data loss, maintain a continuous power supply to the terminal.

Letting the backup battery become fully discharged causes the terminal to lose all data in RAM. Therefore, you should keep a charged battery pack in the Dolphin at all times. The internal battery discharges prematurely if there is not at least a partially charged battery in the terminal. When you remove a battery pack, insert another charged battery pack in the Dolphin immediately.

Default Critical and Low Battery Points

Dolphin terminals are programmed to display warnings when the battery reaches critical and low battery points. There are two DWORD value registry entries [HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power] that set the warning points. The default values for these entries are as follows:

“LowBatt”=19 (25%) This sets the Low Battery point to 25 percent (19 hex=25 decimal). The low battery setting is the point at which the user is notified that the battery is low by an icon in the Navigation bar. The user is notified only once for a low battery.

“CriticalBatt”=a (10%) This sets the Critical Battery point to 10 percent (a hex= 0 decimal). The critical battery setting is the point at which the customer is warned that the battery charge is very low. This warning is posted every 3 minutes until the situation is corrected.

Status Notifications

Icons appear in the Navigation bar to indicate battery status.

- The main battery pack is low (at 25% or less). If the main battery is low and the terminal is in suspend mode, pressing the SCAN or Power button won’t wake the Dolphin terminal; you must replace the discharged battery with a battery charged over 25% mark before you can resume terminal operation.

- The main battery is critically low (at 10% or less).

- The backup battery is low.

Setting Critical and Low Battery Points

Developers can reset these parameters in the registry from 0 (no warning) to 99 (would nearly always warn). Warnings do not appear when the terminal is on external power.

You can review and set these battery points in the RegEdit Power Tool.

1. Tap Start > Power Tools > RegEdit.
2. Drill-down to HKEY_LOCAL_MACHINE > System > CurrentControlSet > Control > Power.

3. Tap the Value Name to change the Value Data.
   You can reset the Value Data from 0 (no warning) to 99 (would nearly always warn).
4. Tap OK to save changes.

**Checking Battery Power**

Tap **Start > Settings > System tab > Power**. The Battery tab opens displaying the charge status of both the installed Li-ion battery pack and the NiMH backup battery inside the terminal.

The Power system setting contains three tabs: Battery, Wireless, and Advanced. For more information, see Power on page 6-12.

**Storing Batteries**

To maintain optimal battery performance, follow these storage guidelines:
- Avoid storing batteries outside the specified range of -4 to 104°F (-20 to 40°C) or in extremely high humidity.
- For prolonged storage, do not keep batteries stored in a charger that is connected to a power source.

**Guidelines for Battery Use and Disposal**

The following are general guidelines for the safe use and disposal of batteries:
- Use only the battery supplied, recommended, or approved by Hand Held Products.
- Replace defective batteries immediately; using a defective battery could damage the Dolphin terminal.
- Never throw a used battery in the trash. It contains heavy metals and should be recycled according to local guidelines.
- Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.
- Excessive discharge damages a battery. Recharge the battery when your terminal indicates low battery power.
- Although your battery can be recharged many times, it will eventually be depleted. Replace it after the battery is unable to hold an adequate charge.
- If you are not sure the battery or charger is working properly, please send it to Hand Held Products or an authorized Hand Held Products service center for inspection.

**Maintenance**

When needed, clean the image engine window and the LCD display with a clean, non-abrasive, lint-free cloth. The terminal can be cleaned with a damp cloth.
### Dolphin 9500 Series Technical Specifications

<table>
<thead>
<tr>
<th>System Architecture</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor:</strong></td>
</tr>
</tbody>
</table>
| **Development Environment:** | Dolphin SDK Add-on for Pocket PC 2003 supports Embedded Visual C++ 4.0  
Dolphin .NET SDK for Pocket PC 2002 and 2003 supports Visual Studio.NET 2003 (VB.NET and C#.NET)  
Dolphin GSM/GPRS SDK Add-on for Pocket PC 2003 supports Embedded Visual C++ 4.0 and Visual Studio.NET 2003 |
| **Operating Platform:** | Microsoft Windows Mobile 5.0  
| **Third-Party Software:** | SOTI MobiControl (remote device management), PowerNet™ Terminal Emulation (TNVT, 3270, 5250), and ITScriptNet |
| **Memory:** | 64MB RAM x 64MB non-volatile Flash |

<table>
<thead>
<tr>
<th>Data Inputs</th>
</tr>
</thead>
</table>
| **Imager/Scanner:** | See Dolphin 9500/9550 Image Engine Specifications on page 4-2.  
See Laser Engine Specifications on page 11-1. |
| **1D Symbologies:** | See 1D Symbologies on page 4-3. |
| **2D Symbologies:** | See 2D Symbologies on page 4-3. |
| **Composite Codes** | See Composite Codes on page 4-3. |
| **OCR Fonts:** | See OCR Codes on page 4-3. |
| **Keyboard Options:** | See Using Dolphin Keyboards on page 5-1. |

<table>
<thead>
<tr>
<th>Data Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display:</strong></td>
</tr>
</tbody>
</table>
| **I/O Ports:** | Custom, industrial-grade, mechanical connector supports  
• USB communications at 12Mbps  
• Serial RS-232 communication up to 115Kbps  
• Charging via peripheral cradles or AC adapter cables  
• Integrated IrDA port, speaker, and microphone |
| **Mass Storage:** | User-accessible Secure Digital (SD) memory interface |

### Wireless Radio Options

| **WLAN:** | IEEE 802.11b DSSS  
Authentication Methodologies: LEAP, MD5, TLS, TTLS, PEAP, and WEP |
| **WWAN: (9500 only)** | GSM/GPRS Quad-band radio (850/900/1800/1900 MHz) with accessible SIM card interface |
| **WPAN:** | Bluetooth radio |
# Dolphin 9500 Series Technical Specifications

<table>
<thead>
<tr>
<th>Physical</th>
<th></th>
</tr>
</thead>
</table>
| **Dimensions:** | 9500/9550 – 9.6”L x 3.45”W x 1.66”D at display (24.53 x 8.76 x 4.23 cm), 2.7”W x 1.5”D at grip (6.9 x 3.8 cm)  
9501/9551 – 9.7”L x 3.45”W x 2.27”D at display (24.66 x 8.77 x 5.76 cm), 2.7”W x 1.5”D at grip (6.9 x 3.8 cm) |
| **Weight:** | 9500 Terminal – Batch: 19.7 oz. (558 gm), WLAN: 20.2 oz. (573 gm), WPAN: 20 oz. (567 gm), WLAN/WPAN: 20.3 oz. (576 gm)  
9501 Terminal – 22.65 oz. (642 gm), all versions  
9550 Terminal – Batch: 23.4 oz. (663 gm), WLAN: 23.9 oz. (677.5 gm)  
9551 Terminal – 25.8 oz. (732 gm), all versions |
| **Operating Temperature:** | 14 to 122°F (-10°C to 55°C)  
The terminal can operate in temperatures lower than -20°C with potential degradation in performance depending on the application |
| **Storage Temperature:** | -4° to 158°F (-20° to 70°C) |
| **Humidity:** | 95% humidity, non-condensing |
| **Electrical Static Discharge:** | 15 KVA on all surfaces |
| **Impact Resistance:** | Withstands multiple 5ft. (1.5m) drops onto concrete |
| **Environmental Resistance:** | Independently certified to meet IP64 standards for moisture and particle resistance |
| **Power:** | Lithium-Ion battery technology – 7.4V, 14.8 watt-hour main battery with hot-swappable design for fast replacement in the field |
| **Other:** | Integrated stylus with optional tether and adjustable, removable hand strap |
| **Peripherals & Accessories** | See Dolphin 9500 Series Peripherals on page 3-2.  
See Dolphin 9500 Series Accessories on page 3-3. |
| **Regulatory Approvals** | See Compliance Label Locations on page 1-1. |
**Today Screen**

After the Dolphin terminal initializes the first time, you see the Today screen.

You can also display the Today screen anytime by tapping **Start** and then **Today**.

**Navigation Bar and Start Menu**

The Navigation bar is located at the top of the screen that displays the active program and current time. It also provides access to the Start menu, which allows you to open programs and access the system settings.

**Command Bar**

Use the Command bar at the bottom of the screen to perform tasks in programs. The Command bar includes popup menus and the Soft Input Panel (SIP) button. The name of the menus here and the content changes according to the open application.
Using the Image Engine

The Dolphin terminal houses a compact image engine that instantly reads popular 1D and 2D bar codes and supports omni-directional aiming and decoding for greater flexibility in real-world settings. The image engine can also capture digital images, such as signatures and pictures of damaged inventory.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>1D</th>
<th>2D</th>
<th>Image Capture</th>
<th>Aiming</th>
<th>Omni-Directional Aiming</th>
<th>Engine Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dolphin 9500</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Green aiming beam or Red High-Vis aiming pattern</td>
<td>Y</td>
<td>5100SR</td>
</tr>
<tr>
<td>Dolphin 9550</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td>Y</td>
<td>5300SR</td>
</tr>
<tr>
<td>Dolphin 9501</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Long-range laser aimer</td>
<td>N</td>
<td>SE1200HP</td>
</tr>
<tr>
<td>Dolphin 9551</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td></td>
<td>N</td>
<td>SE1200LR</td>
</tr>
</tbody>
</table>

Dolphin 9500/9550 Image Engine Specifications

5100 Standard Range (5100SR)
5300 Standard Range (5300SR)

<table>
<thead>
<tr>
<th>Code</th>
<th>8 mil Linear</th>
<th>10 mil PDF417</th>
<th>13 mil UPC</th>
<th>15 mil QR</th>
<th>15 mil Data Matrix</th>
<th>35 mil MaxiCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working Range</td>
<td>(.020 cm)</td>
<td>(.025 cm)</td>
<td>(.033 cm)</td>
<td>(.038 cm)</td>
<td>(.038 cm)</td>
<td>(.089 cm)</td>
</tr>
<tr>
<td>Near</td>
<td>3.4 in. (8.6 cm)</td>
<td>3 in. (7.6 cm)</td>
<td>2 in. (5.1 cm)</td>
<td>3 in. (7.6 cm)</td>
<td>2.2 in. (5.6 cm)</td>
<td>1.9 in. (4.8 cm)</td>
</tr>
<tr>
<td>Far</td>
<td>7.5 in. (19 cm)</td>
<td>8.9 in. (22.6 cm)</td>
<td>13.1 in. (33.3 cm)</td>
<td>8.7 in. (22 cm)</td>
<td>10.1 in. (25.6 cm)</td>
<td>12.9 in. (32.7 cm)</td>
</tr>
</tbody>
</table>

5100 Smart Focus (5100SF)

<table>
<thead>
<tr>
<th>Code</th>
<th>6.6 mil PDF417</th>
<th>7.5 mil Linear</th>
<th>10 mil Linear</th>
<th>10 mil PDF417</th>
<th>13 mil UPC</th>
<th>15 mil Data Matrix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working Range</td>
<td>(.017 cm)</td>
<td>(.019 cm)</td>
<td>(.025 cm)</td>
<td>(.025 cm)</td>
<td>(.033 cm)</td>
<td>(.038 cm)</td>
</tr>
<tr>
<td>Near</td>
<td>2.7 in. (6.8 cm)</td>
<td>2.4 in. (6.1 cm)</td>
<td>2.1 in. (5.3 cm)</td>
<td>2.1 in. (5.3 cm)</td>
<td>1.9 in. (4.8 cm)</td>
<td>1.7 in. (4.3 cm)</td>
</tr>
<tr>
<td>Far</td>
<td>5.9 in. (14.9 cm)</td>
<td>6.4 in. (16.2 cm)</td>
<td>7.5 in. (19 cm)</td>
<td>7.5 in. (19 cm)</td>
<td>8.8 in. (22.3 cm)</td>
<td>7.4 in. (18.8 cm)</td>
</tr>
</tbody>
</table>

Note: The 5300 image engines contains a high-visibility aimer that projects aiming brackets around the bar code or image preview for maximum viewability and aiming. For details, see 5300 Red High-Vis Aiming Pattern on page 4-5 and page 4-6.

Dolphin 9501/9551 Laser Engine Specifications

Dolphin 9501/9551 terminals can be equipped with one of three laser engines. For details, see Laser Engine Specifications on page 11-1.
### Bar Code Symbologies Supported

<table>
<thead>
<tr>
<th>Symbology type</th>
<th>Symbologies Supported</th>
</tr>
</thead>
</table>
| **1D Symbologies** |  Codabar  
|                  |  Code 3 of 9  
|                  |  Code 11  
|                  |  Code 32 Pharmaceutical (PARAF)  
|                  |  Code 93  
|                  |  Code 128  
|                  |  EAN with Add-On and EAN with Extended Coupon Code  
|                  |  EAN-13  
|                  |  GS1 DataBar  
|                  |  Interleaved 2 or 5  
|                  |  Matrix 2 of 5  
|                  |  Plessey  
|                  |  PosiCode  
|                  |  Straight 2 of 5 IATA  
|                  |  Straight 2 of 5 Industrial  
|                  |  Telepen  
|                  |  Trioptic Code  
|                  |  UCC/EAN-128  
|                  |  UPC and UPC-A  |
| **2D Symbologies** |  Aztec  
|                  |  Code 16K  
|                  |  Composite  
|                  |  Data Matrix  
|                  |  GS1 DataBar  
|                  |  MaxiCode  
|                  |  OCR  
|                  |  PDF417  
|                  |  QR Code  |
| **Composite Codes** |  Aztec Mesa  
|                  |  Codablock F  
|                  |  EAN-UCC  
|                  |  GS1 DataBar 14  |
| **OCR Codes** |  OCR-A and OCR-B  |
| **Postal Codes** |  Postnet and most international 4 state codes  
|                  |  Australian Post  
|                  |  British Post  
|                  |  Canadian Post  
|                  |  China Post  
|                  |  Japanese Post  
|                  |  KIX (Netherlands) Post  
|                  |  Korea Post  
|                  |  Planet Code  |
Decoding

The terminal supports two types of image decoding for use in various bar code reading and imaging applications: full-area imaging and Advanced Linear Decoding (ALD).

**Full-Area Imaging**

Full-area imaging provides omni-directional reading of linear and non-linear 1D and 2D bar codes, OCR, signature capture, and picture taking. When reading all bar code types using full-area imaging, a positive read can be obtained from many positions; see *Dolphin 9500/9550 Scanning Position Options* on page 4-5. To achieve the best read, the aiming beam should be centered horizontally across the bar code.

**ALD**

ALD provides fast reading of linear and stacked linear bar codes. To achieve a positive read when reading linear 1D and PDF417 bar codes, the green aiming beam should be centered horizontally across the bar code. When ALD is enabled, the reader does not read matrix or postal codes.

**To Decode a Bar Code**

1. Point the Dolphin terminal directly at the bar code. The imager faces straight out the top panel. The aiming beam should be oriented in line with the bar code to achieve optimal decoding. A range of 4-10 inches (10-25 cm) from the bar code is recommended.

2. Project the aiming beam or pattern by pressing and holding the SCAN key. On the Dolphin 9550 and the Dolphin 9551, you can also press the **Scan Trigger**, page 3-8.

3. The scan LED lights red.

4. Center the aiming beam over the bar code; see *Dolphin 9500/9550 Scanning Position Options* on page 4-5.

5. When the bar code is successfully decoded, the decode LED lights green and the terminal beeps.

6. The bar code information is entered into the application in use.
**Dolphin 9500/9550 Scanning Position Options**

The aiming beams are smaller when the terminal is held closer to the code and larger when it is farther from the code. Symbologies with smaller bars or elements (mil size) should be read closer to the unit whereas symbologies with larger bars or elements (mil size) should be read farther from the unit.

**5100 Green Aiming Beam**

Linear Bar Code

![Linear Bar Code](image)

2D Matrix Symbol

![2D Matrix Symbol](image)

**5300 Red High-Vis Aiming Pattern**

If your Dolphin terminal is configured with a 5300 imager, high-vis aimers frame the bar code for more intuitive aiming.

![5300 Red High-Vis Aiming Pattern](image)

**Dolphin 9501/9551 Scanning Position Options**

For more information, see Laser Engine Specifications on page 11-1.
Capturing Images

The image-capture process is an intuitive, split-second operation for experienced users. By following the basic guidelines, new users can easily develop their own technique and, with practice, quickly learn to adapt it to different application environments.

Note: The Dolphin 9501 and Dolphin 9551 do not support image capture.

Image Preview

When the imaging process is initiated, Dolphin touch screens display a preview of the object. This is a live video image of what the imager is currently viewing. The live video image has a slightly degraded appearance compared to the captured image. This is normal.

Scan Key

The SCAN key captures images on both the Dolphin 9500 and Dolphin 9550 terminals. The SCAN key is the only way to capture an image on the Dolphin 9500; however, on the Dolphin 9550, you can also use the Scan Trigger on the pistol-grip handle.

Image Files

The terminal is capable of saving images in a number of industry-standard file formats such as *.bmp, *.jpg and *.png. The default file format for images is a grayscale *.jpg.

The image quality and related file size are determined by the data compression method used by the software application used to take images. The average size of the image file is approximately 4-8K. However, the size of the image depends on the content of the image - the more complex the content, the larger the file size.

For the highest quality image, take grayscale images.

Taking an Image

The following steps are basic guidelines for taking images:

1. Point the Dolphin terminal directly at the object. The imager points straight out the top panel.

2. To preview the image, press and hold the SCAN key.
   On the Dolphin 9550, you can also press and hold the Scan Trigger, page 3-8.

3. The touch screen displays a preview of the object, and the decode and scan LEDs light red.

4. Adjust the terminal’s position until the object appears on the screen the way you want it to appear in the image.

5. Hold the terminal still and release the SCAN key or Scan Trigger. The scan and decode LEDs flash red, the screen flashes, and the captured image appears on the screen.

6. Unless otherwise specified by the application in use, the image is saved to the My Device\My Documents folder (Start > Programs > File Explorer > My Device > My Documents).

5300 High-Vis Aiming Pattern

If your Dolphin terminal is configured with the 5300 imager, you can enable the aiming pattern for imaging in the Imaging Demo.
1. Tap Start > Demos > Imaging Demo > Options menu > Aimer > Enable.

2. The aiming pattern is now enabled for imaging.

   Note: You can also select the 2 or 5 second timeout options, which means that the aiming pattern is on for 2 or 5 seconds and then shuts off automatically.

**Uploading Images**

Image files can be uploaded to a host PC via Microsoft ActiveSync and a Dolphin communication peripheral or your wireless radio connection.

**Pop-Up Menus**

With pop-up menus, you can quickly choose an action for a selected item. To access a pop-up menu, tap and hold the stylus on the item name of the action you want to perform the action. When the menu appears, lift the stylus, and tap the action you want to perform.

Tap anywhere outside the menu to close the menu without performing an action.

**Selecting Programs**

To see additional programs loaded on your terminal, tap Start > Programs. The Programs screen displays the programs that are not listed on the Start menu. To open a program, tap once on the icon.

   Note: Some programs have abbreviated labels underneath the icon. To see the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out.
**File Explorer**

You can also use the File Explorer to find files and organize these files into folders. Tap **Start > Programs > File Explorer**.

Tap the **Up** button to move up one level in the directory.

You can move files in File Explorer by tapping and holding on the item you want to move, and then tapping **Cut** or **Copy** and **Paste** on the pop-up menu.

**Search**

The Search feature on your Dolphin terminal helps you quickly locate information. Tap **Start > Programs > Search**.

Enter the text you want to find, select a data type, and then tap Go to start the search. To quickly find information that is taking up storage space, select **Larger than 64 KB** in the **Type** drop-down field.

**Using the Soft Input Panel (SIP)**

Use the SIP to enter information in any program on the Dolphin terminal. You can either tap on characters on the soft keyboard or write on the touch screen using Block Recognizer (see page 4-9) or Letter Recognizer (see page 4-9). In either case, the characters appear as typed text on the screen.

To show or hide the SIP, tap the SIP button . When you tap on the SIP button , the soft keyboard appears. This is the default **Keyboard** mode that allows you to tap on letters and characters and have them appear on the screen.
When you use the SIP, your terminal anticipates the word you are typing or writing and displays it above the input panel. When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your Dolphin terminal, the more words it learns to anticipate.

Note: To change word suggestion options, such as the number of words suggested at one time, see Input Panel Options on page 6-4.

Also, a small arrow appears to the right of the button. Tap this arrow to see more SIP options.

![Input Panel Options]

Tap Options to see the Input Panel Options (see page 6-4).

**Using the Block Recognizer**

With Block Recognizer you can input character strokes using the stylus. Tap the arrow next to the Input Panel button and then Block Recognizer.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Block Recognizer, tap the question mark next to the writing area when Block Recognizer is open.

**Using the Letter Recognizer**

With Letter Recognizer you can write letters using the stylus just as you would on paper. Tap the arrow next to the Input Panel button and then Letter Recognizer. When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Letter Recognizer, with Letter Recognizer open, tap the question mark next to the writing area.

**Selecting Text**

To edit or format typed text, select it by dragging the stylus across the text. Then, use the commands on the pop-up menu to cut, copy, and paste the selected text.

**Writing on the Screen**

In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen as you would on paper. To write on the screen, tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how to switch to writing mode.

**To Select Writing**

If you want to edit or format writing, you must select it first.
1. Tap and hold the stylus next to the text you want to select until the insertion point appears.
2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the selected words and then tap an editing command on the pop-up menu, or tap the command on the Edit menu.
Drawing on the Screen

Drawing on the screen is similar to writing on the screen. The difference between writing and drawing on the screen is how you select items and how they can be edited. To create a drawing, cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

Note: You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then a zoom level.

Selecting a Drawing

To edit or format a drawing, tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, deselect the Pen button and then drag to select the drawings you want. You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then tapping an editing command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button is not selected, and drag a selection handle.
Keyboard Options

There are three keyboards available in the Dolphin 9500 Series:

1. **35-key numeric/alpha keyboard**
2. **43-key alpha/numeric keyboard**
3. **56-key full alpha/numeric keyboard**

All three keyboards:
- Are backlit for easy viewing in various lighting conditions.
- Have centrally-located keys for both right- and left-hand operation.
- Have keys and overlays with a silver background to enhance readability.
- Contain function, navigation and modifier keys.
- Are color-coded for ease-of use.

Common Buttons

See Using the Function Keys on page 5-2.
See Using the Navigation Keys on page 5-3.
See Using the Modifier Keys on page 5-3.

Keyboard Combinations

See 35-Key Numeric/Alpha Keyboard on page 5-5.
See 43-Key Alpha/Numeric Keyboard on page 5-7.
See 56-Key Full Alpha/Numeric Keyboard on page 5-10.
**Using the Function Keys**

These keys and/or functions appear on all three Dolphin 9500 Series keyboards.

<table>
<thead>
<tr>
<th>Name</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
</table>
| Backlight    | ![Backlight](image) | Turns the keyboard backlight on and off.  
*Note:* To see the keyboard better in low-light conditions, press the keyboard backlight button once. |
| Backspace (BKSP) | ![BKSP](image) | This key appears on both the 35- and 56-key keyboards. The BKSP key moves the cursor back one space each time the key is pressed. If you are typing text, it deletes the previous character each time it is pressed. On the 43-key keyboard, the backspace is a shifted function; press Red + SP to backspace. To delete a single character, press Red + SP. To delete multiple characters, press Red + SP and hold the SP key. |
| Delete (DEL) | ![DEL](image) | This key appears on both the 35- and 56-keyboard. The Delete key deletes the next character forward each time the key is pressed. On the 43-key keyboard, delete is a shifted function; press Red + the Backlight key to delete. |
| Enter (ENT)  | ![ENT](image) | The Enter key confirms data entry.                                                                                                         |
| Escape (ESC) | ![ESC](image) | The Escape key performs a cancel action.                                                                                                   |
| Power Key    | ![Power](image) | The Power key puts the terminal in and wakes the terminal from suspend mode; see **Suspend Mode** on page 2-6.                              |
| SCAN Key     | ![SCAN](image) | The SCAN key activates the scan and “wakes” the terminals from sleep mode. Its position allows convenient one-handed image-taking and/or bar code decoding. |
| Space (SP)   | ![Space](image) | The Space key moves the cursor one space.                                                                                                 |
| Tab          | ![Tab](image) | The Tab key moves the cursor to the next tab stop or the next control (on a form).                                                         |
Using the Navigation Keys

Located in the center of each keyboard for easy access with either hand, the navigation keys navigate the cursor through application screens.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲</td>
<td>Moves the cursor up one row or line.</td>
<td>▲ &amp; ◼️</td>
<td>Page up</td>
</tr>
<tr>
<td>◼️</td>
<td>Moves the cursor down one row or line.</td>
<td>◼️ &amp; ◼️</td>
<td>Page down</td>
</tr>
<tr>
<td>◼️</td>
<td>Moves the cursor one character to the right.</td>
<td>◼️ &amp; ◼️</td>
<td>Volume up</td>
</tr>
<tr>
<td>▲</td>
<td>Moves the cursor one character to the left.</td>
<td>▲ &amp; ◼️</td>
<td>Volume down</td>
</tr>
</tbody>
</table>

Note: Additional functionality varies according to the application in use.

Using the Modifier Keys

<table>
<thead>
<tr>
<th>Name &amp; Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift 📅</td>
<td>The SFT key modifies only the next key pressed; it must be pressed before each key you wish to modify. SFT toggles the keyboard between uppercase alphabet mode and lowercase alphabet mode.</td>
</tr>
</tbody>
</table>

Use SFT toggle Caps Lock on and off by double-tapping it or by pressing SFT + the Red modifier key. When Caps Lock is toggled on, characters are uppercase; when toggled off, characters are lowercase.

| ALT and CTRL | Functions of the ALT and CTRL keys depend on the software application in use and the keys pressed in combination with each. |

| Blue and Red | The blue and red keys are used in combination with other keys to type special characters and perform system functions. Each key modifies only the next key pressed. |

The overlay of each keyboard is color-coded to indicate the character typed or function performed when specific keys are pressed immediately after the blue or red modifier key.

Sticky Key Functionality—ALT and CTRL

Dolphin 9500 terminals support sticky key functionality for the ALT and CTRL keys, which means that you don’t have to press and hold the ALT and CTRL keys when you press the next key. Instead, you can tap ALT or CTRL and then the next key.

You need to open RegEdit and enable the \HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD key.

1. Tap Start > Power Tools > RegEdit ☑️.
2. Tap the += sign.
3. Tap **HKEY_LOCAL_MACHINE > HARDWARE > DEVICEMAP > KEYBD.**

   ![Registry Editorcreenshot](image1)

   ![Value EditorScreenshot](image2)

4. In the bottom half of the window, double-tap the **StickyCtrlAlt** key and change the Value Data from “0” to “1.”

5. Tap **OK**, then **OK** in the upper right corner to save the change to the registry.

6. Press the CTRL and ALT keys in combination with other keys to verify that you do not need to hold them down while you press the next key. For an example of CTRL and ALT key combinations, see **General Windows Keyboard Shortcuts** on page 5-13.
35-Key Numeric/Alpha Keyboard

**Alpha Lock Key (ALPHA)**

The Alpha Lock key appears only on the 35-key keyboard. The Alpha Lock key enables you to toggle between the numeric and alpha modes. Numeric mode is when you type numbers with the number keys. Alpha mode is when you type letters with the number keys. The 35-key keyboard defaults to numeric mode.

On the overlay, there are Alpha Lock Indicators above number keys 2-9 that specify the letter that will be typed when you press that number key in alpha mode.

Please note that when pressing number keys in alpha mode, you must use the same multi-press method you would use when typing letters on a phone keypad. Each key press will type the next letter in the sequence displayed in the Alpha Lock Indicator.
### 35-Key Blue Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue key + SP</td>
<td>+</td>
</tr>
<tr>
<td>Blue key + DEL</td>
<td>-</td>
</tr>
<tr>
<td>Blue key + F1</td>
<td>:</td>
</tr>
<tr>
<td>Blue key + F2</td>
<td>:</td>
</tr>
<tr>
<td>Blue key + F3</td>
<td>/</td>
</tr>
<tr>
<td>Blue key + F4</td>
<td>\</td>
</tr>
<tr>
<td>Blue key + BKSP</td>
<td>START</td>
</tr>
<tr>
<td>Blue key + F5</td>
<td>–</td>
</tr>
<tr>
<td>Blue key + F6</td>
<td>@</td>
</tr>
</tbody>
</table>

### 35-Key Alpha Mode Key Combinations

The 35-key keyboard defaults to numeric mode. To switch to alpha mode, press the ALPHA key once. In alpha mode, when you press a number key, you type the letter indicated by the alpha lock indicators over the key.

<table>
<thead>
<tr>
<th>Key/Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALPHA + 1</td>
<td>When you press the 1 key repeatedly, the following characters type in the following sequence: . , ' ? ! -</td>
</tr>
<tr>
<td>ALPHA + SFT + 1</td>
<td>! &lt; &gt;</td>
</tr>
<tr>
<td>ALPHA + SFT + 2</td>
<td>@</td>
</tr>
<tr>
<td>ALPHA + SFT + 3</td>
<td>#</td>
</tr>
<tr>
<td>ALPHA + SFT + 4</td>
<td>$</td>
</tr>
<tr>
<td>ALPHA + SFT + 5</td>
<td>%</td>
</tr>
<tr>
<td>ALPHA + SFT + 6</td>
<td>^</td>
</tr>
<tr>
<td>ALPHA + SFT + 7</td>
<td>&amp;</td>
</tr>
<tr>
<td>ALPHA + SFT + 8</td>
<td>*</td>
</tr>
<tr>
<td>ALPHA + SFT + 9</td>
<td>(</td>
</tr>
<tr>
<td>ALPHA + SFT + 0</td>
<td>)</td>
</tr>
</tbody>
</table>

Please note that when typing in alpha mode, you must use the same multi-press method you would use when typing letters on a phone keypad. Each key press will type the next letter in the sequence as displayed by the alpha lock indicators over the number keys.
43-Key Alpha/Numeric Keyboard

Number Lock (NUM)

The **Number Lock** key and **Number Lock Pad** and **Indicators** appear only on the 43-key keyboard. The Number Lock key enables you to toggle between the alpha and numeric modes. Alpha mode is when you type letters with the letter keys. Numeric mode is when you type numbers with the letter keys. On the 43-key keyboard, alpha mode is the default.

The **Number Lock Indicators** above the letter keys in the **Number Lock Pad** specify the number or character that will be typed when you press that letter key in numeric mode.
### 43-Key Blue Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue key + D</td>
<td>*</td>
</tr>
<tr>
<td>Blue key + H</td>
<td>_</td>
</tr>
<tr>
<td>Blue key + L</td>
<td>=</td>
</tr>
<tr>
<td>Blue key + P</td>
<td>+</td>
</tr>
<tr>
<td>Blue key + Q</td>
<td>;</td>
</tr>
<tr>
<td>Blue key + R</td>
<td>:)</td>
</tr>
<tr>
<td>Blue key + S</td>
<td>*</td>
</tr>
<tr>
<td>Blue key + T</td>
<td>/</td>
</tr>
<tr>
<td>Blue key + U</td>
<td>@</td>
</tr>
<tr>
<td>Blue key + X</td>
<td>\</td>
</tr>
<tr>
<td>Blue key + Y</td>
<td>START</td>
</tr>
</tbody>
</table>

### 43-Key Red Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red key + ESC</td>
<td>Lightens Contrast*</td>
</tr>
<tr>
<td>Red key + TAB</td>
<td>Darkens Contrast*</td>
</tr>
<tr>
<td>Red key + SFT</td>
<td>Toggles on Caps Lock</td>
</tr>
<tr>
<td>Red key + Q</td>
<td>F1</td>
</tr>
<tr>
<td>Red key + R</td>
<td>F2</td>
</tr>
<tr>
<td>Red key + S</td>
<td>F3</td>
</tr>
<tr>
<td>Red key + T</td>
<td>F4</td>
</tr>
<tr>
<td>Red key + U</td>
<td>F5</td>
</tr>
<tr>
<td>Red key + V</td>
<td>F6</td>
</tr>
<tr>
<td>Red key + W</td>
<td>F7</td>
</tr>
<tr>
<td>Red key + X</td>
<td>F8</td>
</tr>
<tr>
<td>Red key + Z</td>
<td>Insert</td>
</tr>
<tr>
<td>Red key + SP</td>
<td>Backspace</td>
</tr>
<tr>
<td>Red key + BKSP</td>
<td>Delete</td>
</tr>
</tbody>
</table>
43-Key Num Lock Key Combinations

The 43-key keyboard defaults to alpha mode. To switch to num lock mode, press the NUM key once. In Num Lock mode, when you press a letter key, you type the number indicated by the num lock indicators over the key.

<table>
<thead>
<tr>
<th>Key/Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM + SFT + A</td>
<td>!</td>
</tr>
<tr>
<td>NUM + SFT + B</td>
<td>@</td>
</tr>
<tr>
<td>NUM + SFT + C</td>
<td>#</td>
</tr>
<tr>
<td>NUM + SFT + E</td>
<td>$</td>
</tr>
<tr>
<td>NUM + SFT + F</td>
<td>%</td>
</tr>
<tr>
<td>NUM + SFT + G</td>
<td>^</td>
</tr>
<tr>
<td>NUM + SFT + I</td>
<td>&amp;</td>
</tr>
<tr>
<td>NUM + SFT + J</td>
<td>*</td>
</tr>
<tr>
<td>NUM + SFT + K</td>
<td>(</td>
</tr>
<tr>
<td>NUM + SFT + M</td>
<td>&gt;</td>
</tr>
<tr>
<td>NUM + SFT + N</td>
<td>)</td>
</tr>
<tr>
<td>NUM + SFT + O</td>
<td>&lt;</td>
</tr>
</tbody>
</table>
56-Key Full Alpha/Numeric Keyboard

Note: To type a “Z” on this keyboard, press Red + Y.

56-Key Blue Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue key + .</td>
<td>+</td>
</tr>
<tr>
<td>Blue key + ,</td>
<td>-</td>
</tr>
<tr>
<td>Blue key + A</td>
<td>;</td>
</tr>
<tr>
<td>Blue key + B</td>
<td>@</td>
</tr>
<tr>
<td>Blue key + E</td>
<td>_</td>
</tr>
<tr>
<td>Blue key + F</td>
<td>:</td>
</tr>
<tr>
<td>Blue key + K</td>
<td>/</td>
</tr>
<tr>
<td>Blue key + P</td>
<td>\</td>
</tr>
</tbody>
</table>
## 56-Key Red Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red key + ESC</td>
<td>Lightens Contrast*</td>
</tr>
<tr>
<td>Red key + TAB</td>
<td>Darkens Contrast*</td>
</tr>
<tr>
<td>Red key + SFT</td>
<td>Toggles on Caps Lock</td>
</tr>
<tr>
<td>Red key + A</td>
<td>F1</td>
</tr>
<tr>
<td>Red key + B</td>
<td>F2</td>
</tr>
<tr>
<td>Red key + C</td>
<td>F3</td>
</tr>
<tr>
<td>Red key + D</td>
<td>F4</td>
</tr>
<tr>
<td>Red key + E</td>
<td>F5</td>
</tr>
<tr>
<td>Red key + F</td>
<td>F6</td>
</tr>
<tr>
<td>Red key + G</td>
<td>F7</td>
</tr>
<tr>
<td>Red key + H</td>
<td>F8</td>
</tr>
<tr>
<td>Red key + I</td>
<td>F9</td>
</tr>
<tr>
<td>Red key + J</td>
<td>F10</td>
</tr>
<tr>
<td>Red key + K</td>
<td>F11</td>
</tr>
<tr>
<td>Red key + L</td>
<td>F12</td>
</tr>
<tr>
<td>Red key + M</td>
<td>F13</td>
</tr>
<tr>
<td>Red key + N</td>
<td>F14</td>
</tr>
<tr>
<td>Red key + O</td>
<td>F15</td>
</tr>
<tr>
<td>Red key + P</td>
<td>F16</td>
</tr>
<tr>
<td>Red key + Q</td>
<td>F17</td>
</tr>
<tr>
<td>Red key + R</td>
<td>F18</td>
</tr>
<tr>
<td>Red key + S</td>
<td>F19</td>
</tr>
<tr>
<td>Red key + T</td>
<td>F20</td>
</tr>
<tr>
<td>Red key + U</td>
<td>F21</td>
</tr>
<tr>
<td>Red key + V</td>
<td>F22</td>
</tr>
<tr>
<td>Red key + W</td>
<td>F23</td>
</tr>
<tr>
<td>Red key + X</td>
<td>F24</td>
</tr>
<tr>
<td>Red key + Y</td>
<td>Z</td>
</tr>
</tbody>
</table>
### 56-Key SFT Key Combinations

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function/Special Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFT + 1</td>
<td>!</td>
</tr>
<tr>
<td>SFT + 2</td>
<td>@</td>
</tr>
<tr>
<td>SFT + 3</td>
<td>#</td>
</tr>
<tr>
<td>SFT + 4</td>
<td>$</td>
</tr>
<tr>
<td>SFT + 5</td>
<td>%</td>
</tr>
<tr>
<td>SFT + 6</td>
<td>^</td>
</tr>
<tr>
<td>SFT + 7</td>
<td>&amp;</td>
</tr>
<tr>
<td>SFT + 8</td>
<td>*</td>
</tr>
<tr>
<td>SFT + 9</td>
<td>(</td>
</tr>
<tr>
<td>SFT + 0</td>
<td>)</td>
</tr>
<tr>
<td>SFT + .</td>
<td>&gt;</td>
</tr>
<tr>
<td>SFT + ,</td>
<td>&lt;</td>
</tr>
</tbody>
</table>
### General Windows Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Press these keys,</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + C</td>
<td>Copy</td>
</tr>
<tr>
<td>CTRL + X</td>
<td>Cut</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Paste</td>
</tr>
<tr>
<td>CTRL + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>DELETE</td>
<td>Delete</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Move the insertion point to the beginning of the next word.</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Move the insertion point to the beginning of the previous word.</td>
</tr>
<tr>
<td>CTRL + DOWN ARROW</td>
<td>Move the insertion point to the beginning of the next paragraph.</td>
</tr>
<tr>
<td>CTRL + UP ARROW</td>
<td>Move the insertion point to the beginning of the previous paragraph.</td>
</tr>
<tr>
<td>SHIFT with any of the arrow keys</td>
<td>Select more than one item in a window or on the desktop, or select text within a document.</td>
</tr>
<tr>
<td>CTRL+ A</td>
<td>Select all.</td>
</tr>
<tr>
<td>ALT + ENTER</td>
<td>View properties for the selected item.</td>
</tr>
<tr>
<td>ALT + TAB</td>
<td>Switch between open items.</td>
</tr>
<tr>
<td>ALT + ESC</td>
<td>Cycle through items in the order they were opened.</td>
</tr>
<tr>
<td>ALT + Tap on Touch screen</td>
<td>Right-click</td>
</tr>
<tr>
<td>CTRL + ESC</td>
<td>Display the Start menu.</td>
</tr>
<tr>
<td>ALT + Underlined letter in a menu name</td>
<td>Display the corresponding menu.</td>
</tr>
<tr>
<td>Underlined letter in a command name on an open menu</td>
<td>Carry out the corresponding command.</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>View the folder one level up in My Computer or Windows Explorer.</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel the current task.</td>
</tr>
</tbody>
</table>
Overview

Customized settings are available from the Start menu. Tap **Start > Settings** and settings screen opens. Settings consists of three tabs:

**Personal Tab**
- Customize buttons, set SIP options, and adjust headset settings; see **Personal Tab** on page 6-2.

**System Tab**
- Adjust system settings; see **System Tab** on page 6-8.

**Connections Tab**
- Establish network connections settings; see **Connections Tab** on page 6-16.
**Personal Tab**

To access the Personal tab, tap **Start > Settings**. The screen opens to the Personal tab.

![Personal Tab Screen](image)

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buttons</td>
<td>Customize keyboard buttons to perform functions.</td>
<td><strong>Buttons</strong> on page 6-3.</td>
</tr>
<tr>
<td>Headset</td>
<td>Adjust audio settings for headset use.</td>
<td><strong>Headset Control</strong> on page 6-5.</td>
</tr>
<tr>
<td>Input</td>
<td>Customize the SIP</td>
<td><strong>Input Panel Options</strong> on page 6-4.</td>
</tr>
<tr>
<td>Lock</td>
<td>Password protect the terminal to limit access to your device.</td>
<td></td>
</tr>
<tr>
<td>Menus</td>
<td>Customize the Start and New menus.</td>
<td><strong>Menus–Modifying the Start Menu</strong> on page 6-6.</td>
</tr>
<tr>
<td>MSN Options</td>
<td>Opens addition options associated with MSN.</td>
<td></td>
</tr>
<tr>
<td>Owner Information</td>
<td>Enter your contact information.</td>
<td></td>
</tr>
<tr>
<td>Ringtones</td>
<td>Allows you to choose customer ringtones for your GSM phone. This option appears only on Dolphin 9500 Series units with a GSM radio installed.</td>
<td></td>
</tr>
<tr>
<td>Sounds &amp; Notifications</td>
<td>Set the sound volume, enable and disable sounds for specific actions, and set sound parameters for system notifications.</td>
<td><strong>Notifications</strong> on page 6-7.</td>
</tr>
<tr>
<td>Today</td>
<td>Customize the look and information that is displayed on the Today screen.</td>
<td></td>
</tr>
</tbody>
</table>

*Personal settings are stored in RAM memory. They are replaced by system defaults after each hard reset. For more information about resets, see Resetting the Terminal on page 2-6.*
Buttons

Buttons programs keyboard buttons to launch applications or execute commands. The default button assignments that appear on the Buttons window are inactive until you enable the HotKeys Power Tool.

To Enable HotKeys

1. Tap Start > Power Tools.

2. Tap the HotKeys icon once. HotKeys activates the button assignments in Buttons.

3. Verify the assignment by tapping the button on the keyboard.


Button Assignments

1. After HotKeys is enabled, tap Start > Settings > Personal tab > Buttons.

   ![Settings window](image)

   - **Assign a program** list contains the applications installed on the terminal. If there is a program installed that you would like to see in this list, paste a Shortcut to the program in the `\Windows\Start Menu\Programs` folder. For instructions about creating shortcuts, see Using File Explorer on page 6-6.

   - **Additional Functions**

   The Assign a program list also contains the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Input Panel&gt;</td>
<td>Opens the soft input panel.</td>
</tr>
<tr>
<td>&lt;None&gt;</td>
<td>Nothing happens when the button is pressed.</td>
</tr>
</tbody>
</table>
Input Panel Options

The following graphics are the tab windows where you can customize the input panel to your preferences:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;OK/Close&gt;</td>
<td>Performs the same function as tapping OK on the screen.</td>
</tr>
<tr>
<td>&lt;Scroll Down&gt;</td>
<td>Scrolls down in the open application.</td>
</tr>
<tr>
<td>&lt;Scroll Left&gt;</td>
<td>Scrolls left in the open application.</td>
</tr>
<tr>
<td>&lt;Scroll Right&gt;</td>
<td>Scrolls right in the open application.</td>
</tr>
<tr>
<td>&lt;Scroll Up&gt;</td>
<td>Scrolls up in the open application.</td>
</tr>
<tr>
<td>&lt;Start Menu&gt;</td>
<td>Opens the Start menu.</td>
</tr>
<tr>
<td>&lt;Today&gt;</td>
<td>Opens the Today screen.</td>
</tr>
</tbody>
</table>

---

Input Method Tab

Word Completion Tab

Options Tab

---

[Image of tab windows]
Headset Control

The Headset Control setting enables you to adjust audio settings while using a headset.

Stereo headphone
Select this option if you are using a headset for audio output only. If so, you need to use the microphone on the terminal (Microphone, page 3-7) for audio input; i.e., listen via the headset and speak into the microphone. These types of headsets usually contain two earpieces for stereo sound. Tap OK to save your selection.

Telephone (mono with mic)
Select this option if you are using a headset that also contains a microphone. When this option is selected, you speak into the microphone on the headset and not the microphone on the terminal. These types of headsets usually have one earpiece for mono audio. Tap OK to save your selection.

Mic Volume
These options enable you to adjust the audio level of the microphone; Normal is the default setting. These settings apply to the selected Headset Type:

- **Stereo headphone**
  Adjusts the volume on the terminal’s microphone (Microphone, page 3-7).
- **Telephone (mono with mic)**
  Adjusts the volume on the headset’s microphone.

Tap OK to save your selection. This setting does **not** work if you are using a GSM radio for two-way voice communication; see Audio Modes on page 10-3.

Headset Volume
The slider enables you to adjust the speaker volume (audio output) of the headset. Move the slider from Mute to High depending on your preference. The volume adjusts automatically as you move the slider. These headset volume settings apply to both Headset Types.
Menus—Modifying the Start Menu

You can add existing programs you use often, such as File Explorer, to the Start menu. You are not installing or moving the program itself, you are simply creating a shortcut to the program from the Start menu.

You can modify the Start menu,

- Using Menus (page 6-6),
- Using File Explorer (page 6-6), or
- Using ActiveSync on the Desktop (page 6-7)

Using Menus

1. Tap Start > Settings > Personal tab > Menus.

2. Select the program you want to add and tap OK to save.

3. Tap the Start menu.

4. Verify that the shortcut to the program appears on the Start menu.

Note: You can also remove shortcuts from the Start menu by de-selecting them here and tapping OK.

Using File Explorer

We recommend that you Copy and Paste Shortcut so that you do not alter your program configurations by accident. If you Cut and Paste the program itself, you will be removing the program from its proper location, which means that the program might not run properly. Using Copy and Paste Shortcut ensures that the program files remain where they need to be to function properly.

1. Tap Start > Programs > File Explorer. To see a list of all folders, tap the folder name and then My Device.

2. Navigate to the program.

3. Tap and hold on the program, then tap Copy on the pop-up menu.

4. Navigate to the Windows folder and open the Start Menu (My Device > Windows > Start Menu), tap and hold a blank area of the window, and tap Paste Shortcut on the pop-up menu.

5. Tap the Start menu.

6. Verify that the shortcut to the program now appears on the Start menu.
Using ActiveSync on the Desktop

You can use the Explore feature of ActiveSync on your desktop computer to navigate through the files on your Dolphin terminal. The process is essentially the same, except that you are using Windows Explorer on the PC to create and paste the shortcut.

1. Tap **ActiveSync > Explore**.
2. Navigate to the program.
3. Right-click on the program and select **Create Shortcut**.
4. Select the shortcut, right-click, and select **Cut**.
5. Navigate to the **Start Menu** folder (Windows > Start Menu).
6. Right-click on an empty area and select **Paste**.
7. On the terminal, tap the **Start** menu.
8. Verify that program appears on the Start menu.

See ActiveSync Help for more information about using ActiveSync.

Notifications

Notifications remind you when you have something to do. For example, if you’ve set up an appointment in Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways:

- A message box appears on the screen.
- A sound, which you can specify, is played.

The options you choose here apply throughout the terminal.
System Tab

The System tab enables you to verify and sometimes alter system parameters. To access the System tab, tap Start > Settings > System tab. Tap the appropriate icon to open that system setting.

About

The About system setting displays specific information about what is loaded on the terminal. It contains three tabs: Version, Device ID, and Copyrights.

Version Tab
Displays the information about the software, operating system, and processor of the terminal.

Device ID Tab
Displays the information the terminal uses to identify itself to other devices. It can be important to know this information if the Dolphin terminal is going to be part of a networked system of devices.

Device name: Displays the system’s default name. This is the name used by ActiveSync.
Description: Displays the description of the device ID.

Copyrights Tab
Displays important copyright information.

Backlight

The backlight for the display is programmed to turn off after the period of time specified in the Backlight Setting. To turn the display backlight back on, simply tap anywhere on the touch screen.
The Backlight Setting has two tabs: **Battery** and **External**; the options on each tab are the same. The Battery tab determines display backlight settings when the terminal is running on battery power. The External tab determines display backlight settings when the terminal is powered by an external source, such as a Hand Held Products cable.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off backlight</td>
<td>Select how many minutes you want to elapse before the backlight automatically turns off.</td>
</tr>
<tr>
<td>Turn on backlight</td>
<td>Select this option if you want the backlight to turn on when a button is pressed or the touch screen is tapped.</td>
</tr>
<tr>
<td>Dim backlight if</td>
<td>Select how many minutes you want to elapse before the backlight dims.</td>
</tr>
<tr>
<td>Backlight Intensity</td>
<td>Move the slider to set the intensity of the backlight.</td>
</tr>
<tr>
<td>OK</td>
<td>Tap OK to save settings. The display backlight functions according to the settings saved on each tab.</td>
</tr>
</tbody>
</table>

**ClearType Tuner**

Dolphin terminals display support ClearType font rendering. ClearType is a Microsoft technology that increases the readability of text on LCD displays.

After you enable ClearType font rendering in the Screen setting (Screen, page 6-14), you can adjust the render level. Use the slider to adjust the appearance of the sample type on the screen and tap **OK**. For more information about ClearType font rendering, visit: [www.microsoft.com/typography/cleartype/what.htm?fname=%20&fsize=](http://www.microsoft.com/typography/cleartype/what.htm?fname=%20&fsize=)

**Clock**

This setting sets the system clock. Appointments, scheduled events, and any function on a schedule runs off this setting. You need to set the time zone and time after each hard reset; see Set the Time and Date on page 2-4.

**CPU Speed**

The Central Processing Unit (CPU) always runs at the default speed of 400MHz.
Memory

There are two kinds of memory:

**Main Board/IPSM**  64MB RAM x 64MB non-volatile Flash

**Secure Digital (SD) Card**  Each terminal has an SD memory interface for additional application and data storage. You can order memory cards to increase memory. Each terminal contains an access door on the side panel that makes the SD memory interface user-accessible; see Access Door to SD Memory on page 3-10.

The Memory system setting displays capacity and usage statistics for both RAM (volatile) and IPSM/Storage Card (non-volatile) memory. Access this setting whenever you receive system messages about memory.

There are three tabs: Main, Storage Card, and Running Programs.

**Main Tab**  This tab displays the usage statistics of the 64MB of on-board, volatile RAM memory.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Columns** | Storage: The part of RAM memory used for storing programs and program data.  
Program: The part of RAM memory used to run programs. |
| **Total** | Displays the current MB of memory allocated for Storage and Program use. |
| **In use** | Displays the total MB of that allocated memory being used in Storage and Program memory functions. |
| **Free** | Displays the total MB of memory available for Storage and Programs use. |

**Storage Card Tab**  This tab displays the current capacity and usage statistics of the selected memory type; IPSM or Storage Card. Select the memory type from the drop-down list. IPSM is selected by default.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total storage card memory</strong></td>
<td>The total MB of memory capacity of the selected memory.</td>
</tr>
</tbody>
</table>
IPSM—Short for Internal Persistent Storage Manager, this is the 14MB of on-board Flash memory that is non-volatile. Because this memory is non-volatile, data or programs stored in IPSM are not affected when power is removed. Autoinstall programs, for example, are stored in IPSM so that they are always installed at cold-boot startup.

Storage Card—You can install one memory card in Dolphin terminals (see Access Door on page 3-6). If a storage card is installed in the terminal, you can select it in the drop-down list and see capacity and usage statistics for the card.

Running Programs Tab Displays the software programs currently using Storage memory.

Check this tab when you are receiving out of memory errors or when the mobile computer is running slowly. You can

- Select a program in the list and tap Stop to stop it from running (and therefore from using memory), or
- Tap Stop All to automatically stop all running programs.

Anytime you stop a running program, it frees up RAM memory. Be advised that, when you stop a program here, any unsaved data in that program is lost. To free up memory without risking data loss, return to the running program, save your data, and close the application.

Find Link
Underneath the three Memory tabs is a link to the Find window that enables you to search for large files using storage memory.

Clicking this link opens the Search screen with Larger than 64KB already selected in the Type field. To perform a search, enter the search criteria in the Find field and tap Search in the lower left corner.
Power system settings contains three tabs: Battery, Wireless, and Advanced.

Battery Tab
Displays the remaining charge of both the main and backup batteries. For more information about the terminal’s batteries, see Batteries on page 3-14.

Wireless Tab
Determines the power settings for your wireless connection.

Select Wireless signals off when you don’t want to use system power to power up the radio(s).

Select Wireless signals on when you want the radio to use system power to transmit. This is the default setting. The list contains the radio firmware installed in the terminal. The selected items are the items using system power.

Advanced Tab
Determines power time-outs.

Adjust backlight settings to conserve power.
Change beam settings to conserve power.
For **On battery power**, select the number of minutes of inactivity you want to pass before the terminal powers off when running on battery power.

For **On external power**, select the number of minutes of inactivity you want to pass before the terminal powers off when running on external power.

**Options below the tabs**

- **Adjust backlight** opens the Backlight settings so that you can make adjustments to conserve power usage; see Backlight on page 6-8.

- **Change beam** opens beam settings so that you can make adjustments to conserve power usage; see Using Infrared on page 7-6. (You would turn off receiving capabilities to conserve power.)

You can also set automatic turn-off times for the terminal to conserve power. When the device is "turned off," that means that it goes into **Suspend Mode** (see page 2-6).

**Regional Settings**

Regional Settings enables you to customize the appearance and formatting to your geographic region. Specifically, you can customize numbers (number of decimal places allowed, for example), currency (using the $ or € symbol, for example), time, and date. These specifications apply to all screens, including the Today screen. To see specific settings or change a specific setting, tap on one of the tabs, make the change and tap **OK** to save it.

**Remove Programs**

The Remove Programs settings enables you to remove programs installed on the terminal. Use this setting to troubleshoot when you receive messages that the device is out of memory. The programs removed are removed from RAM memory. Any program (usually *.cab or *.dll files) stored in the Autoinstall folder (My Device > IPSM > Autoinstall) will re-install after the next hard reset.

For information about the Autoinstall process, see **Let Autoinstall Run** on page 2-4. For information about the hard reset process, see **Hard Reset (Cold Boot)** on page 2-6.

1. Tap the **Remove Programs** icon.

2. In the list, select a program and tap **Remove**. The following message appears:

3. Tap **Yes**. Wait while the program is removed.
4. Verify that the program no longer appears in the list.

**Screen**

*Note:* By default, dynamic screen rotation (i.e., the ability to switch between landscape and portrait orientation) is disabled on Dolphin terminals. Please consult the Dolphin SDK Add-on to find out how to enable dynamic screen rotation.

There are three tabs: Alignment, Clear Type, and Text Size. Screen opens to the Alignment tab.

**Alignment Tab**

On this tab, you can re-align the screen. You first align the screen at bootup. Re-align the screen again if tapping buttons or icons with the stylus no longer seems to work appropriately. For more information, see Align the Screen on page 2-3.

**ClearType Tab**

The displays of Dolphin terminals support ClearType font rendering. ClearType is a Microsoft technology that increases the readability of text on LCD displays.

To enable ClearType font rendering, select **Enable ClearType** and tap **OK**. To adjust the level of ClearType font rendering, use the ClearType Tuner; see ClearType Tuner on page 6-9.

For more information about ClearType font rendering, visit: www.microsoft.com/typography/cleartype/what.htm?fname=%20&fsize=
Text Size Tab

The Text Size tab enables you to perform font scaling within certain views of the Today screen, Contacts, Calendar, Messaging, and Tasks. This means that you can increase or decrease the point size of the font on application windows.

This is the default font size setting. To change the font size, move the slider toward Smallest or Largest. The Example text changes to reflect the font change. Tap OK to save the new font size setting.

uPhone Settings

If you have a GSM/GPRS radio installed on your terminal the uPhone Settings icon appears on the System tab. For details, see Wireless WAN (WWAN) Communications with GSM/GPRS on page 10-1.
## Connections Tab

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>802.11b Settings</strong></td>
<td>Configures the 802.11b radio. This icon appears only if an 802.11b radio is installed on the terminal.</td>
<td><a href="#">Wireless LAN (WLAN) Communications with 802.11b, page 8-1</a></td>
</tr>
<tr>
<td><strong>Beam</strong></td>
<td>Verifies and adjusts infrared settings of the IrDA port.</td>
<td><a href="#">Using Infrared, page 7-6</a></td>
</tr>
<tr>
<td><strong>Connections</strong></td>
<td>Configures network connections; this is the Connections Manager.</td>
<td><a href="#">Connections Tab, page 6-16</a></td>
</tr>
<tr>
<td><strong>IrDA</strong></td>
<td>Enables and disables the IrDA port so that the port can be used by the Bluetooth radio. This icon appears only if a Bluetooth radio is installed on the terminal.</td>
<td><a href="#">Verify That the IrDA Port is Enabled, page 7-6</a></td>
</tr>
<tr>
<td><strong>Radio Manager</strong></td>
<td>Enables and disables the radios installed on the terminal.</td>
<td><a href="#">Radio Options, page 7-9</a></td>
</tr>
<tr>
<td><strong>Network Cards</strong></td>
<td>Displays network cards installed in the terminal.</td>
<td><a href="#">Network Cards, page 6-18</a></td>
</tr>
<tr>
<td><strong>uPhone GPRS</strong></td>
<td>Configures GPRS settings for the GSM radio. This icon appears only if a GSM/GPRS radio is installed on the terminal.</td>
<td><a href="#">Wireless WAN (WWAN) Communications with GSM/GPRS, page 10-1</a></td>
</tr>
</tbody>
</table>
Server-Assigned IP Addresses

Server-assigned IP addresses use Dynamic Host Configuration Protocol (DHCP).

Zero-Config Wi-Fi

The zero-config Wi-Fi feature of Windows Mobile is disabled on Dolphin 9500 series mobile computers.

Connections Manager

Microsoft's connection manager sets up various network connections to Internet Service Providers (ISPs) via external modem. All server-assigned IP addresses use Dynamic Host Configuration Protocol (DHCP).

If you are using one of the on-board wireless radios to connect to a network, do not enter network parameters in the connections manager. The Dolphin terminal uses the radio's settings to connect to the network.

Note: The zero-config Wi-Fi feature of Windows Mobile is disabled on Dolphin terminals.

To open the connections manager, tap Start > Settings > Connections tab > Connections icon. The connections manager queries the system configuration and opens displaying the Tasks tab.

Task Tab

The Task tab enables you to initially configure, then manage network settings when using a modem. Select an item in this list and then complete the setup screens that follow with the appropriate information for your network.

My ISP

The links under this heading enable you to add and manage modem connections to an ISP. To complete the setup screens, obtain the following information from your ISP:

- ISP dial-up access telephone number
- Username
- Password
- TCP/IP settings

My Work Network

These links enable you to establish the following connections types:

- Modem
- Virtual Private Network (VPN)
- Proxy server connection

To complete the setup screens, obtain the network parameters from your system administrator.
Proxy Server Connections

If you are connected to your ISP or private network during synchronization, the terminal should download the proper proxy settings during synchronization with the PC. If these settings are not on your PC or need to be changed, ask your ISP or network administrator for the proxy server name, server type, port, type of Socks protocol used, and your user name and password.

Modify an Existing Connection

Manage Existing Connections appears on the Connections tab after at least one network connection has been established. Tap Manage Existing Connections on this tab and follow the setup screens. You will usually be walked through the same setup screens used to establish the connection.

Advanced Tab

The Advanced tab enables you to select the default network, dialing rules, and IP address exceptions for modem connections.

![Advanced Tab Screenshot]

Note: You should not need to change Advanced settings because most ISPs now use DHCP addresses.

Online Help

For more information about modem connection setup, consult the online help on the setup screens by tapping the Help icon 📖.

Creating a Wireless Network Connection

On Dolphin terminals, wireless networks need to be configured according to the radio installed in the terminal.

For more information about 802.11b radios, see Wireless LAN (WLAN) Communications with 802.11b on page 8-1.
For more information about Bluetooth radios, see Wireless PAN (WPAN) Communications with Bluetooth on page 9-1.
For more information about GSM/GPRS radios, see Wireless WAN (WWAN) Communications with GSM/GPRS on page 10-1.

Network Cards

To see the network cards installed on the terminal,
1. Tap Start > Settings > Connections > Network Cards.
2. In the list, tap on an adapter to review its settings. (Server-assigned IP addresses use DHCP.)

3. If you make a change on one of these tabs, tap **OK**. The following message appears:

4. You must perform a soft reset to update the registry; see **Soft Reset (Warm Boot)** on page 2-12. During the soft reset, the new registry entries created by the changes can be read by the applications that need them.

   *Do NOT perform a hard reset (see **Hard Reset (Cold Boot)** on page 2-12) after modifying an adapter here. Hard resets return the terminal to factory defaults, which means that any network adapter modifications are lost.*
Communications

Communication Options

You can exchange information between your Dolphin terminal and other mobile devices, a desktop computer, a network, or the Internet. You have the following connection options:

- Connect to your desktop computer and synchronize via Microsoft ActiveSync v4.1 or higher.
- Use the infrared (IrDA) port to send and receive files between two devices.

Mechanical Connector

The 17-pin, industrial-grade, mechanical connector on the bottom panel is designed to work only with communication and charging peripherals sold/manufactured by Hand Held Products. Via these peripherals, the connector supports USB and RS-232 communications, enabling the user to connect the Dolphin terminal to external devices such as scanners and printers.

For more information about the connector, see Mechanical Connector on page 3-11.

Microsoft ActiveSync v4.1 or Higher

Microsoft ActiveSync is a tool that enables Windows Mobile devices to exchange and synchronize application data with a desktop computer.

For more information, see Using ActiveSync on page 7-2.

IrDA Port

The IrDA port enables the Dolphin terminals to transmit data via pulses of light to and from other IrDA-compliant devices, such as printers and PCs or to other Dolphin terminals.

For more information, see Using Infrared on page 7-6.

Wireless Radios

Dolphin terminals can be configured with one or a combination of 802.11b, Bluetooth, or GSM/GPRS (only available on Dolphin 9500 units) radios.

For more information, see Radio Options on page 7-9.

RAS (Remote Access Services)

RAS is a feature built into Windows NT that enables users to log into an NT-based LAN using a modem, X.25 connection or WAN link. RAS is fully supported and allows the use of PPP or SLIP connections for network connectivity.

Installing Additional Software

In addition to the default programs installed on your terminal when it is first booted up, you can install any program (created for a Windows Mobile-based device), as long as the terminal has enough memory to store the program and the program has an *.exe, *.cab, or *.dll extension.

The most popular place to find software on the Windows Mobile website: www.microsoft.com/windowsmobile/products/pocketpc/

When selecting programs, verify that the program and version of the program are designed for the Windows Mobile and your processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the information in the Processor field.

You can install additional software via:

- ActiveSync - see page 7-5.
- Infrared - see page 7-6.
- Network connection (via wireless radio) - see page 7-8.
- Connect to your ISP.
Using ActiveSync

Microsoft ActiveSync lets you synchronize information between the Dolphin terminal and the workstation. Synchronization compares the data on the desktop computer and the terminal and updates both with the most recent data so that the information on both is identical.

Note: The most current version of ActiveSync can be downloaded from www.microsoft.com.

Capabilities

- Back up and restore your device data.
- Copy (rather than synchronize) files between your device and desktop computer.
- Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually while connected to your desktop computer or only when you choose the synchronize command.
- Select which information types are synchronized and control how much data is synchronized. For example, you can choose how many weeks of past appointments you want synchronized.

Requirements

To synchronize, ActiveSync version 4.1 or higher must be installed on both your desktop computer and Dolphin terminal. Dolphin terminals ship with ActiveSync 4.1 already installed. Therefore, you must install ActiveSync 4.1 on your desktop computer from the Microsoft Companion CD that came with your terminal.

To install ActiveSync on your desktop computer, insert the Microsoft Companion CD into the CD-ROM drive of your desktop computer. Click the yellow arrow, then Start Here, and follow the directions on your screen.

When communicating via ActiveSync, your terminal must be connected to the host PC with a peripheral device sold/manufactured by Hand Held Products, such as the Dolphin HomeBase, Dolphin Mobile Base, Dolphin Net Base, Dolphin Mobile Charger or other Dolphin 9500 Series charging/communication cable. Use of any peripheral not sold/manufactured by Hand Held Products may damage your terminal and will void the warranty.

For more information about connecting with communication peripherals, see Dolphin HomeBase on page 12-1 and Dolphin Mobile Base on page 13-1.

Establishing ActiveSync Communication

Connect the Dolphin terminal to the workstation via a Dolphin peripheral.

- See Establishing Communication with the HomeBase on page 12-6.
- See Establishing Communication with the Mobile Base on page 13-7.

Note: USB or RS-232 communication with the terminal is usually auto-detected and configured by ActiveSync based on the communication cable. If you are using a USB cable to connect to the workstation, ActiveSync will usually set up a USB connection. If you are using an RS-232 cable, ActiveSync will usually set up an RS-232 connection.
Setting up the Terminal for ActiveSync Communications

1. On the terminal, tap Start > ActiveSync > Tools > Options. OR, Start > Programs > ActiveSync > Tools > Options. ActiveSync opens displaying the PC tab.

2. Tap Menu > Connections…

3. Select Synchronize all PCs using this connection.

4. For USB communication, select ‘USB Connection’ from the drop-down list. For RS-232 communication, select ‘115200’ from the drop-down list.

5. Tap OK.

Setting up the Desktop Computer for ActiveSync Communications

After the HomeBase is installed, you can use ActiveSync to connect to a Dolphin terminal that is properly seated in the HomeBase. These instructions assume that ActiveSync v4.1 is installed on your PC.

1. On the workstation, tap Start > Programs > Microsoft ActiveSync.
2. Tap File > Connection Settings.

![Connection Settings](image)

3. For USB communication, the **Allow USB connection with this desktop computer** box must be checked. Do NOT check **Allow connections to one of the following**! (USB is the default connection type.)

4. For serial (RS-232 communication), select **Allow connections to one of the following**: and **COM1**.

5. Tap **OK** to save settings.

**Synchronizing from Your Desktop Computer**

Because ActiveSync is already installed on the Dolphin terminal, your first synchronization process begins automatically when you finish setting up your desktop computer in the wizard and your terminal is connected to the host PC.

After your first synchronization, look at Calendar, Contacts, and Tasks on the terminal. Notice that the same information from Microsoft Outlook on your desktop computer is now on the terminal. Simply remove the Dolphin from the communication peripheral and you’re ready to use it.

By default, ActiveSync does **not** automatically synchronize all types of information. Use **ActiveSync Options** to specify the types of information you want to synchronize. The synchronization process makes the data (in the information types you select) identical on both your desktop computer and your device.

For more information about using ActiveSync on your desktop computer, open **ActiveSync**, then open **ActiveSync Help**.

**Synchronizing from the Terminal**

ActiveSync **must** be setup on your desktop computer and the first synchronization process completed **before** you initiate synchronization from the terminal for the first time.

To initiate synchronization the first time, tap **Start > ActiveSync**. The synchronization process begins.

**Note:** If you have a wireless LAN card, you can synchronize remotely.

After the first synchronization, when using Dolphin peripherals such as the HomeBase or Mobile Base, synchronization begins automatically whenever a terminal is properly seated in the terminal well. For more information, see **Dolphin HomeBase** on page 12-1 or **Dolphin Mobile Base** on page 13-1.

**Exploring Your Terminal from the Desktop Computer**

When the terminal and desktop computer are connected, open the main ActiveSync window (on the desktop), and click **Explore**.
The Mobile Device folder opens in Windows Explorer.

![Image](image_url)

The terminal is now treated as a mass storage device, and transferring files is as simple as dragging and dropping or copying and pasting as you would for moving files between folders on your hard drive.

**Adding Programs to the Terminal Using ActiveSync**

*When selecting programs, verify that the program and version of the program are designed for Windows Mobile and your processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the information in the Processor field.*

Depending on the application, the software must be stored or installed on the host PC.

1. Download the program to your desktop computer from either the Internet or the CD or disk that contains the program. You may see a single *.exe or setup.exe file, a *.cab file, or *.dll. There may also be several versions of files for different device types and processors.

2. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

3. Connect the terminal to the desktop computer via a Hand Held Products communication peripheral.

### If the File is an Installer:

An installer program is one that installs on the PC and the terminal simultaneously; one process installs to both devices.

1. On the PC, double-click the *.exe or *.setup.exe file. The installation wizard begins.

2. Follow the directions on the PC screen. The installation process includes transferring the software to the terminal.

### If the File is Not an Installer:

Some programs cannot be installed on PCs because they are designed for terminals. In these cases, the appropriate files must be stored on the host PC, transferred via ActiveSync, and installed on the terminal. You will know the program cannot be installed on the PC if an error message appears when you try to install it stating that the program is valid but designed for a different type of computer.

1. If you cannot find any installation instructions for the program in the Read Me file or documentation, open ActiveSync and click Explore.*

2. Navigate to the My Pocket PC folder and copy the program file or files to the Program Files folder on the terminal.

   - If you want the program to be part of the Autoinstall that occurs after every hard reset, place the program file in the Autoinstall folder (My Pocket PC > IPSM > Autoinstall).

3. Depending on the program, you may need to open File Explorer on the terminal, navigate to the folder where the program is located, and tap on the program file to install it.

   - If you copied the file to the Autoinstall folder, you can either tap on the program inside the Autoinstall folder or perform a hard reset and the program will install as part of the regular Autoinstall; see Let Autoinstall Run on page 2-4. Remember, a hard reset erases RAM data! For more information, see Hard Reset (Cold Boot) on page 2-6.

After installation on the terminal is complete, tap Start > Programs and the program and its icon appears on the Programs screen. Tap it to open the program.
Using Infrared

Dolphin terminals contain infrared or IrDA ports on the left side panel (see IrDA Port on page 3-10). Using these ports, you can send and receive data between the terminal and other devices equipped with infrared. This can include, but is not limited to, Windows Mobile information such as Contacts and Tasks, as well as software upgrades.

Verify That the IrDA Port is Enabled

The IrDA port must be enabled to transmit data. By default, the IrDA port is assigned to Com port 6 and is enabled. When a Bluetooth radio is installed, the IrDA port can be disabled to free up a Com port for Bluetooth devices.

To verify that the IrDA port is enabled, tap Start > Settings > Connections tab > IrDA.

If Enable IrDA ports is selected, then the IrDA port is active.

Note: The IrDA icon appears on the Connections tab only if there is a Bluetooth radio installed on the terminal.

IrDA Port Location on the Terminal

The above graphics shows the left side panel of the Dolphin 9500 terminal. The location of the IrDA port is the same on all terminals in the Dolphin 9500 Series. For more information, see IrDA Port on page 3-10.

Verify That Beam Settings Are Set to Receive

The Beam Settings must be set to receive for the terminal to receive data from other infrared devices. To verify, tap Start > Settings > Connections tab > Beam. The Beam Settings window should appear as follows:

If Receive all incoming beams is selected, then the IrDA beam is enabled.
Sending Information

To send or receive, the IrDA ports of both devices - whether it’s two terminals, or a terminal and a host device - must be aligned with each other and within a close range. The maximum data-transfer speed is 115 Kbps.

1. Align the IrDA ports.
2. Open the program where you created the item you want to send and locate the item in the list. You can also beam files, but not folders, from File Explorer.
3. Tap and hold the item. A pop-up menu appears.
4. Select Beam File on the pop-up menu. The information begins transmitting to the other device.

Receiving Information

1. Align the IrDA ports.
2. Have the owner of the other device send the information to you.
3. Your terminal automatically begins receiving it.

Troubleshooting

If the Beam Settings are not set to receive or you’ve aligned two IrDA ports and the terminal is still not receiving, tap Start > Settings > Connections tab > Beam. The terminal searches for the sending device.

If the terminal cannot find the sending device, the following message appears:
Using an ISP

The communication software for creating an ISP connection is already installed on your device. Your service provider should provide the software needed to install other services, such as paging and fax services.

After you are connected, you can send and receive e-mail messages by using Inbox and view web pages using Pocket Internet Explorer. For more information, see Inbox on page 11-6. You can also download software applications from the web.

Adding Programs Directly from the Internet

⚠️ When selecting programs, verify that the program and version of the program are designed for Windows Mobile and your processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the information in the Processor field.

1. Determine your device and processor type so that you know which version of the software to install. Tap Start > Settings > System tab > About. On the Version tab, make a note of the information in the Processor field.

2. Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single *.exe or setup.exe file, or several versions of files for different device types and processors.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

4. Tap the file, such as an *.exe file. The installation wizard begins. Follow the directions on the screen.

For more information about working with Pocket Internet Explorer, see Pocket Internet Explorer on page 11-8.
Radio Options

Dolphin terminals can be configured with one or a combination of 802.11b, Bluetooth, or GSM/GPRS (only available on Dolphin 9500 units) radios.

For more information about 802.11b radios, see Wireless LAN (WLAN) Communications with 802.11b on page 8-1.
For more information about Bluetooth radios, see Wireless PAN (WPAN) Communications with Bluetooth on page 9-1.
For more information about GSM/GPRS radios, see Wireless WAN (WWAN) Communications with GSM/GPRS on page 10-1.

Note: Dolphin 9550 terminal supports all radio options and configurations EXCEPT FOR GSM/GPRS!

Radio Combinations

Co-located
Co-located radio combinations are those where you can use only one radio at a time. Both radios can be installed but not operate simultaneously.
802.11b and GSM/GPRS

Co-operational
Co-operational radio combinations are those that you can enable and operate simultaneously.
Bluetooth and 802.11b
Bluetooth and GSM/GPRS

Radio Driver Installation

Radio drivers install during the autoinstall portion of any hard reset. Only the appropriate drivers for your terminal’s radio configuration install. For more information, see Let Autoinstall Run on page 2-4.

When one radio driver installs, its radio is enabled automatically after each hard reset. When more than one radio driver installs, the terminal generally enables the 802.11b radio. However, if a GSM radio is installed, the terminal enables the GSM radio.

Using the Radio Manager

The Radio Manager enables and disables radios and radio combinations.

Single Radio
If your terminal contains a single radio module and its associated driver is installed, the radio is enabled and operates after each hard reset.

Multiple Radio
If multiple radio modules are installed in your terminal, you must enable simultaneous operation of the radios in the Radio Manager. (Configuration of simultaneous radio operation is done during the manufacturing process according to FCC regulations.)

Multiple Radio
GSM and 802.11b are mutually exclusive. While both radios may be installed on the terminal, they cannot operate simultaneously. Therefore, even if you have modules and drivers for both radios installed on your terminal, you will not see GSM and 802.11b together as a radio combination to be enabled in the Radio Manager.

Enabling Radios and Radio Combinations

Requirements
To successfully enable a radio, its hardware module and software driver must both be installed. If the module is present, the radio appears in the Radio Manager. However if the driver is not installed, you cannot successfully enable the radio.

Driver Sequence
When working with radio combinations, the Radio Manager enables and disables the radio drivers as necessary and in the proper sequence.
1. Open the Radio Manager by tapping **Start > Settings > Connections** tab > **Radio Manager**. The Radio Manager appears identifying the radios and radio combinations that can be enabled on your terminal in the Radio Modes list. (To appear on this window, a radio’s hardware module must be installed.)

   ![](image)

2. Select the radio or radio combination and tap **Apply**. The Radio Manager begins enabling your radio or radio combination.

3. When enabled, the **Status** field reads “Success.”

**Radio Manager Window**

- **Radio Modes**
  - The Radio Modes section displays the radio hardware modules currently installed on the terminal.
- **Status field**
  - The Status field provides feedback on the state of the radio:
    - **Ready**
      - The selected radio(s) is enabled and the Radio Manager is ready to receive a command.
    - **Success**
      - The selected radio(s) was enabled successfully.
    - **Error Message**
      - The selected radio(s) could not be enabled.

**To Disable Radios**

Radio drivers are automatically powered down if the radio combination that is currently enabled requires it. To disable all radios, select **None** in the Radio Modes box and tap **Apply**.
### Com Port Assignment Table

<table>
<thead>
<tr>
<th>Com Port</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port 1</td>
<td>Serial port. This is the 17-pin connector on the bottom panel of Dolphin terminals.</td>
</tr>
<tr>
<td>Com Port 2</td>
<td>Bluetooth Module&lt;br&gt; If there is no Bluetooth hardware installed on the terminal, this com port is unassigned.</td>
</tr>
<tr>
<td>Com Port 3</td>
<td>Raw Infrared</td>
</tr>
<tr>
<td>Com Port 4</td>
<td></td>
</tr>
<tr>
<td>Com Port 5</td>
<td>USB virtual serial port</td>
</tr>
<tr>
<td>Com Port 6</td>
<td>IrDA, if IrDA is enabled. If IrDA is disabled, this com port becomes available. See <a href="#">Verify That the IrDA Port is Enabled</a> on page 7-6.</td>
</tr>
<tr>
<td>Com Ports 7-9</td>
<td>Unassigned. These are available for selection only when connecting to devices that use virtual com ports, such as Bluetooth.</td>
</tr>
</tbody>
</table>
Overview

Dolphin terminals are available with an on-board 2.4 GHz 802.11b WLAN (Wireless Local Area Network) radio that uses Direct Sequence Spread Spectrum (DSSS) technology to spread the signal continuously over a wide frequency band at a data rate of up to 11 Mbps. In addition, the open software architecture makes the Dolphin terminal a complete solution for a variety of wireless mobile data collection applications.

Dolphin terminals are interoperable with other 802.11b Wi-Fi-compliant products including Access Points (APs), printers, PCs via PC card adapters and other wireless portable terminals.

Enabling the 802.11b Radio Driver

When the Dolphin terminal initializes, the radio driver for 802.11b is installed. The terminal defaults to the 802.11b radio during initialization unless a GSM radio is installed, in which case, the terminal defaults to the GSM radio. The 802.11b radio must be enabled before you can configure the radio on a network. Verify the radio’s status before configuring.

Note: Radios are enabled manually in the Radio Manager; tap Start > Settings > Connections tab > Radio Manager.

Configuration Utility Options

There are two configuration utilities for the 802.11b radio: 802.11b Settings (default) and the 802.11b Wireless Security Supplement.

802.11b Settings

802.11b Settings is the default configuration utility and should be used to configure the radio with standard WEP (64/128 bit) and no authentication. For more details, see 802.11b Settings later in this chapter.

If you chose to set up the radio with 802.11b Setting, remove the 802.11b Wireless Security Supplement from the device; see Removing the 802.11b Wireless Security Supplement on page 8-2.

802.11b Wireless Security Supplement

The 802.11b Wireless Security Supplement (also known as the AEGIS Client) is an additional configuration utility you should use when configuring the radio using WEP (beyond the standard), Wi-Fi Protected Access (WPA), and authentication.

For details, see 802.11b Wireless Security Supplement later in this chapter.
802.11b Settings

If you want to use standard WEP authentication or no authentication, you need to use 802.11b settings to configure the radio with the 802.11b Settings utility.

Removing the 802.11b Wireless Security Supplement

If you decide to use the 802.11b Settings utility to configure your radio, you must remove the 802.11b Wireless Security Supplement and re-boot the device.
1. Tap Start > Programs > File Explorer.
2. Drill-down to the \IPSM\Autoinstall folder.
3. Delete the .cab file named “LeWM*.cab.”
4. Press and hold Red + Tab keyboard buttons to cold boot the device.

Accessing 802.11b Settings

Access 802.11b settings two ways:
1. Tap Start > Settings > Connections tab > 802.11b Settings.
OR
2. Tap the Status icon in the command bar; see Using the Status Icon.

The 802.11b Settings utility consists of four tabs: Status, Config, Advanced, and About. You configure the radio on the Status, Config and Advanced tabs.

Status Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Channel</td>
<td>Shows the RF channel currently used by the radio.</td>
</tr>
<tr>
<td>Current TX Rate</td>
<td>Shows the current transmit rate. This can be 1 Mbps, 2 Mbps, 5.5 Mbps, or 11 Mbps.</td>
</tr>
<tr>
<td>Disable/Enable Radio</td>
<td>Tap this button to disable/enable the radio.</td>
</tr>
<tr>
<td>Rescan</td>
<td>Tap this button to start a rescan process to search for an AP with a stronger signal in the network.</td>
</tr>
<tr>
<td>Link Quality</td>
<td>Displays the signal to noise ratio.</td>
</tr>
<tr>
<td>Strength</td>
<td>Displays the signal strength at the receiver.</td>
</tr>
</tbody>
</table>
### Field Description

**IP Address**
Displays the IP address of the radio. Verify configuration information with your network administrator.

**Renew IP**
Tap this button to reapply the IP address from the DHCP server when automatic DHCP is enabled.

**State**
Displays the Network Name and the MAC address of the:
- AP the radio is associated with in AP mode, or
- Creator of IBSS into which the radio is joined in peer-to-peer (Ad-Hoc) mode.
After an SSID is chosen, this field name changes to "BSS ID."

**More Info**
Tap this button to display detailed TCP/IP information as shown in the following screen.

**Ping**
Tap this button to open the Ping Utility window where you can ping IP addresses.

### Ping Utility for WLAN

- **IP Address:** 192.168.0.1
- **Size (Bytes):** 32
- **Timeout (ms):** 500

### Ping Statistics

Field | Description
--- | ---
**IP Address** | Enter an IP address to ping.
**Size (Bytes)** | The current data packet size in bytes; 32 is the default. You can select up to 8192 from the drop-down list.
**Timeout (ms)** | The current timeout; 500 is the default. Increase or decrease it by tapping the up and down arrow buttons.
**Clear** | Clears IP Address input and the ping statistics field.
**Ping** | Pings the IP address entered in the input field.
**Ping Statistics** | Displays the pinging IP address and the pinging results.
**Config Tab**

The Config tab provides a list of all APs and peer stations in range. Use the list to create and edit SSID profiles for APs that you want the terminal to associate with.

### Preferred Profiles

The Preferred Profiles section displays a list of your preferred profiles, the profiles you create or add from the list of Active SSIDs below. When applied, the 802.11b radio searches for the APs in the exact order shown in the list of profiles. This section is blank after the initial installation and each hard reset. This section remains blank if no automatic association preference is selected.

This section contains several icons that enable you to add and configure APs.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New</td>
<td>Always active, tap this button to create a new profile.</td>
</tr>
</tbody>
</table>

The following buttons activate only when an Active SSID in the Preferred Profile list is selected.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Edit</td>
<td>Opens the configuration screens for a selected SSID in the Preferred Profiles list.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the selected SSID from the Preferred Profile list.</td>
</tr>
<tr>
<td></td>
<td>Up</td>
<td>Moves the selected SSID up one place in the Preferred Profile list so that the terminal hits it prior to the next SSID.</td>
</tr>
<tr>
<td></td>
<td>Down</td>
<td>Move the selected SSID down one place in the Preferred Profile list so that the terminal hits it after the prior SSID.</td>
</tr>
</tbody>
</table>

**Note:** Remember that the terminal accesses the SSIDs in this list in the exact order that they appear; moving an SSID up or down in the list determines the order of contact.

### Active SSIDs

This table shows all APs or peer stations (creator of IBSS) in the vicinity of the terminal that accept broadcast associations.

Each record displays information in the following six columns (Scroll right to see all the columns.):

<table>
<thead>
<tr>
<th>Column</th>
<th>This column displays…</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSID</td>
<td>The Network Name of the AP or peer station and shows the signal strength icon.</td>
</tr>
<tr>
<td>Signal</td>
<td>Strength in percentage for the selected SSID.</td>
</tr>
<tr>
<td>Mode</td>
<td>The mode of operation</td>
</tr>
</tbody>
</table>

- =$AP$
- =$Peer station$
**Add**

Tap this button to add an Active SSID to the Preferred Profiles list.

**Apply**

Tap **Apply** to associate your station with a selected SSID. The SSID selected can be in the Preferred Profile or Active SSIDs lists. When applied, the Status tab opens displaying the status of the wireless connection. If the association fails, a search for another AP in the Preferred Profile list automatically takes place, and the radio attempts to associate with the station, in order of preference.

**Refresh**

Tap **Refresh** to start a new search for all available APs or peer stations in the vicinity.

---

### To Add an Active SSID to the Preferred Profile Table

An SSID needs to be in the Preferred Profile list to be edited.

1. Select an SSID in the Active SSID list and tap **Add**. The SSID moves to the Preferred Profile list.
   
   If the SSID has the WEP Key turned on, the Settings window displays and prompts you to enter the WEP Method, Encryption Key, and Key ID.
   
2. In the Preferred Profile list, select the SSID and tap **Edit**.

3. Follow the same process for creating a profile.

4. When configuration is complete, tap **OK**.

5. The SSID and its profile are added into the Preferred Profiles list.
   
   If you're adding an SSID with the WEP Key turned off, the Settings window does not display and the SSID is added directly to the Preferred Profile table.

---

### Column | This column displays...
---|---
Channel | The channel and applied WEP method, if any.
| =WEP Key-On
| =WEP Key-Off

| SupRate | Supported data rate of the AP or the peer station.

| BSSID (MAC Addr) | BSSID or MAC Address of the AP or the peer station. |
### Status Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Excellent signal strength. Excellent connection.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Poor signal strength. Poor connection.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Radio disabled. No radio connection.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>(Access Point) AP Mode.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Peer Station, Peer-to-Peer Mode.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>WEP enabled. Network needs a WEP Key to connect.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>WEP disabled. Network does not need a WEP Key to connect.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Mismatched WEP Key configuration with your network.</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Online help button.</td>
</tr>
</tbody>
</table>

### To Create a New Profile

In the Preferred Profiles section, tap the **New** button. Complete the Network Profile and Authentication tab windows.
Network Profile Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Name &amp; Type</strong></td>
<td></td>
</tr>
<tr>
<td>SSID</td>
<td>Enter an SSID, which is the Network Name. Check with your network administrator for Network Name (SSID).</td>
</tr>
<tr>
<td>TX Rate</td>
<td>Choose the transmit rate from the drop-down list - 1MB, 2 MB, Auto 1/2 MB, 5.5 MB, 11 MB, or Fully Auto. The transmit rate is set to Fully Auto by default.</td>
</tr>
<tr>
<td>Type</td>
<td>From the drop-down list, select <strong>Peer-to-Peer</strong>=For communication between two (or more) radio stations (cards) without an AP. <strong>Access Point (AP)</strong>=Infrastructure mode.</td>
</tr>
<tr>
<td>Chan</td>
<td>Scroll to select a channel for communication.</td>
</tr>
<tr>
<td>AP Search Threshold</td>
<td>Select <strong>Low Density</strong> (default), <strong>Medium Density</strong>, or <strong>High Density</strong> from the drop-down list and tap <strong>OK</strong>. AP search thresholds are used for wireless client roaming between APs. In general, the higher the density selected here, the easier your WLAN card roam between APs with the same SSID in the same network. Roaming also depends on the relative signal strength of the AP.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Tap this button to save the profile or changes to the profile.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Tap this button to close the window without saving or modifying the profile.</td>
</tr>
</tbody>
</table>

*Note: The SSID, Type, TX Rate, and Channel fields are unchangeable in AP mode, whereas TX Rate and Channel fields can be changed in Peer-to-Peer mode.*
**Authentication Tab**

On the Authentication tab, you configure the WEP encryption key for secure wireless communication.

To use WEP, the encryption key **must** be configured as part of the profile before connecting. For more information about configuring a profile, see To Create a New Profile on page 8-6.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Authentication Algorithm** | This drop-down list is active and configurable only when the WEP Key is enabled for the selected SSID profile. If this drop-down list is active, select one of the following options:  
  - **Automatic based on WEP setting**=The algorithm automatically matches the AP’s setting. This is the default selection.  
  - **WECA Compliant (always use Open)**=The algorithm should match the AP’s setting for Open.  
  - **Must use Shared with WEP**=The algorithm should match the AP’s setting for Shared. |
| **Method**          | The options in this drop-down list determine what characters can be used to create the WEP encryption key in the Encryption Key field. Select one of the following five:  
  - **Disabled**=WEP Key is off  
  - **64 bit (HEX)** uses 10 characters in Hexadecimal  
  - **64 bit (ASCII)** uses 5 characters in ASCII  
  - **128 bit (HEX)** uses 26 characters in Hexadecimal  
  - **128 bit (ASCII)** uses 13 characters in ASCII  
  HEX=Hexadecimal is a set of 16 characters from 0-9 and A(a)-F(f).  
  ASCII=Any printable ASCII character can be typed. |
| **Key ID**          | Choose from the available Key IDs: 1 (Default), 2, 3, or 4. Check with your network administrator for the WEP Key and Key ID you need to use for your network. |
| **Encryption Key**  | Type in the encryption key for your wireless connection. The format allowed in this field depends on the character set and format selected in the Method field. |
| **Enable 802.1X**   | This option and drop-down list is active only when the WEP Key is enabled. Select this option if access to the network needs group authentication, then select the 802.1X security standard—PEAP or TLS—from the drop-down list. |
| **Properties**      | Tap the Properties button to choose the certificate that applies. Accessing 802.1x networks require personal certificates for authentication. |

*Please note that 802.11b Settings does not support authentication; therefore, these fields are not active. If you are using authentication in your wireless 802.11b connection, you must configure that connection in the 802.11b Wireless Security Supplement. For more information, see 802.11b Wireless Security Supplement on page 8-12.*

**OK**

Tap this button to save the profile or changes to the profile.

**Cancel**

Tap this button to close the window without saving or modifying the profile.
**Encryption Tab**

Leave the **Method** as Disabled. Both authentication and encryption are configured in the *802.11b Wireless Security Supplement* (see page 8-12).

If you must establish WEP parameters in 802.11b Settings, please remove the 802.11b Wireless Security Supplement and cold boot; see *Removing the 802.11b Wireless Security Supplement* on page 8-2. However, the preferred method for WEP encryption is to use the 802.11b Wireless Security Supplement.

**To Delete a Profile**

Profiles may be deleted either from the Preferred List or from the Preferred List and Registry. To delete a profile, select (highlight) a profile and tap the **Delete** button. On the pop-up window select the option of your choice and tap **Yes** to confirm or **No** to cancel.
### Advanced Tab

![Image of Advanced Tab]

**Field** | **Description**
--- | ---
**Power Save Mode** | This drop-down list determines the settings for Power Save Mode.
- **Disable** = Disables the Power Save mode.
- **Always Enable** = Enables Power Save mode. This is the default setting.
- **Auto Enable** = Automatically enables the Power Save mode when the terminal is running on battery power and automatically disables Power Save mode when the terminal is running on external power.

**Slider** | The slider is active only if Power Save Mode is enabled. Move the slider between Best Performance and Best Battery Life. The setting here modulates Power Save Mode to achieve maximum performance and maximum battery life.

**Preamble Mode** | A preamble consists of a Synchronization (Sync) field and a 16-bit Start Frame Delimiter (SFD) field.
- **Long TX Preamble** = Where Sync field consists of 128 bits.
- **Short TX Preamble** = Where Sync field consists of 56 bits.
- **Auto TX Preamble** = Automatically changes between long and short preamble mode transmission based on AP configurations. This is the default Preamble Mode.

**Defaults** | Resets all the settings to default values, which are:
- **Always Enable** for Power Save Mode,
- **Automatic** based on WEP setting for Authentication Algorithm, and
- **Auto TX Preamble** (for Preamble Mode).

**Apply** | Applies changes. This button is active only when a change has been made on the tab.

### About Tab

The About tab displays Version Number and time of build for Network Driver, Configuration Utility, and NIC Firmware.
Using the Status Icon

You access the 802.11b Settings by tapping the Status icon once on the Today screen. The following menu pops up:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless Radio On</td>
<td>Turns on the radio. LED is on and the Link Icon displays with signal strength.</td>
</tr>
<tr>
<td>Wireless Radio Off</td>
<td>Turns off the radio. A pop-up window will ask for your confirmation. If confirmed, the LED will be off and the Status icon will change color from green to red on the top without signal strength displayed. The WLAN card/module will stop functioning.</td>
</tr>
<tr>
<td>Remove Status Icon</td>
<td>Removes the Status Icon from the bottom tray. A pop-up window asks you to confirm. Click Yes to confirm, or No to cancel.</td>
</tr>
<tr>
<td></td>
<td>If confirmed, the Status icon does not display in the task tray, and you will need to go to Start &gt; Settings &gt; Connections tab &gt; 802.11b Settings in the future.</td>
</tr>
<tr>
<td>Wireless Network Status</td>
<td>Opens the Status tab.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Opens the Config tab.</td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>Opens the Advanced tab.</td>
</tr>
<tr>
<td>Version Information</td>
<td>Opens the About tab.</td>
</tr>
</tbody>
</table>

Note: The Status icon changes to a crossed lock as a warning that you may have entered a wrong key (WEP Key mismatch) for the WEP-On AP or a station.
802.11b Wireless Security Supplement

AEGIS Client® offers the most comprehensive IEEE 802.1X supplicant for securing wired and wireless networks. The Client is a standards-based implementation of IEEE 802.1X and can be configured to work with almost any network equipment—wired or wireless—that supports the 802.1X authentication standard. The Client is interoperable with 802.1X-capable wireless APs and authentication servers including Microsoft’s IAS and Cisco’s ACS.

The Client solves the problem of key distribution in wireless LANs by using public key authentication and encryption between Wireless APs (WAP) and roaming stations to exchange dynamic Wired Equivalent Privacy (WEP) keys. In addition, network managers can control 802.1X user profiles from a centralized RADIUS server or, in the case of TTLS, from a RADIUS Diameter or other AAA servers. The Client supports both wireless (802.11a/b/g) and Ethernet interfaces.

802.1X Supplicant Protocol Support

Authentication
The Client supports the following authentication methods according to the 802.1X protocols:

- MD5
- EAP TLS
- EAP TTLS
- Cisco LEAP and PEAP
- Microsoft PEAP

Encryption
The Client supports the following encryptions methods:

- WEP
- TKIP

AP Search Threshold

⚠ If you are using one of these authentication methodologies, you need to configure your 802.11b connection here, NOT through 802.11b Settings. However, if you want to set the AP Search Threshold above the default setting of Low Density, you do need to change that setting in 802.11b Settings; for details, see Network Profile Tab on page 8-7.

Required Network Configuration Information

Because the Client accesses a network that is protected by the IEEE 802.1X protocol, you must configure EAP data communication to match your network server parameters. If the EAP configuration doesn’t match your network configuration, you can’t access the network. Therefore, make sure you have the correct network server parameters on hand when you configure the client.

Opening the Client

To access the client the first time, tap Start > Programs > Meetinghouse AEGIS Client.

After the Client has been activated, you can tap the icon in the lower left corner of the command bar.
**Color Indicators**

The color of the icon indicates the status of the controlled ports.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>This color icon indicates that …</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Icon]</td>
<td>Green</td>
<td>Authentication succeeded.</td>
</tr>
<tr>
<td>![Yellow Icon]</td>
<td>Yellow</td>
<td>Authentication is in process.</td>
</tr>
<tr>
<td>![Red Icon]</td>
<td>Red</td>
<td>Authentication failed.</td>
</tr>
<tr>
<td>![Gray Icon]</td>
<td>Gray</td>
<td>The port is not in use or is disabled. Either the Client isn’t running, or the port is not bound to the 802.1X protocol.</td>
</tr>
<tr>
<td>![Orange Icon]</td>
<td>Orange</td>
<td>The port is associated, but there is no response to 802.11b packets. If using WEP without 802.1x authentication, this will be the final state when the connection is complete. If using 802.1x authentication, it is either a transient condition or can indicate that attempts to authenticate have timed out as there was no response to 802.1X packets.</td>
</tr>
<tr>
<td>![Blue Icon]</td>
<td>Blue</td>
<td>There is no 802.11b activity. The port may not be connected to an 802.1X-aware entity.</td>
</tr>
</tbody>
</table>

If there is no yellow, red or green in the icon then either the ports are not being controlled by 802.1X, or there is no authentication activity on the controlled ports. The absence of yellow, red or green may also indicate that the network access server is not an 802.1X aware device.

**Main Screen**

On the terminal, open the Client. The main screen opens displaying a list of ports on the system’s network interface cards, You manage ports on this screen.

![Main Screen Diagram]

**Port Status Icon**

The main screen contains a port status icon to the left of each port listed. The color of this icon indicates the status of the port. The color of the icon changes as the port starts authentication, negotiates with the AP and/or authentication server, and then joins the network. As the network interface starts or stops, the color of the port icon and the status field in the Interface List updates to reflect the current state of the interface. For details about what each color means, see Color Indicators on page 8-13.
Client Menu
To open the client menu, tap Client in the command bar along the bottom of the window.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the Client's interface, while leaving the client running.</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>Starts or stops 802.1X authentication. After you finish the initial configuration, tap the network interface and tap Start. If the port is already active, tap Stop first, then Start to force the program to read the new configuration file.</td>
</tr>
<tr>
<td>Restart</td>
<td>Same as a Stop followed by Start. Tap this when you receive a notice such as the following:</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens the Configuration screen displaying the User tab.</td>
</tr>
<tr>
<td>Install Protocol</td>
<td>Selecting this option binds the 802.1X protocol to the WLAN adapter currently installed on the device. The WLAN adapter then appears in the port list.</td>
</tr>
<tr>
<td>Exit</td>
<td>Terminates the client, which stops the 802.1X protocol.</td>
</tr>
</tbody>
</table>

View Menu

The Standard and Advanced Views control the number of columns displayed in the main menu.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard View</td>
<td>Displays the Port (adapter name) and State columns. This is the default view.</td>
</tr>
<tr>
<td>Advanced View</td>
<td>Displays the Port (adapter name), State, Primary Wireless Network, Wireless Network, and MAC Address of AP columns. Scroll right to see all columns.</td>
</tr>
<tr>
<td>Event Log</td>
<td>The Event Log is a text file that contains status information from the logging function.</td>
</tr>
</tbody>
</table>
Help Menu

Tapping Help opens the help menu. Select Online Help to access online help. Select About to review software version information.

Status Bar

The status bar at the bottom of the main screen indicates the connection status between the network card and the AP.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Bar</td>
<td>Each entry is listed sequentially with a time stamp and a text message. Tap Refresh to query the log again. Tap Close to return to the main screen.</td>
</tr>
</tbody>
</table>

Port Menu

On the main screen, tapping on a port opens a popup menu that allows the port to be enabled or disabled, configured, or deleted.
Port Menu Options

The port menu enables you to use 802.1X authentication, change the port configuration, or remove it from the port list. If there are no entries in the Port list, follow the advice in the troubleshooting section to resolve the problem.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable and Disable</td>
<td>These commands enable or disable 802.1X authentication on the port. The port should be enabled before the protocol is started. Enabling a port is not the same as starting it (see Client Menu on page 8-14); however, both actions are required for the Client to work.</td>
</tr>
<tr>
<td>Configure</td>
<td>Opens the port configuration screen</td>
</tr>
<tr>
<td>Delete</td>
<td>Selecting Delete has no effect on the Dolphin device because you cannot remove the radio driver from the device.</td>
</tr>
</tbody>
</table>

Configuring the Client

Each user account needs to define the protocol and the credentials the Client will use to authenticate a user. The Client will need to be reconfigured if the device is used on multiple networks, or if different users share the computer.

Note: Fields are grayed out if not relevant to the selected protocol.

On the main screen, tap Client > Configure. The Client Configuration screen opens displaying the User tab.

On this tab, you...

User Settings Tab
Configure authentication credentials and profiles.

System Settings Tab
Set the level of detail that the Client will provide in the system log and zero-config options.

Server Identity Tab
Control how the Client authenticates the server that handles the 802.1X protocol on the network side. This applies only to the TLS, TTLS, and PEAP authentication methods and is used to tell the Client what server credentials to accept from the authentication server to verify the server.
User Tab

The User settings tab defines the protocol and the credentials used to authenticate a user.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Profile        | Multiple user credential profiles can be created for use when the user roams from one network to another. The drop-down list contains existing authentication credential profiles. Select a profile from the list to edit it in the fields that follow.  
  • Tapping Add permits new profiles to be added to the list. A screen appears where you can enter a name for the new profile. Enter a Profile name and tap OK. The name entered appears in the Profile drop-down list.  
  • Tapping Delete deletes authentication profiles. To be deleted, a profile cannot be assigned to a configured network.                                                                                           |
| Identity       | This is the 802.1X identity supplied to the authenticator. The identity value can be up to 63 ASCII characters and is case-sensitive.  
  For tunneled authentication protocols such as TTLS and PEAP, this identity (called the Phase 1 identity) is sent outside the protection of the encrypted tunnel. Therefore, it is recommended that this field not contain a true identity, but instead the identity “anonymous” and any desired realm (e.g. anonymous@myrealm.com).  
  For TTLS and PEAP, true user credentials (Phase 2 identity) are entered in the Tunneled authentication section.  
  When used with PEAP and the .NET Enterprise Server Version 5.2, this field must contain the identity used in both Phase I and Phase II. The Phase II identity field is ignored.                                           |
| Password       | This is the password used for MD5-Challenge or LEAP authentication. It may contain up to 63 ASCII characters and is case-sensitive. Asterisks appear instead of characters for enhanced security.                                                        |
| Authentication type | This is the authentication method to be used - MD5-Challenge, LEAP, PEAP, TLS, or TTLS.  
  Your network administrator should let you know the protocols supported by the RADIUS server. The RADIUS server sits on the network and acts as a central credential repository for Access Servers that receive the radio signals and ultimately block or allow users to attach to the network. |
Use certificate

This is the certificate to be used during authentication. A certificate is required for TLS, optional for TTLS and PEAP, and unused by MD5 and LEAP. Therefore, this option becomes active only when TLS, TTLS, or PEAP is selected as the Authentication type.

If Use certificate is enabled, the client certificate displayed in the field is the one that is passed to the server for verification. To select a client certificate, tap Change and select the certificate from the list that appears.

To appear in this list, certificates must be installed in the system. The Issued to column should match the Identity field and the user ID on the authentication server used by the authenticator.

Your certificate must be valid with respect to the authentication server. This generally means that the authentication server must accept the issuer of your certificate as a Certificate Authority.

When obtaining a client certificate, do not enable strong private key protection. If you enable strong private key protection for a certificate, you will need to enter an access password for the certificate each time this certificate is used.

Tunneled authentication area

Tunneled authentication parameters are used by only by TLS, TTLS and PEAP protocols, in Phase 2 of authentication, and after the secure tunnel has been established. The fields in this section are active only if the TLS, TTLS, or PEAP is selected as the Authentication type.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity</td>
<td>The user identity used in Phase 2 authentication. The identity specified may contain up to 63 ASCII characters, is case-sensitive and takes the form of a Network Access Identifier, consisting of &lt;name of the user&gt;@&lt;user's home realm&gt;. The user's home realm is optional and indicates the domain to which the tunneled transaction is to be routed. Because Microsoft .NET Enterprise Server Version 5.2 does not use this parameter for PEAP, This field will have no effect for PEAP at this time. Phase 1 identity is used instead.</td>
</tr>
<tr>
<td>Password</td>
<td>The password used for the tunneled authentication protocol specified. It may contain up to 63 ASCII characters and is case-sensitive. Asterisks appear instead of characters for enhanced security.</td>
</tr>
<tr>
<td>Protocol</td>
<td>This parameter specifies the authentication protocol operating within the secure tunnel. The following protocols are currently supported for TTLS: EAP-MD5, CHAP, PAP, MS-CHAP and MS-CHAP-V2. The following protocols are currently supported for PEAP: EAP-MS-CHAP-V2, TLS/SmartCard, and Generic Token Card (EAP-GTC).</td>
</tr>
</tbody>
</table>
**System Tab**

The System Settings tab controls logging and the port manager timeout period.

### Log Level

These settings control the detail of the log messages generated by the Client. Each level is cumulative. By default, all errors, warnings, and information events are logged. Each entry records a severity code (of one [debug message] to four [error] asterisks), a time stamp, and a message.

- **Errors** - only the most severe conditions are logged.
- **Warnings** - less severe conditions are logged.
- **Information** - all errors, warnings, and information events are logged. This is the default setting.
- **Debugging** - creates a log message each time the Client detects or reacts to an event. Be advised that log entries fill memory quickly if the Debugging level is chosen. Do not use the Debugging option for a significant length of time because most internal operations generate messages.

### Defaults

Tap this button to return log settings to the default settings.

### Save credentials for (min)

Use the up and down arrows to specify the number of minutes to save credentials for.

### Disable Wireless Zero Config

Selecting this option disables other wireless utilities whether the Client is running or not. If not selected, other wireless utilities cannot apply their settings to the wireless card while the Client is running (although their status displays are usually unaffected). You will need to perform a soft reset whenever this setting is changed.

### Port Manager Timeout

The interval at which the client polls the ports. This is used under different circumstances, for instance after physical changes such as card removal or insertion have been detected. This value should not be changed from the 10-second default unless so advised by technical support.
Server Tab

The Server identity tab defines the credentials the client uses to authenticate the server during TLS/TTLS/PEAP authentication message exchange. The Client uses this information to verify that the Client is communicating with a trusted server.

Field | Description
--- | ---
**Do not validate server certificate chain** | If this option is selected, the server certificate received during the TLS/TTLS/PEAP message exchange is not validated.

**Certificate issuer must be** | This is the certificate authority used during TLS/TTLS/PEAP message exchange. *Any Trusted CA* is the default selection and means that any certificate authority can be used during authentication. Both trusted intermediate certificate authorities and root authorities whose certificates exist in the system store are available for selection in the drop-down list.

**Allow intermediate certificates** | This option is selected by default and enables unspecified certificates to be in the server certificate chain between the server certificate and the certificate authority selected in the *Certificate issuer must be* field. When selected, this option allows the server certificate received during negotiation to be issued directly by the certificate authority or by one of its intermediate certificate authorities. If disabled, then the selected Certificate issuer must have directly issued the server certificate.

**Server name must be** | This is either the server name or the domain the server belongs to, depending on which option is selected below the text field. During authentication, this name will be compared to the server certificate's Subject: CN field.

**Must match exactly** | When selected, the server name entered must match the server name found on the certificate exactly.

**Must contain domain name** | When selected, the server name field identifies a domain and the certificate must have a server name belonging to this domain or to one of its sub-domains (e.g., zeelans.com, where the server is blueberry.zeelans.com).

**Configuring the Port**

On the main screen, tap and hold on a port, and select Configure on the popup menu. The Port Settings Configuration screen opens displaying the Wireless Networks tab.
Wireless Networks Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Networks</td>
<td>Displays the networks the terminal recognizes as available to connect to. When the Client is first installed, there are no entries in the Available Networks list.</td>
</tr>
<tr>
<td>Scan</td>
<td>Displays a list of networks broadcasting their availability. You can also attach to networks who are not broadcasting.</td>
</tr>
<tr>
<td>Move to Configured</td>
<td>Activates after Scan has been tapped and the available networks have been retrieved. In the list of networks retrieved, select the network you wish to connect to, and tap Move to Configured. This selects the network.</td>
</tr>
<tr>
<td>Configured Networks</td>
<td>Displays the networks your terminal is connected to. This section adds and removes networks as well as reviews and edits the properties of existing configured networks.</td>
</tr>
<tr>
<td>Default</td>
<td>When the Client is first installed, there is a Configured Network named &quot;default&quot; in the list. This profile has Associate with any network selected in its Properties selection screen. If you are going to be in a location with only one AP (or more than one AP that attaches to the same network), the default profile may be sufficient for your needs, without necessitating the selection of a specific network or networks. If default is last in the list, it can act as a wildcard should you be out of the range of your primary networks (which are listed first). Do not place default at the top or middle of the list because, if it is, connection to the other list entries will never be attempted.</td>
</tr>
<tr>
<td>Up</td>
<td>Moves a selected network up one place in the list.</td>
</tr>
<tr>
<td>Down</td>
<td>Moves a selected network down one place in the list.</td>
</tr>
</tbody>
</table>

Note: The order of the networks in this list is the exact order that connections will be attempted. The network listed first will be attempted first and so on. Place your primary networks first.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Manually adds a network to the Configured Networks list if the AP does not broadcast its SSID or you are pre-configuring the client for an AP that is not currently in range.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a selected network in the list.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the properties of the network selected in the list. This button opens the same network configuration screen as the Add button does; use it to edit network configuration properties.</td>
</tr>
</tbody>
</table>
**Protocol Tab**

The Protocol tab configures parameters that apply to all the networks the selected port connects to.

---

**Protocol Settings**

These are the timer intervals and retry settings defined in the 802.1X standard. They determine how long the supplicant state machine will wait in a given state. These parameters shouldn’t be modified without an understanding of the supplicant state machine. For more information about the supplicant state machine, obtain its 802.1X protocol specification.

The parameters are:

- **Authentication Timeout** - The period of time the Client remains in the authenticating or acquired state without receiving a response from the AP or switch.
- **Held Timeout** - The period of time the Client remains in the held state after failing authentication.
- **Start Timeout** - The period of time the Client remains in the connecting state before restarting when there is no response.
- **Number of Start Attempts** - The number of times the Client restarts before giving up. At that point, the Client then defaults to the authenticated state, but there will be no network connectivity because the protocol exchange was never completed.

**Display EAP notifications**

Specifies that the EAPOL notification message will be displayed to the user. An authenticator may use such notification to inform you, for example, about a near password expiration. However, some authenticators send chatty and annoying notifications that may, for the convenience of the user, be suppressed. Note that all notifications are written to the event log even if they are not displayed.

**Renew IP address**

Initiates a DHCP request to obtain a dynamic IP address after a successful authentication, but only if the client detects that the connected network (the SSID) has changed. The result is that renewal should not occur upon re-authentication, but does occur at boot or when connecting to a different network.

If you have a slow authenticator, you may wish to enable this option when configuring the service because a slow authenticator may prevent you from getting a DHCP-assigned IP address upon boot-up. This option is ignored if the given adapter has a static IP address.
Configuring a Network Profile

To configure a network profile, on the main screen, tap and hold on the port, tap Configure, then tap Add. The Network Profile screen opens displaying the Profile Info tab.

![Network Profile Screen]

**Note:** The settings on these tab windows are interrelated. This means that selecting one may disable access to others.
Profile Info Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Profile</td>
<td>Enter the name of this record. This is the name that appears in the Configured Networks list and, by default, is the same as the broadcast SSID. Note that there is nothing special about the name &quot;default&quot;. You could configure any other record similarly and it would behave the same way.</td>
</tr>
<tr>
<td>Network Name</td>
<td>This is the SSID of the AP. If the AP broadcasts its SSID, then this value may be derived from the Available Networks list. If the SSID does not broadcast, then you must manually enter the value here.</td>
</tr>
<tr>
<td>Peer-to-Peer Group</td>
<td>Select this option to have two or more client workstations communicate with each other without the benefit of an AP. You should also select Do Active Scan and, in the WEP Management page, enable Use key for data encryption while entering a common key for both sides. WPA is not supported in this mode.</td>
</tr>
<tr>
<td>Do active scan</td>
<td>Select this option whenever the AP (or client, for ad hoc mode) is not broadcasting its SSID.</td>
</tr>
<tr>
<td>Authentication Profile</td>
<td>Select the Client Configuration (user) profile associated with this network. The drop-down list contains the profile names created on the User tab of the Client configuration area. To open the selected profile, select it in the drop-down list and tap View. The User tab opens displaying the profile details. If you tap OK (to save changes) or Cancel, you are returned to the Profile Info tab.</td>
</tr>
</tbody>
</table>

WEP Mgmt Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide encryption key dynamically</td>
<td>This option is selected by default. If this option is selected, the other WEP settings on this page are disabled. To enter a custom WEP, de-select this option. The other fields become active.</td>
</tr>
<tr>
<td>Use key for data encryption</td>
<td>Select this option to manually enter a WEP key to encrypt your data to the AP. You enter that key in the Key field below.</td>
</tr>
<tr>
<td>Use key to authenticate with AP</td>
<td>Select this option if your network does not support 802.1x authentication and you need to connect to the AP without username and password authentication. The key entered below is used to authenticate instead.</td>
</tr>
</tbody>
</table>
WP A Settings Tab

The WPA Settings tab appears only when the device you are configuring uses WPA.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>In this field, enter the WEP key. ASCII: 5 or 13 characters Hexadecimal: 10 or 26 characters. When the key entered is in the correct format, the screen changes to display the type - ASCII or Hexadecimal.</td>
</tr>
<tr>
<td>Key Index/Transmit Key</td>
<td>The Key Index drop-down list contains the available keys. You may enter up to four keys for reception; the Client will try all four to find one that works with the AP. From the drop-down list, select the key to be used for transmission as well. If the key selected is the transmit key, the Transmit key box is checked. To change the transmit key, select another key and check the Transmit key box. The check box of the original transmit key will be automatically de-selected.</td>
</tr>
</tbody>
</table>

**WPA Settings Tab**

The WPA Settings tab appears only when the device you are configuring uses WPA.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| WPA Mode               | This drop-down list contains the following options:
  • Disabled—This is the default selection. Do not enable WPA mode.
  • WPA 802.1x—Enable WPA and obtain key information through the 802.1x protocol.
  • WPA PSK—Enable WPA with Pre-Shared Key (PSK) information entered in the field below. This mode is used if the 802.1x protocol is not being used for authentication. |
| Encryption             | Select the encryption method from:
  • WEP
  • TKIP
  • *AES
  *AES is not supported in Dolphin 9500 Series hardware. |
| PSK pass-phrase        | This field activates if you select WPA PSK in the WPA Mode drop-down list. Enter a Hexadecimal value that is 64 characters long. Asterisks appear as you type for increased security. |
**Logging**

The event log is an ASCII text file named “LOG8021X.TXT” located in the directory defined by the WINDIR environment variable (usually the Windows directory). The information the log records is determined by the log settings on the System tab.

The format of the entries is

```
Time Stamp   Message Text
```

The Refresh button at the bottom of the screen is used to update the log file while you are reading it. If the file gets too large, old entries are automatically deleted.

If you wish to start with a blank file, exit from the Client (so the icon no longer appears at the lower right of the screen) and delete the log file (log8021x) in File Explorer.

When you restart the Client, a new log file is created.

**Installing Certificates with CertAdd**

**Certificate Requirements**

During configuration, you may have specified one or two certificates to use during the authentication process. The specified identity should match the Issued to field in the certificate and should be registered on the authentication server (i.e., RADIUS server) that is used by the authenticator. In addition, your certificate must be valid on the authentication server. This requirement depends on the authentication server and generally means that the authentication server must know the issuer of your certificate as a trusted Certificate Authority (CA).

If the selected certificate does require a password or pass phrase to decode the private key, enter this value in the “Certificate Pass Phrase” field. This value will be encrypted when the configuration is saved. However, on some systems, there may not be a certificate. If that is the case, you can use the section below as a primer on OS X certificate management.

**About CertAdd**

CertAdd is a standalone utility that allows certificates to be selected and installed on a Windows Mobile device.

**Installing Certificates**

Client or CA certificates can be imported from *.cer (same as *.der), *.p7b, or *.pfx files.

1. Download the certificate file to the My Documents folder. The location isn't critical, although you may want to create a standard folder for consistency.

2. Go to Start > Programs > Meetinghouse Certificate Installer. All valid certificate file types located in the My Documents folder appear in the list.
3. Tap and hold on a certificate in the list. A pop-up appears asking if you want to install the certificate.

4. Tap OK. The certificate is loaded into the correct certificate store.
### Advice and Workarounds

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Client will not start on the device with an error message about missing files.</td>
<td>Perform a soft reset.</td>
</tr>
</tbody>
</table>
| The wireless network interface (port) does not appear in the main AEGIS screen. | - The license is not valid (If you have entered a time-limited license, is your clock on the device correct?).  
- Restart the client - on the main screen tap Client > Restart.  
- Perform a soft reset.  
- If the radio is turned off or the radio card is not present, this will sometimes cause the port name to not appear.  
- If the radio driver is very old and does not support NDIS 5.1 commands, the Client may not be able to detect it. |
| The wireless network interface appears, but when I select it and tap Configure, the Scan button is disabled. | Enable the radio; Start > Settings > Connections tab > Radio Manager.                          |
| The client is not attaching to the correct AP.                       | The default network profile instructs the client to attach to the first available AP. On the Wireless Networks window, select a network, move it to Configured Networks, and then move it above default in the list. |
| The Client is failing authentication even though all my information was entered correctly. | 1. Verify that the network profile for the AP corresponds to the authentication profile you created for it.  
- Select the network profile in the Configured Networks list.  
- Tap Properties. The Profile Info tab opens; see page 8-24.  
- In the Authentication profiles drop-down list, select the profile you want to review.  
- Tap View. The User tab appears displaying the profile’s information.  
2. Verify that you have configured the identity and password into the correct fields on the User tab in the authentication profile. If you are using PEAP or TTLS, the username and password are entered in the Tunneled authentication section. |
| My AP does not broadcast its SSID. Even though I have manually configured an AP with that name, the Client won't associate with it. | - Make sure that the desired SSID is listed as the Network Name, not the Network Profile (which is a screen label).  
- Verify that Do Active Scan is selected on the Profile Info tab. If not selected, the Client will not attempt to find the AP. |
<p>| I am authenticated, but I don't get an IP address through DHCP.      | On the main screen, tap and hold on your AP, tap Configure on the popup menu, and select the Protocol tab. Verify that Renew IP Address is selected. |</p>
<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible Causes and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>I cannot attach to my old network that does not support 802.1x</td>
<td>• Verify that you can see your SSID in the Available Networks list on the Wireless Networks tab. Move the SSID to</td>
</tr>
<tr>
<td>authentication, but is using WEP encryption.</td>
<td>the top of the Configured Networks list so that it is accessed first. If the SSID is not there, you can add it</td>
</tr>
<tr>
<td></td>
<td>manually and enter the SSID as the network name.</td>
</tr>
<tr>
<td></td>
<td>• Select the SSID and tap Properties.</td>
</tr>
<tr>
<td></td>
<td>• On the Profile Info tab, select Do active scan if your AP does not broadcast its SSID.</td>
</tr>
<tr>
<td></td>
<td>• On the WEP Mgmt tab, select Use key for data encryption and Use key to authenticate with AP.</td>
</tr>
<tr>
<td></td>
<td>• Enter the WEP Key.</td>
</tr>
<tr>
<td></td>
<td>• On the Protocol tab, select Renew IP Address (unless you have entered one manually separate from the Client)</td>
</tr>
<tr>
<td></td>
<td>• Note that the port status indicator in the main screen reads &quot;Associated,&quot; not &quot;Authenticated&quot; when the</td>
</tr>
<tr>
<td></td>
<td>connection is complete; although the log file will indicate &quot;Entered AUTHENTICATED state.&quot;</td>
</tr>
<tr>
<td>I made changes, but they do not appear to have taken effect.</td>
<td>Always tap OK before exiting a screen you have changed. Then restart the Client from the Client menu on the main</td>
</tr>
<tr>
<td></td>
<td>screen.</td>
</tr>
<tr>
<td>How do I enable peer-to-peer (ad-hoc) mode to have two clients</td>
<td>• On the Wireless Networks tab, add a new profile to the Configured Network list.</td>
</tr>
<tr>
<td>communicate without an AP?</td>
<td>• On the Profile Info tab, give each side the same network name (SSID).</td>
</tr>
<tr>
<td></td>
<td>• Select Peer-to-Peer Group (ad hoc mode) and Do active scan.</td>
</tr>
<tr>
<td></td>
<td>• On the WEP management section, select Use key for data encryption and enter an identical key for both clients.</td>
</tr>
<tr>
<td></td>
<td>• Verify that this network profile is the first (or only) one in the Configured Network list and try to restart</td>
</tr>
<tr>
<td></td>
<td>both clients at roughly the same time.</td>
</tr>
</tbody>
</table>
Overview

Dolphin terminals are available with a Bluetooth radio for WPAN (Wireless Personal Area Network) usage. When the Dolphin is first initialized, the *.cab file and module for Bluetooth are installed.

Enabling the Bluetooth Radio

Before using the radio, make sure that the Bluetooth radio is enabled. When the radio is enabled, the Bluetooth icon appears in the task tray on the Today screen.

Note: Radios are enabled in the Radio Manager; tap Start > Settings > Connections tab > Radio Manager.

Setting Up Your Bluetooth Card

Note: If you use the Get Connected! Wizard, which is recommended for normal usage, then this step is not necessary. This step would be used to change the friendly name of your device.

1. Tap the Bluetooth icon that appears in the task tray on the Today screen.
2. In the pop-up menu, select Advanced Features, then My Bluetooth Device. (If you installed OBEX, the menu also lists Transfer via Bluetooth.)
3. On the General tab, you can modify the Friendly Name and make any desired configuration changes. When done, tap OK.

- In normal phone connect operation, Discoverable mode is not needed and should be disabled.
- If you do enable Discoverable mode (e.g., for ActiveSync), note that it does not shut off by itself. To save power, remember to disable it when not needed.
- Connectable, Use Authentication, and Use Encryption are also not required for printing or dial-up networking applications.
- Check Use Authentication to enable the Use Encryption option.

Assign COM Ports

Follow these steps to view and/or modify the Bluetooth COM ports.

1. Tap on the Bluetooth icon on the Today screen. Select Advanced Features, then My Bluetooth Device.

Note: If you installed OBEX, the menu also lists Transfer via Bluetooth.
2. Tap on the **COM Ports** tab.

3. As needed, view and/or enable/disable the Bluetooth COM port assignments. Tap **OK**.

You can also disable the IrDA port to free up a port for Bluetooth devices. Tap **Start > Settings > Connections** tab > **IrDA** and select **Disable IrDA Port**.

*Note: The Bluetooth Phone port can be enabled or disabled.*

**Object Sharing**

1. Tap the Bluetooth icon that appears in the task tray on the Today screen.
2. In the pop-up menu, select **Advanced Features**, then **My Bluetooth Device**.
3. Tap the **Object Sharing** tab.

**Discover Bluetooth Device(s)**

Follow these steps to discover other Bluetooth devices nearby, including non-phone devices. The Device Discovery Wizard is a more detailed alternative to using the Bluetooth “Get Connected!” Wizard or Bluetooth ActiveSync or Bluetooth LAN Access options. The Device Discovery Wizard allows you to discover any type of Bluetooth device.

1. If not open, launch the **Bluetooth Devices** folder. Tap on the Bluetooth icon on the **Today** screen. Select **Advanced Features** then **Bluetooth Devices**.
2. In the **Bluetooth Devices Folder**, tap on the **Device Discovery** icon. Or you can tap on **Tools**. In the pop-up menu, select **Device Discovery**.
3. Follow the Bluetooth Device Discovery Wizard to search for Bluetooth devices nearby. When prompted, select the device type you seek.

4. When the search is complete, a screen reports the discovered Bluetooth devices. Check the box next to any device you wish to save information about, (i.e., any devices you wish to connect to). Tap Next.

5. A service discovery phase begins, 5-10 seconds per chosen device.

6. In the next screen, tap Finish.

**Bond With Discovered Device(s)**

Follow these steps to bond with an already discovered Bluetooth device. In most cases, bonding is for establishing secure communications with a Bluetooth-enabled phone. This is a more detailed alternative to using the Bluetooth “Get Connected! Wizard.”

**Important!**
- Do not try to bond with a Motorola Timeport 270C or Nokia 6310!
- Do not use this method to bond with a printer! The third-party printing software included on the installation CD also handles bonding.

1. If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon in the Today screen. Select Advanced Features, then Bluetooth Devices.
2. Tap and hold your stylus on the Bluetooth device you want to bond with. In the pop-up menu, select **Bond**.

3. Alternatively, after selecting a device, tap on the **Bond** icon. Or tap on **Device**, then select **Bond**.

4. The **Bluetooth Device Bonding Wizard** launches. Follow the wizard to bond with your selected device.

5. As prompted, make sure the Bluetooth device that you want to bond with is in **Bondable** mode.
6. If the remote device is set up to accept bonding, a Bluetooth Passkey screen appears. To continue bonding, enter the correct passkey and tap Reply.

7. When you have successfully bonded with the other device, tap Finish.

**View Device Properties**

Follow these steps to view the properties of an already discovered device.

1. If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced Features then Bluetooth Devices.

2. Select a device. Tap on the Properties icon, or tap on Device then select Properties. Alternatively, you can tap and hold your stylus on the Bluetooth device you want to view information about. In the pop-up menu, select Properties.

3. Use the General and Services screens to research device properties. If needed, assign a new device type icon by tapping on the arrow buttons in the General screen. You can also use the Device name field to rename the device. When done, tap OK for the setting to take effect.

**Set Up Your Favorite Device**

Follow these steps to set up default devices in the Bluetooth Devices folder. Please note that the Get Connected! Wizard automatically assigns the favorite phone.

1. Tap Tools > My Favorites.
2. Tap on the tab for the type of device you would like to set a favorite for. If needed, use the arrow buttons to scroll and find the tab you need.

```
   [Image of tab]
```

Note: Tabs appears only for COM ports you have enabled. To enable a port, refer to the “Assign COM Ports” section earlier in this chapter. All tabs contain the same options for their type.

3. To select a favorite device, select **Use the favorite selected above**. In the drop-down list, select your device. Tap **OK**.

4. After setting a device as your favorite, its icon appears in the Bluetooth Devices folder with a heart next to it.

**Change Views**

You can switch between the **Large Icons** or **Details** views for the **Bluetooth Devices** folder.

1. In Bluetooth Devices, tap on **View**.

2. In the pop-up menu, choose between **Large Icons** or **Details**.

```
   [Images of Large Icons and Details views]
```

Note: In **Details** view, you can see the Device Class and scroll right to see the current Bonded status.

**Delete a Device From the Folder**

If you no longer plan to connect with it, you can delete a device from the **Bluetooth Devices** folder.

1. If not open, launch the **Bluetooth Devices** folder.

2. Tap and hold your stylus on the device you wish to delete. In the pop-up menu, select **Delete**.
**Turn Radio Transmitter ON/OFF**

You may want to turn off the radio transmitter to save power or if you are entering an area with radio restrictions (e.g., an airplane).

1. Tap on the Bluetooth icon in the task tray on the Today screen.
2. In the pop-up menu, select **Turn Transmitter OFF**.
3. The Bluetooth Card radio transmitter shuts off. The Bluetooth icon and menu options turn gray.
4. To turn the radio transmitter back on, tap on the gray Bluetooth icon. In the pop-up-menu, select **Turn Transmitter ON**.

**Bluetooth ActiveSync**

This section explains how to quickly and easily ActiveSync to a notebook or desktop computer with Microsoft ActiveSync.

1. Tap on the Bluetooth icon. In the pop-up menu, select **Bluetooth ActiveSync**.
2. The next screen varies if your Bluetooth Devices folder contains computers, and if one is chosen as your favorite. Please refer to the appropriate scenario:

**SCENARIO #1:** Your Bluetooth Devices folder contains a favorite desktop computer.

(a) When you tap **Bluetooth ActiveSync**, your device automatically tries to connect to your favorite computer.

(b) The Connect To screen appears, reporting that it is trying to connect to Wireless ActiveSync.

(c) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize files, if desired.

**SCENARIO #2:** Your Bluetooth Devices folder contains no favorite desktop computer.

(a) When you tap on **Bluetooth ActiveSync**, a screen appears that allows you to choose which computer to connect to in your Bluetooth Devices folder. Choose a computer from the list and tap Select, or tap **Find** to search for another computer.

**Note:** If the computer you want to connect to is not listed, tap **Find** to begin a search. Proceed as described in Scenario #3 on page 9-8.

(b) Your device attempts to connect to your selected computer.
(c) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize files, if desired.

**SCENARIO #3:** Your Bluetooth Devices folder contains no computers.
(a) When you tap on Bluetooth ActiveSync, a Bluetooth Device Search automatically begins.

![Bluetooth ActiveSync](image)

*Note:* You can also start the device search by tapping Find in the Bluetooth Devices screen.
(b) After the search is complete, select the computer you wish to ActiveSync with and tap **Select**. If the computer is not listed, make sure the computer is discoverable and tap **Refresh** to search again.

![Bluetooth Device Search](image)

(c) After you tap **Select**, a service discovery phase begins.
(d) The Connect To screen appears, reporting that it is trying to connect to Wireless ActiveSync.

![Connect To](image)

(e) After a successful connection is made, the status screen reports Connected. Now you are ready to synchronize, if desired.

**Bluetooth LAN Access**

This section explains how to use the Bluetooth LAN Access feature to quickly and easily connect to a Bluetooth-enabled LAN access point.

1. Tap on the Bluetooth icon. In the pop-up menu, select **Bluetooth LAN Access**.

2. The next screens varies depending on if your Bluetooth Devices folder contains any access points, and if one is chosen as your favorite. Please refer to the appropriate scenario:

**SCENARIO #1:** Your Bluetooth Devices folder contains no favorite access point.
(a) When you tap Bluetooth LAN Access, a screen appears that allows you to choose which access point to connect to in your Bluetooth Devices folder. Choose an access point from the list and tap Select.

Note: If your access point is not listed, tap Find and proceed as described in Scenario #3.

(b) Your device tries to connect to the selected access point.

(c) If your LAN requires a passkey, a screen appears asking for the passkey. Enter the passkey, then tap OK.

(d) After a successful connection is made, the status screen reports Connected.

(e) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #2: Your Bluetooth Devices folder contains a favorite access point.
(a) When you tap Bluetooth LAN Access, the device automatically tries to connect with your favorite access point.

(b) If your LAN requires a passkey, a screen appears, asking for the passkey. Enter the passkey, then tap OK.

(c) After a successful connection is made, the status screen reports Connected.

(d) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #3: Your Bluetooth Devices folder has no access points.
(a) When you tap **Bluetooth LAN Access**, the device automatically begins to search for new Bluetooth devices.

![Bluetooth Device Search](image)

**Note:** You can also start the device search by tapping **Find** in the Bluetooth Devices screen. See Scenario #2.

(b) After the search is complete, select the access point you wish to connect to. Tap **Select**. If the access point is not listed, tap **Refresh** to search again.

![New Bluetooth Devices](image)

(c) After you tap **Select**, a service discovery phase begins.

![Service Discovery](image)

(d) If the LAN requires a Passkey, a screen appears, asking for the Passkey. Enter the passkey, then tap **OK**.

(e) After a successful connection is made, the screen reports **Connected**.

![Connected to Bluetooth LAN Access](image)

(f) Now you are ready to access your LAN for Internet access, files, etc.

**OBEX**

This section explains how to use the OBEX (object exchange) application to trade business cards, contacts or files with another Bluetooth device that supports OBEX.

Bluetooth OBEX application supports five operations:

- Exchange Business Cards
- Send a Contact
- Send a File
- Browse Remote Device
- Receive Contact or File
- Enable File Sharing

The first four operations - exchange business cards, send a contact, send a file, and browse remote device - are client-oriented. They involve initiating an object exchange.

The last two operations - receive contact or file and enable file sharing - are server-oriented. They involve accepting objects in an exchange initiated by another Bluetooth device.
Exchange Business Cards

1. Make sure both Bluetooth devices have a business card assigned to them. If each device does not have a business card assigned to it, you cannot exchange business cards.

   To assign a business card to your device, do the following:
   - Tap on the Bluetooth icon. In the pop-up menu, tap Advanced Features > My Bluetooth Device.
   - Tap on the Object Sharing tab. Under My business card, tap Assign.
     
     - In the next screen, select your business card and tap OK. If your business card is not listed, tap Contacts to create one.

   When you return to the Object Sharing screen, tap OK.

2. Make sure the other Bluetooth device is set up to receive a contact. The device must support the OBEX Object Push profile.

   Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.

3. Now you are ready to exchange business cards. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Exchange Business Cards.

4. If your device has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices nearby.
5. Select the Bluetooth device you wish to exchange business cards with. If the device is not listed, tap Find.

6. Your device begins exchanging business cards. After the exchange, the new business card should appear in your Contacts.

Send a Contact

1. Make sure the other Bluetooth device is set up to receive a contact. It must support the OBEX Object Push server profile. Refer to the documentation that came with the device for instructions.

   Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.

2. Now you are ready to send a contact. Go to your Contacts folder.

3. Tap and hold your stylus on the contact(s) you would like to send. In the pop-up menu, select Send Via Bluetooth.

4. If your device has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices nearby.
5. Select the Bluetooth device you wish to send the contact(s) to. If the desired device is not listed, tap **Find**.

![Image of Bluetooth contacts selection]

6. Your device processes and sends the contact(s).

![Image of Send via Bluetooth]

**Send a File**

1. Make sure the other Bluetooth device can receive a file; that device must support the OBEX Object Push server profile.

   *Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a file by tapping the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Receive Contact or File.*

2. Now you are ready to send a file. Tap the **Bluetooth** icon. In the pop-up menu, tap **Transfer via Bluetooth > Send a File**.

![Image of Bluetooth settings]

3. If your device has no devices in the Bluetooth Devices Folder, then it begins to search for Bluetooth devices nearby.

4. Select the Bluetooth device you wish to send a file. If the desired device is not listed, tap **Find**.

![Image of Bluetooth device selection]
5. In the next screen, tap on the file you wish to send. You can use the Folder and Type drop-down menus to search for your file. Also, you can scroll horizontally to view the folder, date, size, type, and location of each file.

![Folder and Type drop-down menus]

6. Your device sends the file.

![Send a File]

**Browse Remote Device**

The Bluetooth File Explorer lets your device share files with another Bluetooth device. The other device must support the OBEX File Transfer server profile.

This section covers the following file transfer operations:

- Prepare for file transfer
- Send/receive file(s) or folder(s)
- Create a folder
- Delete file(s) or folder(s)
- Refresh remote view
- Connect/disconnect
- Exit the program

*Note:* “Local device” refers to the device you are running the OBEX from. “Remote device” refers to the Bluetooth device you are trying to transfer files with.

**Prepare for File Transfer**

1. Make sure the remote device has file sharing enabled. It must support the OBEX File Transfer server profile.

*Note:* If the other device is also using the Bluetooth Connection Kit, you can enable file sharing by tapping the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Enable File Sharing.

2. Now you are ready to browse the remote device. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth > Browse Remote Device.

3. If your device has no devices in the Bluetooth Devices Folder that supports OBEX File Transfer, then it begins to search for Bluetooth devices nearby.
4. Select the Bluetooth device you wish to browse. If the desired device is not listed, tap **Find**. If the device is in the list, select it and tap **Select**.

5. Your device begins to establish a file sharing connection.

6. After the devices successfully connect, the Bluetooth File Explorer appears. Half of the screen shows contents of the remote device, while the other half shows contents of your device (the local device). The very bottom of the screen reports the connection status.

**Send/Receive File(s) or Folder(s)**

- Single-tap items to select them for transfer.
- Double-tap on a folders to open it and see its contents.

1. Select the file(s) or folder(s) that you wish to transfer. You can select items from only one device per transfer session.

2. There are two different ways to initiate the transfer:
   - Tap **File > Send to remote** or **Get from remote**, as applicable. The inappropriate option should be gray.
   - Tap on the **Send to remote** icon or **Get from remote** icon, as applicable. The inappropriate icon should be gray.

3. A screen reports the status of the transfer.
4. After the transfer, a copy of each selected item should appear in the other device.

Create a Folder
1. Tap on the File menu. Select Remote device or Local device, wherever you want to create a folder, then tap Create remote folder or Create local folder, as applicable.

2. You can also tap and hold your stylus on an item in either the remote or local device that you wish to put in a new folder. In the pop-up menu, select Create folder.

3. In the next screen, enter a name for your new folder. Tap OK.

4. The new folder should be listed under the appropriate device.

Delete File(s) or Folder(s)
1. Select the items you wish to delete. You can only delete items from one device at a time.

2. Tap on the File menu. Select Remote device or Local device, wherever the items are located, then tap Delete remote item(s) or Delete local item(s), as applicable.

3. Once in local or remote, tap and hold on the item you want to delete and select Delete folder on the popup menu.

4. In the Confirm screen, tap Yes.
Refresh Remote View
1. Tap on the Device menu. Select **Refresh** remote view.

2. Your local device begins to read the contents of the remote device.
3. After a few seconds, the contents view of the remote device is refreshed.

Connect/Disconnect
To connect to the remote device, do the following:
1. Make sure the remote device has file sharing enabled.
2. Start the connection process by either of two methods:
   - Tap **Device > Connect**.
   - Tap the **Connect** icon.
3. On the next screen, select the device you wish to connect to and tap **Select**. Your device attempts to connect to the selected device.

To disconnect from the remote device, do the following:
1. Start the disconnection process by either of two methods:
   - Tap **Device > Disconnect**.
   - Tap the **Connect** icon.
2. Your device disconnects from the remote device. Afterwards, no contents are listed for the remote device.

Exit Bluetooth File Explorer
To exit the Bluetooth File Explorer, tap **File > Exit**.

Receive Contact or File
1. Tap on the Bluetooth icon. In the pop-up menu, tap **Transfer via Bluetooth > Receive Contact or File**.

2. The Receive Contact or File status screen appears. Your device waits two minutes for the contact or file.

3. After successfully connecting to the remote device, the screen reports Connected then disappear. The new contact or file should now be on your device.
4. If two minutes passes before you receive the item, tap **Wait Again**.

5. After you receive the file or contact, the “Receive Contact or File” feature is automatically disabled.

**Enable File Sharing**

1. Tap on the **Bluetooth** icon. In the pop-up menu, tap **Transfer via Bluetooth > Enable File Sharing**.

 ![Enable File Sharing](image)

2. The Enable File Sharing status screen appears. Your device waits two minutes for the remote device to connect.

 ![Enable File Sharing Status Screen](image)

3. After successfully connecting to the remote device, the screen reports that you are connected.

4. If two minutes passes before you connect, tap **Wait Again**.

5. File sharing is enabled until you end it by tapping **Cancel**.

**Connecting to a Bluetooth Modem**

1. Bond with a Bluetooth modem; see Bond With Discovered Device(s) on page 9-3.

2. Select the Bluetooth modem as a Favorite; see Set Up Your Favorite Device on page 9-5.

3. Tap **Start > Settings > Connections tab > Connections** and select **Add a new modem connection**.

4. On the Make New Connection window, in the **Select a modem** drop-down list, select the Bluetooth modem you established as a Favorite.

5. Tap **Next** and continue to set up the modem connection as normal.

*Note: To specify dialing rules when connecting, Tap Start > Settings > Connections tab > Advanced tab > Dialing Rules.*
Wireless WAN (WWAN) Communications with GSM/GPRS

The Dolphin 9500 is the only terminal in the Dolphin 9500 Series that can be configured with an integrated Siemens® GSM/GPRS quad-band radio module for WWAN communications.

Overview

GSM
Short for Global System for Mobile communications, GSM is an open, non-proprietary wireless WAN system that is constantly evolving and growing. One of its great strengths is international roaming capability, which provides standardized dialing in more than 170 countries.

GPRS
Short for General Packet Radio Service, GPRS is a non-voice value added service that allows packet-switched data to be instantly sent and received across mobile telephone networks.

Enabling the GSM/GPRS Radio

The radio driver for GSM is installed and enabled by default after each hard reset. Before using the radio, make sure that the GSM radio is enabled. For details, see Using the Radio Manager on page 7-9.

GSM Radios

Dolphin 7900 terminals can support an MC-45 or MC-75 radio for two-way voice and data communication.

- **MC-45 Radio**
  - Supports 900/1800/1900 MHz frequencies for use in Europe, Middle East, Asia, and Australia.

- **MC-75 Radio**
  - Supports 850/900/1800/1900 MHz frequencies for use in the U.S., Canada, Latin America, Europe, Middle East, Asia, and Australia.

Dual-Band Antenna

Dolphin terminals configured with a GSM radio feature an external antenna that is optimized for power output and receiver sensitivity. This is an omnidirectional antenna with zero dBm gain.

For the MC-75 radio, there are two different antennas based on geographical location; each supports two bandwidths:

- **Europe**
  - Supports 900 MHz and 1800 MHz bands. This antenna is color-coded with a white O-ring on the inside of the antenna.

- **North America**
  - Supports 850 MHz and 1900 MHz bands. This antenna is color-coded with a green O-ring on the inside of the antenna.

Requirements

Using GMS/GPRS on a Dolphin 9500 terminal requires a:

- Network subscription to a GSM/GPRS network (you need to know what service providers are in your geographic area), and
- SIM card that has been activated by the network service provider installed on the terminal (see SIM Card Installation on page 10-2).

Capabilities

Dolphin terminals with integrated GSM/GPRS radios are optimized for the following two-way voice and data communications:

- GSM voice data ("dial-up")
- SMS (Short Message Service) text messages
- GPRS Class 10 - data transmissions average 40-60 Kbps (available speed depends on the wireless network carrier)
**SIM Card Installation**

Short for Subscriber Information Module, a SIM card stores the subscriber's personal information, GSM/GPRS radio settings, security keys, contacts, etc. SIM cards are installed in compatible mobile devices, enabling you to switch devices without losing personal and setup information.

**SIM Card Requirements**

Before installing the SIM card:

- The SIM card **must** be activated by the service provider.
- The terminal **must** be powered down.

*Note:* If no SIM card is installed, you can still make emergency phone calls such as 9-1-1, for example.

**To Install a SIM Card**

On the Dolphin 9500 terminal, access to the SIM card is located under the battery well, which enables easy access to the SIM card while securing it under an installed battery.

1. Turn off your terminal and lay it face-down on a flat surface.

2. Remove the battery pack; see To Remove the Main Battery Pack on page 2-2.

3. Unscrew the faceplate of the SIM card door. You **must** use a Torx T6 wrench. You can purchase this wrench from Hand Held Products, part number 100001700.

4. Insert your SIM card. Make sure the interface on the card is connected to the SIM Card interface in the slot; the beveled corner is in the upper right corner.
5. Place the SIM card door over the secured SIM card and fasten the screws.

6. Install the battery pack and turn on the terminal.

**Audio Modes**

The back panel of the Dolphin 9500 contains both a speaker and a microphone that you can use to send and receive audio signals over the GSM network; see Back Panel Features on page 3-6.

There are three audio modes:

- **Handset**
  Handset mode is when you use the back panel of the terminal just as you would a cell phone, holding the speaker to your ear to receive audio information and the your mouth over the microphone to send audio information. This is the default audio mode.

- **Headset**
  Headset mode is when you plug a headset into the audio jack and speak into the microphone. You must use a 2.5mm plug; no other audio plug will fit.

- **Hands-Free**
  Hands-free mode is when you use the back panel of the Dolphin 9500 as a speakerphone. To switch the back panel to speakerphone, in the Dialler, tap *Settings > Speakerphone*. The audio levels adjust appropriately for speakerphone use.

**Keyboard Combinations for Calls**

Each keyboard option contains a key combination to send and end a call using the Red modifier key.

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>To Send, Press…</th>
<th>To End (reject), Press…</th>
</tr>
</thead>
<tbody>
<tr>
<td>35-key keyboard</td>
<td>Red + SP</td>
<td>Red + DEL</td>
</tr>
<tr>
<td>43-key keyboard</td>
<td>Red + D</td>
<td>Red + H</td>
</tr>
<tr>
<td>56-key keyboard</td>
<td>Red + 3</td>
<td>Red + 6</td>
</tr>
</tbody>
</table>

**Volume Control**

Use the Dolphin keyboard to manually adjust the volume.

To raise the volume, press the Blue modifier key + up arrow

To lower the volume, press the Blue modifier key + down arrow
Using uPhone

The uPhone Application Suite contains three programs that function together to provide a complete voice, data, and text messaging solution for a mobile device fitted with a radio modem:

- **Dialler** emulates a mobile phone and is used to make and receive telephone calls.
- **Call Log** displays a list of the most recent calls.
- **SMS Manager** is a text messaging program.

Accessing uPhone

Tap **Start > Programs > uPhone**. Tap one of the icons to launch the program.

Navigation Bar Icons

When the Dialler or SMS Manager applications are not open, the icons in the Navigation bar at the top of the screen indicates the status of the phone and messaging system. Each icon indicates a specific action and, when tapped, displays a bubble window that lets you know what is happening.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Tap this icon to display:</th>
<th>Bubble Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power Phone Off" /></td>
<td>The phone is off.</td>
<td>Tap <strong>Power Phone On</strong> to turn the phone on and close the bubble. &lt;br&gt;Tap <strong>Hide</strong> to leave the phone off and close the bubble.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Emergency Calls Only" /></td>
<td>The phone can only make emergency calls. This usually means there is no SIM card installed or PIN number established.</td>
<td>Tap <strong>Hide</strong> to dismiss the bubble. This icon will appear in the Navigation bar until a SIM card is installed or a PIN is entered.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Phone is Registering On the Network" /></td>
<td>The phone is registering on the network.</td>
<td>Tap <strong>Hide</strong> to dismiss the bubble. This is a temporary state. This icon appears only until the phone is registered on the network.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Phone is On" /></td>
<td>The phone is on and registered. To the right of the phone is a bar that indicates signal strength.</td>
<td>Tap <strong>Hide</strong> to dismiss the bubble. Tap <strong>Power Phone Off</strong> to turn off the phone. The icon in the Navigation bar changes to indicate the phone is now off.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Medium Signal Strength" /></td>
<td>Medium signal strength.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Icons and Bubble Messages

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Tap this icon to display:</th>
<th>Bubble Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>📲</td>
<td>Good signal strength.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>📲</td>
<td>Full signal strength.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>📩</td>
<td>Incoming SMS message available.</td>
<td><img src="image" alt="Image" /> This bubble appears automatically when a new SMS message is received. It contains the sender's information and the first line of the text message.</td>
<td>Tap <strong>View</strong> to display the full message in SMS Manager. Tap <strong>Reply</strong> to switch to the SMS Manager Compose screen. The &quot;To:&quot; field is auto-filled with the sender's address. Tap <strong>Save</strong> to put the message in the SMS Manager Inbox. Tap <strong>Delete</strong> to delete the message. Tapping each button closes the bubble.</td>
</tr>
<tr>
<td>📞</td>
<td>A new voicemail message is available.</td>
<td><img src="image" alt="Image" /> This bubble appears automatically when a voicemail notification is received.</td>
<td>Tap <strong>Call Answerphone</strong> to dial the Answerphone service and retrieve voicemail messages. Tap <strong>Hide</strong> to close the bubble.</td>
</tr>
<tr>
<td>📲</td>
<td>There is a call in progress to the name or number shown in the bubble.</td>
<td><img src="image" alt="Image" /></td>
<td>Tap <strong>Hide</strong> to close the bubble. Tap <strong>End</strong> to end the call.</td>
</tr>
<tr>
<td>💯</td>
<td>This icon appears when there is a call coming in or going out. A different bubble displays for each circumstance. If the incoming call is a conference call, a different bubble displays.</td>
<td><img src="image" alt="Image" /> This bubble appears automatically when a call comes in and while the ringtone sounds.</td>
<td>Tap <strong>Hide</strong> to close the bubble. Tap <strong>End</strong> to end the call.</td>
</tr>
</tbody>
</table>

If the caller is in the Phonebook, the name displays. If not in the Phonebook, the caller’s number displays; if the number can't be read, “no number” displays. Tap **Answer** to answer the call; this places any current call on hold. Tap **Reject** to reject the call.
Using the Dialler

The Dialler is the program that manages your GSM/GPRS cell phone calls. To launch the Dialler, tap Start > Programs > uPhone > Dialler. The program launches and the uPhone Dialler screen opens:

Making a Call

Entering a Phone Number

You can:

- **Enter the numbers manually** using the phone keypad on the Dialler screen, the SIP, or the Dolphin keyboard.
  - As you enter each number, the digits appear on the Dialler screen in the Name/Number line. If a contact matching the entered number is found in the Phonebook, the name of the contact appears in the Name/Number line as you type; tapping on the name enters the rest of the number automatically.
- **Use the Phonebook** to
  - Select an existing contact. Tap Tools > Phonebook, select a name or number in the list, and tap OK (you can also tap and hold on the entry). The number is automatically entered in the Dialler and appears on the screen.
  - Use speed dial. Tap and hold on the list to see a popup menu of speed dial numbers.
- **Use the Call Log**
  - When the phone is in Idle status, you can tap the Send button on the screen, press the ENTER key, or tap Tools > Call Log to see a list of the last 20 calls made or received. Tap and hold on an entry in the list and select Dial. Pressing the Send button or ENTER key performs this function only when the phone is in an Idle Status.

Sending a Call

You can:
• Tap the **Send** button.
• Press the ENTER key on the keyboard.
• Press the appropriate key combination on the keyboard.

When the call is connected, the three information lines display the following:

![Network Operator: Cingular, Name/Number: Joe Smith, Status: In Call]

**Network Operator**
Displays the name of the service provider you are using.

**Name/Number**
Displays the name and/or number you called. If the number is from your Phonebook, that entry displays.

**Status**
The status of the call.
- **Idle** - means no calls are incoming or outgoing.
- **In Call** - means a phone call is in progress.
- **Incoming Call** - means that a call is coming in.

**0:00**
The numbers in the lower, right corner display the minutes:seconds that have elapsed.

### Receiving a Call

When the Dialler screen is open and an incoming call is detected, text is displayed on the Dialler screen. If the Dialler is not visible at the time of the incoming call, a Navigation Bar notification appears.

When a call is coming in, the ringtone sounds and the three information lines on the Dialler screen display the following:

![Network Operator: Cingular, Name/Number: [Redacted], Status: Incoming Call]

**Network Operator**
Displays the name of the service provider you are using.

**Name/Number**
Displays the name and/or number calling in. If the number is in your Phonebook, that entry displays.

**Status**
Incoming Call.

### Answering a Call

You can:

• Tap the **Send** button.
• Press the ENTER key on the keyboard.
• Press the appropriate key combination on the keyboard.

### Rejecting a Call

You can:

• Tap the **End** button.
• Press the appropriate key combination on the keyboard.

### Call Waiting

If call waiting is enabled, a second incoming call can be received while a first call is in progress. The second incoming call uses a different ringtone but displays the same incoming call notification.

If a second call is coming in, answering it automatically places the first call on hold. You can also reject the second call by tapping the **End** button.
**Ending a Call**

To end or reject a call, you can:

- Tap the **End** button.
- Press the appropriate key combination on the keyboard.

**Call Waiting**

If two calls are in progress, the above options end the active call and place the other on hold. To activate the call on hold, tap **Send** or press ENTER or the key combination to send calls. To end the call on hold, tap **End** or press the key combination to end calls on the keyboard.

**Conference Call**

If a conference call is in progress, tap **End** or the key combination to end calls.

**Call Waiting**

The uPhone Dialler supports call waiting functionality. This means that you can receive a second call while on a first call.

### Placing the Current Call on Hold

When a second call is coming in, to place the current call on hold:

- Tap the **Send** button.
- Press the **ENTER** key on the keyboard.
- Press the key combination for sending calls on the keyboard.

The Status line of the first call changes to **Call on Hold**. Tapping **Send** again restores the call on hold.

**Making a Second Call**

To make a second call, place the current call on hold, then dial the second number. When there are two calls (one active and one held) the status line displays **In Call, Call on Hold**.

**Switching Between Calls**

To switch between the active and held call, tap **Send**, press ENTER, or the appropriate key combination to send calls. The display is updated to show the active call details, and that the other call is on hold.

**Making Conference Calls**

In addition to supporting call waiting functionality, the uPhone Dialler enables you to join two calls into a conference call. When two calls are in progress, tap the phone icon on the Navigation bar. This opens a bubble dialog that enables you to conference both calls into one.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tapping this button…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Active and Accept Held</td>
<td>Swaps between the currently held and active calls. Tapping <strong>Send</strong> or pressing ENTER performs the same function without opening this bubble dialog.</td>
</tr>
<tr>
<td>End Active and Accept Held</td>
<td>Drops the current active call and connects the held call.</td>
</tr>
<tr>
<td>Join Held in Conference Call</td>
<td>Connects the held call and the currently active call in a three-way conference call. More than three parties can join a conference call via networking; each of the other parties can add another call to the conference, and so on.</td>
</tr>
</tbody>
</table>
Touchtones

To transmit touchtones for interactive voice systems while in a call, you can
• Tap the 0-9, *, and # buttons on the uPhone Dialler screen.
• Press 0-9 keys on the Dolphin keyboard; use the uPhone Dialler screen buttons for * and #.

Dialler Menus

There are three menus in the Dialler application:
1. Tools—Accesses application tools.
2. Settings—Opens application settings.
3. Help—Opens the About screen.

Tools Menu

The Tools menu provides the following options:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tapping this button…</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Held</td>
<td>Drops the held call, and continues with the currently active call.</td>
</tr>
<tr>
<td>Hide</td>
<td>Closes the bubble.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phonebook</td>
<td>Displays the Phonebook</td>
<td>10-11</td>
</tr>
<tr>
<td>Call Log</td>
<td>Opens the Call Log</td>
<td>10-12</td>
</tr>
<tr>
<td>SMS Manager</td>
<td>Opens the SMS Manager Inbox</td>
<td>10-19</td>
</tr>
<tr>
<td>Select Skin</td>
<td>Selects a new skin for the uPhone Dialler application.</td>
<td>N/A</td>
</tr>
<tr>
<td>Configuration</td>
<td>Opens the uPhone Configuration control panel.</td>
<td>10-14</td>
</tr>
<tr>
<td>Ringtones</td>
<td>Opens the ring tone selection control panel.</td>
<td>10-10</td>
</tr>
<tr>
<td>Charging</td>
<td>Displays call meter values.</td>
<td>10-11</td>
</tr>
<tr>
<td>USSD</td>
<td>Sends text messages via USSD as opposed to SMS.</td>
<td>10-12</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the uPhone Dialler.</td>
<td></td>
</tr>
</tbody>
</table>
**Ringtone Configuration**

Different ringtones, with individual volume settings, can be set for the following:

- **Ring Tone**: Sounds on an incoming call.
- **Message Tone**: Sounds on an incoming SMS or Voicemail notification.
- **Call Waiting Tone**: Sounds to indicate an incoming call while you are already on a voice call.

You can access Ringtones two ways:

1. Tap **Start > Settings > Personal** tab > **Ringtones** icon OR
2. Open the Dialler (tap **Start > Programs > uPhone > Dialler**) and tap **Tools > Ringtones**. The Ringtones screen opens displaying the current settings.

Select the desired ringtone for each type of tone in the drop-down lists. Tapping **OK** saves any changes. Opening another screen without tapping **OK** discards any changes.

**WAV Files**

You can customize your ringtones with *.wav files installed on your terminal. To appear here, *.wav files must be stored in the **Programs Files > uPhone > Ring Tones** folder.

**Previewing Tones**

You can preview each tone by selecting the *.wav file in the drop-down list and tapping the **Preview** button. Use the slider to set the volume for each tone.

While the tone is playing, the Preview button changes to a **Stop** button; tap it to stop the preview.
Phonebook

The Phonebook contains the contacts from the SIM card and Pocket Contacts. If fixed dialing is set in the SIM, then only those numbers in the fixed dialing list are shown in the Phonebook, and only these numbers can be called from the Dialler.

You can access the Phonebook manually by opening the Dialler and going to Tools > Phonebook. When you tap and hold on an entry, a popup menu displays.

Dial
Opens the Dialler with the number entered ready for dialing.

Send SMS
Opens the SMS Manager in the Compose screen with the 'To:' field populated with the number.

Speed Dial 2-9
These eight slots are used to assign the Dialler Speed Dial keys. To assign a number to a Speed Dial slot, tap on an entry to assign the number. Tapping and holding the associated button when in Dialler will automatically dial the assigned contact.

Charging

Accessed from the Tools menu, the Charging tool displays call meter values from the network service provider. Tap Tools > Charging and the Charging window opens displaying the current values for the phone.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call meters</td>
<td></td>
</tr>
<tr>
<td>Current call</td>
<td>Displays the number of charge units used on the current call.</td>
</tr>
<tr>
<td>Accumulated calls</td>
<td>Displays the number of charge units used to date.</td>
</tr>
<tr>
<td>Maximum available</td>
<td>Displays the maximum number of units available from the subscriber.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the Current call and Accumulated calls fields with the number of charge units used, read from the SIM card.</td>
</tr>
<tr>
<td>Reset accumulated calls</td>
<td>Display a window for the subscriber to enter a PIN number--“PIN2”–from the subscriber. When the correct PIN is entered, the accumulated call units are reset to 0 on the SIM card.</td>
</tr>
</tbody>
</table>
USSD

Short for Unstructured Supplementary Service Data, (USSD) is a technology unique to GSM that enables session-based text-messaging as opposed to SMS, which is store-and-send text-messaging. Turnaround response times for interactive applications are generally shorter for USSD than SMS. USSD is not currently available on all carrier networks.

USSD communicates with a USSD application portal, a news portal or a chat session with a co-worker.

Tap Tools > USSD.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set maximum available</td>
<td>Display a window for the subscriber to enter a PIN number—“PIN2”—from the subscriber. When the correct PIN is entered, the maximum available charge units for the user is set on the SIM card.</td>
</tr>
</tbody>
</table>

**Call Log**

The Call Log maintains a list of the last 20 calls made or received in each of the following categories:

- Voice Calls In (Default)
- Voice Calls Out
- Voice Calls Missed
- GPRS Data

You can access the Call Log two ways:

1. Tap Start > Programs > uPhone > Call Log OR
2. Open the Dialler and tap Tools > Call Log.

The Call Log opens displaying the last few Voice Calls In; the most recent call always appears at the top.
Name The phone number or the name if the call was from or to a matching entry in the Phonebook.

Time Time and date the call started. This is the local time and date.

Duration Duration of the call (hours:minutes:seconds). The clock starts when the call connects, not when dialed.

From the drop-down list, select the option you want to view.

To see everything, select All Calls.

Tools Menu

Clear Deletes the entire Call Log.

Exit Closes the Call Log.
**uPhone Configuration**

uPhone Settings enable you to establish the normal operating parameters for uPhone applications.

**Requirements**

To open the uPhone configuration tools, the GSM radio **must** be enabled and an active SIM must be installed. The configuration tools access the network directly. If you are not connected, settings cannot be configured and you will receive an error notification when you attempt to open the configuration tools.

**Accessing uPhone Configuration**

You can access uPhone Settings two ways:

1. Tap **Start > Settings > System tab > uPhone icon**.
2. In the Dialler application, selecting **Tools > Configuration**.

An animated wait icon displays the following message while the system accesses the network. If there is no response from the network within 60 seconds, this message times-out and the control panel closes. If the network responds, the uPhone Settings screen displays; the General tab appears first by default.

**Tab Windows**

uPhone Configuration consists of five tabs:

- General
- Network
- Divert
- Bar
- Messaging

Tapping **OK** accepts any changes and exits the uPhone Configuration.
### General Tab

![uPhone Settings](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phone Number</strong></td>
<td>This is the phone number stored on the SIM. It is displayed here for information only.</td>
</tr>
<tr>
<td><strong>Answerphone</strong></td>
<td>This is the number to dial to retrieve voicemail messages. To enter a new number, tap on this field and enter the digits.</td>
</tr>
<tr>
<td><strong>Call waiting</strong></td>
<td>Select <strong>On</strong> or <strong>Off</strong> to enable or disable call waiting functionality. Call waiting must be set to <strong>On</strong> for conference calls.</td>
</tr>
<tr>
<td><strong>PIN protection</strong></td>
<td>Select <strong>On</strong> or <strong>Off</strong> to enable or disable PIN protection. If enabled, a PIN number is requested when the phone is switched on.</td>
</tr>
<tr>
<td><strong>Change PIN</strong></td>
<td>This button is active only if PIN protection is set to <strong>On</strong>. Otherwise, the button is grayed-out. If you tap <strong>Change PIN</strong>, a dialog box appears enabling you to change the PIN.</td>
</tr>
</tbody>
</table>

Enter the PIN. Tap **OK** to save the change. While typing, the numbers appear as asterisks to hide the number from observation by third parties.

### Network Tab
The Network tab provides the ability to choose between **Automatic** and **Manual** network selection.

If you choose **Manual** network selection, the drop-down list of available networks activates. Choose a network from this list and tap **OK**. A wait icon appears while the system accesses the selected network.

**Divert Tab**

The divert tab enables you to select divert options for incoming calls when you are unavailable to answer; e.g., when the phone is off, you are out of network coverage, busy, or not able to answer.

**All Calls** diverts all incoming calls automatically.

**Unavailable** diverts incoming calls when you are unavailable.

The options in both lists are as follows:

- **Not Diverted** Select this option to not divert calls. This is the default setting for both All Calls and Unavailable lists.
- **Answerphone** Select this option to divert calls to voicemail.
- **To number** Select this option to forward incoming calls to another number.
Bar Tab

The Bar tab sets enables you to bar both incoming and outgoing calls.

Bar outgoing calls
Select one of the following options from the drop-down list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not barred</td>
<td>No restrictions on outgoing calls.</td>
</tr>
<tr>
<td>International calls</td>
<td>Bar international calls.</td>
</tr>
<tr>
<td>International except…</td>
<td>Only international calls to the home country designated on the SIM card can be made.</td>
</tr>
<tr>
<td>All outgoing calls</td>
<td>Bar all outgoing calls.</td>
</tr>
</tbody>
</table>

Bar incoming calls
Select one of the following options from the drop-down list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not barred</td>
<td>No restrictions on incoming calls.</td>
</tr>
<tr>
<td>Incoming calls when…</td>
<td>Bar incoming calls when the network coverage is in roaming status.</td>
</tr>
<tr>
<td>All incoming calls</td>
<td>Bar all incoming calls.</td>
</tr>
</tbody>
</table>

Change barring code
Tap this button to change the barring code.

In the Old code field, enter the current code, and enter the new code in the New code and the Confirm code fields. While typing, the numbers appear as asterisks to hide the number from observation by third parties.

To save the barring options, tap OK. The system displays a dialog requesting the barring password before sending the updated settings to the network. Type in the password and tap OK.
**Messaging Tab**

The Messaging tab enables you to adjust the default SMS settings.

![Messaging tab screenshot](image)

**Request Delivery Reports**

By default, the SMS manager receives a confirmation report that each SMS message has been sent. These confirmation reports can take up valuable space and memory. Therefore, you can cancel these reports on this tab by selecting Off and tapping **OK**.

**SMS number of retries**

This setting enables you to control the number of times the system will try to send an SMS message until the message is sent. Nine is the default number. To change the default, enter the number in the field and tap **OK**.
SMS Manager

Abbreviated for Short Message Service, SMS enables the transmission of short messages (140-160 characters) to and from a cell phone. SMS messages travel over the system’s control channel, which is separate from the voice channel. SMS Manager supports creation, sending, receiving, and storing of SMS text messages. Text messages sent or received can be up to 160 characters long.

Opening the SMS Manager

You can access the SMS Manager two ways:

1. Tap Start > Programs > uPhone > SMS Manager, OR

2. Open the Dialler (Start > Programs > uPhone > Dialler) and tap Tools > SMS Manager. The SMS Manager opens to the Inbox, which displays a list of your most recent text messages.

There are three folders: Inbox, Sent, and Outbox. Tap the Inbox folder to see all three folders. The name of the folder appears in the gray bar just under the title bar.

Note: Click the SMS box to expand and collapse the folders.

Inbox

The Inbox folder displays received text messages. Received messages have an envelope icon to the left. The Inbox folder also receives error messages from text messages that could not transmit successfully.

When the Inbox folder is selected, received messages appear in the list.

To Do this...
Open a message Tap on the message and the content of the message appears.
Delete a message Tap and hold on the message. Tap Delete on the popup menu that appears.
Sent Folder

The Sent folder displays sent messages.

Outbox Folder

The Outbox folder displays text messages waiting to be sent.

Sending an SMS Message

1. In the task tray at the bottom of the screen, tap New. The new message screen opens with the cursor active in the text area.
2. Tap inside the To: field. To add the number, you can type it in or tap To: to select an entry from your Phonebook.
   - You must type a number that is in the appropriate international ISDN format for the country you are dialing. However, you can dial a local number without the country code.
   - Destination numbers can start with a “+” sign.
3. Tap inside the text area. To write a message, you can use the SIP or the terminal keyboard.
   - The Remaining characters field displays how many characters you can type in a message. Because 160 is the maximum number of characters per message, the number portion of the field counts backwards from 160 as you type.
4. When finished typing, tap the Send icon to transmit the message. If you tap OK before tapping Send, the program requests confirmation before discarding the message.
5. The Sending message box appears over the message.
6. When the message has been sent, the Message sent box appears.
Icons at the Top of the Message Screen

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>At the top of the window:</td>
</tr>
<tr>
<td>![Copy icon]</td>
<td>Copy selected text.</td>
</tr>
<tr>
<td>![Cut icon]</td>
<td>Cut selected text.</td>
</tr>
<tr>
<td>![Paste icon]</td>
<td>Paste text.</td>
</tr>
<tr>
<td>![Undo icon]</td>
<td>Undo the previous action.</td>
</tr>
<tr>
<td>![Send icon]</td>
<td>This icon appears only in a message that has been sent. Tapping this button will re-send the message.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Send icon]</td>
<td>In the task tray at the bottom of the window: Send all messages in the Outbox.</td>
</tr>
</tbody>
</table>

Edit Menu

The Edit menu provides the same options as the icons at the top of the screen, with the following additional options:

- **Select All**: Selects all text in the active message section.
- **Clear Selection**: De-selects all text in the active message section.
**GPRS Settings**

uPhone includes pre-configured GPRS connection profiles to connect to a GPRS network. When the GSM driver is enabled, uPhone selects the appropriate pre-configured profile based on the service provider information on the installed SIM card. Before connecting to GPRS, you need to confirm and save the selected uPhone GPRS profile (or create one) in uPhone GPRS Settings, then enter the ISP information in Microsoft’s connection manager.

The default profiles are for a modem connection. However, you can also configure GPRS for VPN or Proxy Server connections by creating a GPRS connection profile for that connection type in Microsoft’s connection manager.

**Requirements**

- **No ActiveSync** Make sure that you are **not** connected to a host PC via ActiveSync when configuring the connection settings!

- **Service Provider Information**
  You need the **APN Number**, and **User name** and **Password** from your network service provider.

**Configuring the GPRS Connection**

The GSM driver installs pre-configured GPRS connection profiles. When enabled, the GSM driver reads the installed SIM card and selects the matching pre-configured connection profile.

1. Tap **Start > System > Connections** tab > **uPhone GPRS**. The GPRS Settings screen appears with the selected profile in the Current Profile drop-down list.

2. In the **Current Profile** drop-down list, select the profile associated with your account.

The Details section is already complete. A default GPRS profile (for a modem connection) is created in Microsoft’s connection manager based on the profile selected here.

   If your profile does not appear in the Current Profile list, select **Add new** and complete the Details section.

3. In the **Details** section
   - Type in the **APN number**
   - Type in the **IP address** (Leave blank to use DHCP.)
   - Select the **Protocol**

4. Tap **OK**. You return to the Connections tab.
5. Because GPRS is ISP technology, you need to complete the connection profile in Microsoft's connection manager with information from your ISP. On the Connections tab, tap Connections. The connections manager opens.

6. Tap Manage existing connections.

This default GPRS profile loads into the connection manager based on the service provider profile selected in uPhone's GPRS Settings; see Step 2 above.

Note: A modem connection is the default connection type. If you want to create a VPN connection, for example, you need to create a GPRS profile on the VPN tab using the parameters in the following steps.

7. Make sure that GPRS is selected and tap Edit.

8. You can enter a custom name for the connection but leave PhoneTSP Line (GPRS) as the selected modem.
9. Tap Next.

10. Enter the number provided by your ISP or leave the default “GPRS” if no number has been provided. If you leave “GPRS,” the GSM radio uses the APN Number entered in the uPhone profile (see Step 2 above). Tap Next.

11. Enter the User name and Password provided by your ISP. Tap Finish. Entering your user name and password here in the connection manager profile means that you don’t have to enter them every time you try to connect via GPRS.

12. Tap and hold on the GPRS connection and select Connect on the popup menu.

13. Your terminal attempts to connect to the GPRS network. When the connection is established, the double arrows appear in the Navigation bar.

14. To verify your connection, tap Start > Programs > Internet Explorer. Your homepage should appear.
Overview

Dolphin 9550/9551 terminals contain the same robust features of the Dolphin 9500 Series, such as Windows Mobile 5.0 and rugged ergonomics. In addition, the Dolphin 9550/9551 terminal offer laser engine support, which enables you to scan and decode linear bar codes from greater distances.

The expanded scanning and decoding capabilities combined with the terminal’s durability make Dolphin 9501/9551 terminals ideal for in-premise mobile application environments.

Laser Engine Specifications

Dolphin 9550/9551 terminals may be equipped with one of the following SE1200 non decoded laser engines:

<table>
<thead>
<tr>
<th>Name</th>
<th>Bar Code Type</th>
<th>Decodes from …</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE1200HP (High Performance)</td>
<td>5 mil</td>
<td>2.75 to 7 in (0.07 to 0.17 m)</td>
</tr>
<tr>
<td></td>
<td>55 mil reflective</td>
<td>5 to 50 in (.13 to 1.27 m)</td>
</tr>
<tr>
<td>SE1200LR (Long Range)</td>
<td>10 mil</td>
<td>10 to 24 in (0.25 to .6 m)</td>
</tr>
<tr>
<td></td>
<td>100 mil reflective</td>
<td>66 to 232 in (1.67 to 5.9 m)</td>
</tr>
<tr>
<td>SE1200ALR (Advanced Long Range)</td>
<td>13 mil</td>
<td>18 to 39 in (0.45 to 1 m)</td>
</tr>
<tr>
<td></td>
<td>100 mil reflective</td>
<td>102 to 363 in (2.6 to 9.2 m)</td>
</tr>
</tbody>
</table>

Note: Dolphin 9501/9551 terminals do not support image capture.

Supported Bar Code Symbologies

Laser engines support only the decoding of linear bar codes; see 1D Symbologies on page 4-3.

Aiming Options

Laser engines do not support omni-directional scanning.

To achieve an optimal scan, center the red aiming beam across the bar code horizontally as shown below.

Laser Engine Location

The laser engine points straight out of the contoured casing on the back panel of Dolphin 9501/9551 terminals.
**Front and Bottom Panel Features**

Dolphin 9501/9551 terminals contain the same front and bottom panel features as the other terminals in the Dolphin 9500 Series.

- See Front Panel Features on page 3-4.
- See Bottom Panel Features on page 3-11.

**Dolphin 9501 Side Panel**

The Dolphin 9501 contains a powerful laser engine inside a solid, flashlight form factor with a built-in finger saddle for maximum comfort.

![Dolphin 9501 Side Panel Diagram]

**Dolphin 9501 Back Panel**

![Dolphin 9501 Back Panel Diagram]
Dolphin 9501 Hand Strap and Stylus

The hand strap is attached to the finger saddle and contains two stylus loops on either side.
**Dolphin 9551 Side Panel**

The Dolphin 9551 terminal features the same integrated pistol grip as the Dolphin 9550 for secure and versatile handling in scan-intensive applications. The front end of the bottom housing accommodates the laser engine.

![Laser Engine Diagram](image)

The stylus is stored in the pistol-grip handle.

**Dolphin 9551 Back Panel**

![Back Panel Diagram](image)
Radio Options

Dolphin 9501/9551 terminals can be configured with one or a combination of 802.11b and Bluetooth radios. For more information about radio operations, see Using the Radio Manager on page 7-9.

Keyboard Options

Dolphin 9501/9551 terminals can be configured with any of the Dolphin keyboards. For more information, see Using Dolphin Keyboards on page 5-1.

Peripherals and Accessories

Because Dolphin 9501/9551 terminals have the same Mechanical Connector (see page 3-11), they are compatible with all Dolphin 9500 Series Peripherals (see page 3-2) and Dolphin 9500 Series Accessories (see page 3-3). However, due to their different shape, both the Dolphin 9501/9551 terminals have their own enclosures.

Note: The Dolphin 9551 requires the Dolphin 9550 Mobile Base to accommodate the pistol-grip handle.
Overview

As the hub of your Dolphin system, the Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communications, which make it able to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its main battery pack charges in less than four hours.

Power

The HomeBase completes a full charge of the main battery pack in less than four hours. The HomeBase also provides power to the intelligent battery charging system in all Dolphin terminals that senses when a full charge has been achieved and switches to a trickle charge to maintain the full charge.

Communications

Reliable data communications at speeds of up to 115k baud can be transmitted by the HomeBase through the RS-232 serial port. Using the full-speed USB port, the data transmission rate goes up to 12 Mbps. HomeBases cannot be physically connected to each other - sometimes referred to as “daisy-chained” - but can be networked together via a serial or USB hub.

Convenient Storage

Intelligent battery charging makes the Dolphin HomeBase a safe and convenient storage receptacle for your Dolphin terminal.

Capacity

The Dolphin HomeBase holds one terminal and features an auxiliary battery well behind the terminal well that can charge a battery pack independently of the terminal well. This means that one HomeBase can charge two battery packs: the one installed in the terminal and a spare.

⚠️ Use only Dolphin 9500 Series peripherals, power cables, and power adapters. Use of peripherals, cables, or power adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

⚠️ Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in the Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.
**Dolphin HomeBase Parts and Functions**

**Front Panel**

![Diagram of Dolphin HomeBase with labels for Terminal Well, Auxiliary Battery Well, DOCK LED, AUX Battery LED, and COMM LED.

**Terminal Well**

Place the Dolphin terminal in this well to communicate with a host device, power the terminal, and charge its battery pack. If the host device is a desktop computer that uses ActiveSync, synchronization begins immediately. While seated in the terminal well, the main battery installed in the terminal charges. The HomeBase completely charges a battery pack in less than four hours.

**Auxiliary Battery Well**

See Auxiliary Battery Well on page 12-3.

**DOCK LED**

Turns solid green when the Dolphin terminal is properly seated in the Dolphin HomeBase. When this light is on, the terminal is connected to the base.

**AUX Battery LED**

Indicates status of the battery charging in the auxiliary battery well.

<table>
<thead>
<tr>
<th>This color</th>
<th>means…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange</td>
<td>The auxiliary battery is charging.</td>
</tr>
<tr>
<td>Green</td>
<td>The auxiliary battery has completed charging and is ready for use.</td>
</tr>
</tbody>
</table>

To see the auxiliary battery well, see Back Panel on page 12-3. For information about charging a battery in the auxiliary battery well, see page 12-5.

**COMM LED**

This is the communication LED. It indicates the status of data transfer between the Dolphin terminal and the host device. The color of this LED differs if the HomeBase is using the serial or USB port connection.
If using the serial port

<table>
<thead>
<tr>
<th>This color</th>
<th>means…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Serial data is being sent from the Host Device to the Dolphin HomeBase.</td>
</tr>
<tr>
<td>Green</td>
<td>Serial data is being sent from the Dolphin HomeBase to the Host Device.</td>
</tr>
<tr>
<td>Orange</td>
<td>Serial data is being sent at high data rates.</td>
</tr>
</tbody>
</table>

If using the USB port

<table>
<thead>
<tr>
<th>This color</th>
<th>means…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green LED</td>
<td>A USB Connection is established with the host computer.</td>
</tr>
</tbody>
</table>

**Back Panel**

**Auxiliary Battery Well**

The HomeBase enables you to charge an additional Li-ion battery pack independently of the terminal well. This feature ensures that you can always have a fully-charged battery for your Dolphin terminal. See Charging a Spare Battery in the Auxiliary Battery Well on page 12-5.

**USB Port**

This USB Port is full-speed and 2.0 compliant. Using a USB cable, you can connect the HomeBase to a peripheral device, such as a desktop computer or printer. When the Dolphin terminal is seated in the terminal well, it is connected to the peripheral device via the HomeBase. The USB port on the HomeBase requires that you use ActiveSync 4.1 or higher.

**RS-232 Port**

Use a 9-pin, RS-232 cable from Hand Held Products to connect this port to a peripheral device for RS-232 data communication. For more information, see HomeBase Serial Connector on page 12-4.

**DC Power Jack**

Use a power cable from Hand Held Products to supply power to this power jack. For more information, see Powering the HomeBase on page 12-4.
**Powering the HomeBase**

The terminal requires 9.5 Volts DC input for communications and battery charging; the Hand Held Products’ power cable contains a power adapter that converts the power source voltage accordingly. **Only** the power adapter cable from Hand Held Products converts the voltage appropriately.

Hand Held Products recommends that you leave the Dolphin HomeBase connected to its power source at all times, so that it is always ready to use.

1. Connect the Hand Held Products’ power cable to the DC jack on the rear panel of the HomeBase.
2. Connect the Hand Held Products’ power cable to the power adapter.
3. Plug the power adapter cable into the power source. The HomeBase is now powered.

**HomeBase Serial Connector**

The following diagram displays the pin diagram of the serial connector of the HomeBase.

![HomeBase Serial Connector Diagram](image)

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Internal Jumper to Pin 6</td>
</tr>
<tr>
<td>2</td>
<td>TXD</td>
</tr>
<tr>
<td>3</td>
<td>RXD</td>
</tr>
<tr>
<td>4</td>
<td>DSR</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>DTR</td>
</tr>
<tr>
<td>7</td>
<td>CTS</td>
</tr>
<tr>
<td>8</td>
<td>RTS</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
</tr>
</tbody>
</table>

*Note: Signals referenced are for a DTE device. The HomeBase is at a right-angle to the printed circuit board (PCB). The ninth pin has a ring indicator (RI).*
Charging the Main Battery

The Dolphin HomeBase powers the terminal and fully charges its main battery pack in less than four hours. The HomeBase contains an intelligent battery charging system that protects the battery from being damaged by overcharging. The unit senses when a battery pack is fully charged and automatically switches to a trickle charge that maintains the battery at full capacity. Therefore, Dolphin terminals may be stored in the HomeBase without damage to the terminals, battery packs, or peripherals.

To check battery power, use the Power system setting; see Power on page 6-12.

For more information about Hand Held Products Li-ion batteries, see Batteries on page 3-14.

To Power a Terminal and Charge its Main Battery

1. Install the battery pack in the terminal; see Install the Main Battery Pack on page 2-2.
2. Connect the HomeBase to the power supply provided by Hand Held Products.
3. Slide the terminal into the terminal well until the Dock LED lights green to indicate that the terminal is properly seated.
4. The battery pack begins charging.

Charging a Spare Battery in the Auxiliary Battery Well

The auxiliary battery well located on the back of the HomeBase charges a spare battery independently of the terminal well. The Aux Battery LED on the front panel indicates the status of the battery in this well.

Charge time is less than four hours; see Auxiliary Battery Well on page 12-3.

1. Insert the end of the battery without the locking tab into the bottom of the auxiliary well opening.
2. Snap the battery into place with a hinging motion. The Aux Battery LED lights orange.
3. Use the AUX Battery LED to monitor charging progress.
Communications

USB

The HomeBase also supports USB communications via the USB port located on the back. The HomeBase acts as a USB device by interfacing the USB signals of the Dolphin terminal to the USB of the host workstation. Using a standard USB cable, the HomeBase’s USB interface allows the Dolphin terminal to communicate with a personal computer or to be networked through a USB hub.

Dolphin terminals support USB communications out of the box.

RS-232

The HomeBase supports RS-232 communications via the RS-232 Communications Port located on the back of the device. This port enables the Dolphin terminal to communicate to a workstation, modem, or any RS-232 device using a standard serial cable and communications software.

Note: The HomeBase should have only one type of interface cable connected at a time, either USB or RS-232.

Requirements

To use the HomeBase for communications, you need the following equipment:
- A HomeBase powered by a power cable and power adapter cable from Hand Held Products
- For RS-232 communications, a serial cable
- For USB communications, a USB cable
- ActiveSync v4.1 or above on the host workstation

Note: The HomeBase does not support Windows NT® when using a USB connection because Windows NT does not support USB. Windows® 98 second edition provides full USB support.

To Install the HomeBase for Communication

Note: You must be using ActiveSync 4.1 or higher.

1. Plug in the power supply and connect it to the back of the HomeBase.
2. Plug the USB or the RS-232 communication cable into the back of the HomeBase.
3. Connect the communication cable into the back of the workstation.
4. At this point, the hardware is installed and operating.
   You may need to reboot your workstation to complete the installation process.

Establishing Communication with the HomeBase

USB or RS-232 communication with the terminal is usually auto-detected and configured by ActiveSync based on the communication cable. If you are using a USB cable to connect to the workstation, ActiveSync will usually set up a USB connection. If you are using an RS-232 cable, ActiveSync will usually set up an RS-232 connection.

For more details, see Establishing ActiveSync Communication on page 7-2.

Communicating with the Dolphin Terminal

To initiate communications between the Dolphin terminal and peripheral, complete these steps:

1. Insert the Dolphin terminal into the terminal well of the HomeBase.
   - The DOCK LED illuminates green. If the DOCK LED does not illuminate, make sure that the terminal is properly seated. You may need to remove and re-insert the terminal.
   - The Dolphin terminal activates; if the power is off, the terminal automatically powers on. If the terminal does not power on, verify that the Hand Held Products power supply is properly connected to the cradle and plugged into a functioning outlet.
   - If the HomeBase is connected to the workstation, the Dolphin terminal automatically opens ActiveSync to establish a connection.
The HomeBase can now transfer data between the terminal and the host device. If communication does not occur, check the port connections to ensure that the cradle is correctly configured.

**Verifying Communication**

You can verify that the USB driver is functioning by watching the COMM LED on the USB HomeBase. When the COMM LED illuminates solid green, the HomeBase is communicating with the host device.

**Verifying Data Transfer**

The COMM LED flashes when data is being transferred via the HomeBase. For an RS-232 connection, the COMM LED flashes red and green. For a USB connection, the COMM LED flashes green.

**RS-232 Communications Cables**

**Connecting the Cables**

Connect the HomeBase to the host computer or other device by plugging an RS-232 serial cable into the RS-232 Communications Port on the rear of the HomeBase. The wiring of your cable depends on whether the other device is set up as a Data Communications Equipment (DCE) or Data Terminal Equipment (DTE) device.

The HomeBase Communication Port is configured as a DCE device. To communicate with a DCE device, use either a null modem adapter in line with a standard RS-232 cable, or a null-modem serial cable. To communicate with a DTE device such as a computer, use a standard (or straight-through) RS-232 cable.

You can make your own cables by following the pin configuration in the chart below. To do so, you must determine if your host RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

**RS-232 Pin Configuration**

<table>
<thead>
<tr>
<th>HomeBase /Host Port (DCE)</th>
<th>IBM AT DB9 (DTE)</th>
<th>IBM XT DB25 (DTE)</th>
<th>Modem DB25 (DCE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin / Input Signal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 / (RD)</td>
<td>2</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>3 / (TD)</td>
<td>3</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>5 / (SG)</td>
<td>5</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>4 / (DTR)</td>
<td>4</td>
<td>20</td>
<td>6</td>
</tr>
<tr>
<td>6 / (DSR)</td>
<td>6</td>
<td>6</td>
<td>20</td>
</tr>
<tr>
<td>7 / (RTS)</td>
<td>7</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>8 / (CTS)</td>
<td>8</td>
<td>5</td>
<td>4</td>
</tr>
</tbody>
</table>

*Note: The Dolphin 9500 Series HomeBase cannot be daisy-chained.*
Mounting the HomeBase

Set the Dolphin HomeBase on a dry, stable surface, such as a desktop or workbench near an electrical outlet. Be sure to provide enough workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the HomeBase.

When choosing a location, bear in mind that:

- the mounting location must allow users easy access to the Auxiliary Battery Well, and
- the serial and USB ports as well as the power jack face straight out of the rear panel, and you will most likely want easy access to them in the future.

Desk Mounting

Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment of the unit if desired.

To mount the HomeBase, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts and bolts, secure the DIN rail to the desk or flat surface.
**Wall Mounting**

You can purchase a wall mount kit that contains
- a mounting bracket,
- three screws, and
- six washer/nut sets.

1. Insert a screw into the round end of each screw slot on the bottom panel. Slide each screw towards the narrow end of the slot. Then, use a washer/nut set on each screw to secure the screw in the slot.

2. Attach the bottom panel to the mounting bracket; match the holes to the secured screws.

3. Use the remaining washer/nut sets to secure the mounting brackets to the bottom panel.

4. Turn the secured HomeBase right side up.

5. Secure the back wedge of the mounting brackets to a stable vertical surface.

The back wedge of the mounting bracket contains an open slot for the power and communications cables. There is an extra space between this slot and the rear panel of the HomeBase to allow easy access to the power and communications ports. For more details on both ports, see Back Panel on page 12-3.
**Overview**

The Dolphin Mobile Base charging and communication cradle is designed specifically for in-premise and in-transit data collection applications. It features a flexible mounting bracket, a cigarette lighter adapter, and a power cable to adapt it to your environment.

When a terminal is seated in the Mobile Base, its main battery pack charges in less than four hours. The serial connector supports RS-232 communication and power out to peripheral devices, such as hand held scanners.

As the hub of your Dolphin mobile data collection system, the Mobile Base performs three important functions: charging, communications, and storage.

**Charging**

The Dolphin Mobile Base completes a full charge of the main battery pack in less than four hours. The Mobile Base also provides power to the intelligent battery charging system in all Dolphin terminals that senses when a full charge has been achieved and switches to a trickle charge to maintain the full charge.

**Communications**

The Mobile Base transmits data to other devices at speeds of up to 115K baud via its RS-232 serial port.

**Convenient Storage**

Intelligent battery charging makes the Mobile Base a safe and convenient storage receptacle for your Dolphin terminal.

**Capacity**

The Mobile Base holds one terminal.

---

⚠️ Use only Dolphin 9500 Series peripherals, power cables, and power adapters. Use of peripherals, cables, or power adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

⚠️ Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.
Mobile Base Parts and Functions

Front Panel

The front panel of the Mobile Base has one slot. The following graphic features the Mobile Base with the Dolphin 9500 inserted into the terminal well.

<table>
<thead>
<tr>
<th>Terminal Well</th>
<th>Place the terminal in this well to communicate with a host device and charge the main battery pack.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting Brackets</td>
<td>Use these to mount the Mobile Base to a fixed location.</td>
</tr>
<tr>
<td>DOCK LED</td>
<td>Illuminates solid green when the Dolphin terminal is properly seated in the terminal well.</td>
</tr>
<tr>
<td>COMM LED</td>
<td>Indicates the status of data transfer between the host device and the Dolphin terminal.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>COMM LED color</th>
<th>Indicates that…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Data is being sent from the Host Device to the Dolphin Mobile Base.</td>
</tr>
<tr>
<td>Green</td>
<td>Data is being sent from the Dolphin Mobile Base to the Host Device.</td>
</tr>
<tr>
<td>Orange</td>
<td>Data is being sent at high data rates.</td>
</tr>
</tbody>
</table>
**Bottom Panel**

The power supply and RS-232 connectors are located on the bottom of the unit.

---

**Power Supply Connector**

Use this connector to attach a Hand Held Products power cable to the Dolphin Mobile Base. The Mobile Base can be powered by an external DC power source of between 11 VDC to 48 VDC.

To run on vehicle power, you can use the 12 VDC cable or 24 VDC cable option. The appropriate cable comes with the kit you ordered. The 12 VDC cable can be used with a cigarette lighter outlet. The 24 VDC, pigtail cable can be used to “hard-wire” into the vehicle power bus.

*Verify that the power source is always within the specified range and observe correct input voltage polarity. An improper input voltage range (above the 48 VDC maximum) or reverse polarity could damage the power conversion circuitry.*

---

**RS-232 Communications Port**

Use a standard serial cable to connect the unit to a host device via RS-232; see Mobile Base Serial Connector on page 13-8.


Powering the Dolphin Terminal

When seated in a Mobile Base that is connected to the appropriate power source, the Dolphin terminal receives the power to charge its main battery and run its internal circuitry. Keep the Mobile Base plugged into the power source so that the Dolphin terminal battery pack stays fully charged.

For more information about powering the Mobile Base, see Powering the Dolphin Mobile Base on page 13-6.

Charging the Dolphin Terminal

The Mobile Base supplies charging power to the Dolphin terminal so that the terminal can monitor the charging of its battery pack. This charging method protects the battery from being damaged by overcharging. Therefore, the Dolphin terminal may be stored indefinitely in the Mobile Base without damage to the terminal, the battery pack, or the Mobile Base.

To charge a Dolphin terminal, complete these steps:

1. Insert a battery pack into the Dolphin terminal.
2. Slide the terminal, imager window up and the LCD visible, into the terminal well of the Mobile Base until it stops.
3. When the Dolphin terminal is properly seated, the DOCK LED on the Mobile Base illuminates solid green. The terminal begins charging automatically.
Installing the Dolphin Mobile Base

To install the Dolphin Mobile Base, you need to mount it securely to an appropriate location and supply it with power.

Mounting the Mobile Base

The adjustable mounting bracket holds the terminal securely in place and gives the user a variety of options for mounting the Mobile Base. When selecting a location, keep in mind that the power supply and serial connectors point straight out the bottom panel.

Back Panel and Brackets

1. Loosen the turnscrew.
2. Insert the ball joint of the mounting bracket to the back of the bracket.
3. Insert the ball joint on the back of the Mobile Base into the other side of the bracket.
4. Tighten the turnscrew to secure both ball joints.
5. Secure the mounting bracket to the appropriate location.

Back Panel

Latch

The latch sits on top of the spring arm assembly and holds the back of the terminal securely in place. The graphic above displays the mounting of a Dolphin 9500 terminal. There is another Dolphin Mobile Base that contains a special latch to accommodate the pistol-grip handle on the Dolphin 9550.

Locking Tabs

When positioned as shown in the above graphic, the locking tabs secure the spring arm assembly, latch, and terminal in place. When seating a terminal, turn both arms up to allow the spring arm to move as necessary while the terminal is being inserted. After the terminal is seated, turn both arms toward the center to lock them.

Both locking tabs must be pointing up to insert or remove a terminal in the Mobile Base.
Spring Arm Assembly
The spring arm assembly is the column that connects the latch to the back of the Mobile Base.

Ball Joints
There are two ball joints: one on the back of the Mobile Base and one on the mounting bracket. Both ball joints are inserted into the bracket and secured to mount the Mobile Base.

Connectors
The power and RS-232 connectors are located on the bottom panel. For more information, see Bottom Panel on page 13-3.

Brackets

Bracket
The bracket contains the turnscrew and two slots. Ball joints are inserted into each slot and secured with the turnscrew.

Turnscrew
The turnscrew is located on the top of the bracket. Rotate the turnscrew to secure or loosen the ball joint slots.

Mounting Bracket
The mounting bracket is what you attach to the mounting surface. It is comprised of a ball joint and flat disk. The disk contains drill holes you use to secure the Mobile Base to the mounting surface.

Powering the Dolphin Mobile Base
Note: Hand Held Products recommends that you leave the Mobile Base connected to its power source at all times.

The Mobile Base is powered via the power connector on the bottom panel; see Bottom Panel on page 13-3. Both the power and serial connectors are straight out, not at an angle. The Mobile Base must be powered by a 12 to 48 volt DC source.
Establishing Communication with the Mobile Base

The Mobile Base RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any standard RS-232 device using a standard serial cable and communications software.

Requirements

To use the HomeBase for communications, you need the following equipment:
- A Mobile Base powered by a power cable and power adapter cable from Hand Held Products
- The RS-232 communications cable
- ActiveSync v4.1 or above on the host workstation

To Install the Mobile Base for Communication

Note: You must be using ActiveSync 4.1 or higher.

1. Plug in the power supply and connect it to the back of the Mobile Base.
2. Plug the RS-232 communication cable into the back of the Mobile Base.
3. Connect the communication cable into the back of the workstation.
4. At this point, the hardware is installed and operating.
   You may need to reboot your workstation to complete the installation process.

Establishing ActiveSync Communication with the Mobile Base

The Dolphin terminal is usually auto-detected and configured by ActiveSync based on the communication cable. If you are using an RS-232 cable, ActiveSync will usually set up an RS-232 connection.

For more details, see Establishing ActiveSync Communication on page 7-2.

Connecting the Cables

Connect the Mobile Base to the host computer or other device by plugging an RS-232 serial cable into the RS-232 Communications Port on the bottom of the Mobile Base. Plug the other end of the RS-232 serial cable into the correct port on the host RS-232 device.

The wiring of your cable depends on whether the other device is set up as a Data Communications Equipment (DCE) or Data Terminal Equipment (DTE) device.

The Mobile Base Communication Port is configured as a DCE device. To communicate with a DTE device such as a computer, use a standard (or straight-through) RS-232 cable. To communicate with a DCE device, use either a null modem adapter in line with a standard RS-232 cable, or a null-modem serial cable.
RS-232 Pin Configuration

Refer to this table if you want to make your own cables. To do so, you must determine if your host RS-232 device is
• 9-pin or 25-pin and
• configured as a DCE or DTE device.

Mobile Base Serial Connector

The following diagram displays the pin diagram of the serial connector of the bottom panel of the Mobile Base.

Note: Signals referenced are for a DTE device.

The Mobile Base connector is straight to the printed circuit board (PCB). The ninth pin sends 500mA at 5V power out. This can power a peripheral device, such as a mobile printer, as long as that peripheral device can accept 500mA at 5V.
**Overview**

The Dolphin ChargeBase is a four-slot charging cradle that can power four Dolphin terminals, and charge their main batteries in less than four hours.

**Charging**

The Dolphin ChargeBase completes a full charge of the main battery pack in less than four hours. The ChargeBase also provides power to the intelligent battery charging system in all Dolphin terminals that senses when a full charge has been achieved and switches to a trickle charge to maintain the full charge.

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion batteries. The process monitors changes in temperature, current, and voltage.

**Convenient Storage**

Intelligent battery charging makes the Dolphin ChargeBase a safe and convenient storage receptacle for your Dolphin terminal.

**Capacity**

The ChargeBase can hold up to four Dolphin terminals. Each charging slot charges each terminal independently of the other slots.

---

Use only Dolphin 9500 Series peripherals, power cables, and power adapters. Use of peripherals, cables, or power adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.

---

**Dolphin ChargeBase Parts and Functions**

**Front Panel**

---

**Terminal Wells**

The ChargeBase contains four terminals wells. Each well

- Holds and charges the main battery pack of one Dolphin terminal.
- Contains the companion to the industrial-grade, 17-pin connector on the bottom panel of Dolphin terminals.
- Has two LEDs on the front: the Dock LED and the Charge LED.

**Dock LED**

Each terminal well displays a Dock LED on the front that lights solid green when a terminal is properly seated, which means that the terminal and the base are connected.
Charge LEDs

Each terminal well displays a Charge LED on the front that lights green to indicate charging. For details, see Charging Terminals in the ChargeBase on page 14-4.

Back Panel

Power Supply Connector

This connector receives input from the power adapter. Plug the power connector cable from the power adapter into this connector. There is no ON/OFF switch on the back panel of the ChargeBase. The power switch is on the power adapter.

Power Supply

The ChargeBase includes a power supply that contains a power adapter to ensure the proper voltage. The power adapter is plugged into standard AC/DC outlets.
Supplying Power to the ChargeBase

⚠️ Using a non-Hand Held Products power adapter voids your warranty and could result in serious damage to the circuitry of the Dolphin ChargeBase.

1. Be sure the power switch on the power adapter is in the OFF position.
2. Plug the power cord into the power adapter.
3. Plug the power connector cable into the power connector on the back panel of the ChargeBase.
4. Plug the power cord into a standard wall outlet.
5. On the power adapter, turn the power switch to the ON position. The LEDs illuminate as the ChargeBase powers up.
6. The ChargeBase is ready to begin charging terminals.

Inserting and Removing Terminals

1. To insert the terminal, hold the terminal with the bottom panel perpendicular to the base.
2. Slide the terminal into the well until the Dock LED lights solid green.
3. Charging begins immediately.

Note: To remove a terminal, grasp it firmly in your hand and lift it up and out of the terminal well. The LEDs for the terminal well turns off.
Charging Terminals in the ChargeBase

The Dolphin ChargeBase charges the main battery of each terminal in less than four hours. The ChargeBase uses the intelligent battery charging system incorporated into all Dolphin terminals that prevents overcharging. This means that Dolphin terminals may be stored in the ChargeBase indefinitely without damage to the terminals, battery packs, or the ChargeBase.

1. Power the ChargeBase; see Supplying Power to the ChargeBase on page 14-3.
2. Insert a terminal into a terminal well; see Inserting and Removing Terminals on page 14-3.
3. The Charge LED lights green to indicate that the terminal is powered and charging.

Mounting the ChargeBase

The Dolphin ChargeBase should be mounted to a dry, stable surface. When choosing a location, always bear in mind that:

- The mounting location must allow users easy access to the power connector.
- The ChargeBase should be oriented so that users can easily read the labels.

Bottom Panel

The bottom panel of the Dolphin ChargeBase offers two mounting options: insert a DIN Rail for desk mounting or use mounting brackets with the available screw slots for wall mounting.

![Diagram of Bottom Panel](image-url)
Using the DIN Rail

All Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom panel to enable secure mounting.

1. Slide the DIN Rail into the DIN Rail slot on the bottom panel.

2. Turn the ChargeBase and DIN Rail right side up.

3. Secure the DIN Rail to a stable, flat horizontal surface.
Using the Wall Mount Kit

Wall mount kits can be purchased separately to secure the ChargeBase to a wall or other vertical surface. For the ChargeBase, you need to purchase two kits so that you have two mounting brackets, one for each end of the ChargeBase. Each mounting bracket contains an open slot in the back to accommodate the connector cables.

1. Insert the head of each screw into the round end of each of the four screw slots on the bottom panel. Slide each screw towards the narrow end of the screw slot.

2. Use a washer/nut set on each screw to secure the screw in each slot.

3. Attach the bottom panel to the two mounting brackets.
4. Using the remaining washer and nut sets, secure the mounting brackets to the bottom panel.

5. Secure the mounting brackets to an appropriate vertical surface.
QuadCharger

Overview

The Dolphin QuadCharger is a four-slot charging station that provides intelligent battery management for the Li-ion battery packs used in Dolphin terminals. Batteries charge in less than four hours. The fourth slot features a battery analyzer that completely resets a battery, then displays its remaining capacity.

Compatibility

The QuadCharger is compatible with the Li-ion batteries that power the Dolphin terminals.

Charging Process

Each charging slot works independently of the other three. As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-ion batteries. The process monitors changes in temperature, current, and voltage and resets the battery pack.

Capacity

The Dolphin QuadCharger holds four Li-ion batteries.

⚠️ Use only Dolphin 9500 Series peripherals, power cables, and power adapters. Use of peripherals, cables, or power adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

⚠️ Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products in Dolphin 9500 Series terminals will void your warranty and may result in damage to the Dolphin terminal or battery.
Dolphin QuadCharger Parts and Functions

Top Panel

Charging Slots
The QuadCharger contains four charging slots. Each slot holds one Li-ion battery and charges it independently of the other slots. When a battery is placed in each slot, it immediately begins charging.

Charge/Analyze Slot
This is the fourth slot and the only one that can be used to analyze a battery. When a battery is placed in this slot, it begins charging just as it does in the other three slots. However, if you press the ANALYZE button, it runs the battery in this slot through the complete Analyze cycle. For more information, see Using the Battery Analyzer on page 15-5.

Battery Capacity Indicator LEDs
These LEDs give a readout of the remaining battery capacity after it has run through a complete analyze cycle. For more information, see Battery Capacity Indicator LEDs on page 15-2.

Analyze Button
Press this button to start a battery analyze cycle; see Using the Battery Analyzer on page 15-5.

Status LEDs
A status LED is located above each of the four battery slots. The color of the LED indicates the charge status of the batteries in its slot.

<table>
<thead>
<tr>
<th>Status LED color</th>
<th>This color indicates that the battery in the slot…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Has completed its charge cycle and is ready for use.</td>
</tr>
<tr>
<td>Orange</td>
<td>Is being charged at a maximum charge rate.</td>
</tr>
<tr>
<td>Red</td>
<td>Encountered an error during the most recent charge cycle.</td>
</tr>
</tbody>
</table>
Back Panel

Power Switch

Toggle the power switch to turn the QuadCharger on and off.

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input voltages between 90-265 volts.

Supplying Power to the QuadCharger

The QuadCharger must be connected to a power source via the Hand Held Products power adapter cable so that voltage is adjusted appropriately.

1. Locate the AC power adapter cable and plug it into the power source.
2. Connect the power cable to the power adapter.
3. Connect the power cable to the supply connector on the back of the QuadCharger.
4. Press the power switch to the ON position. The power LED illuminates green, and the charger performs a self-diagnostic test that lasts approximately five seconds.
**Inserting and Removing Battery Packs**

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the battery into place with a hinging motion. The Status LED for that particular slot illuminates orange when the battery has been properly inserted.

To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a hinging motion.

**Storing Batteries**

**Recommendations**

To maintain top performance from batteries, follow these storage guidelines:

- Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
- For prolonged storage, do not keep batteries stored in a charger that is connected to a power source.

**Charging Batteries in the QuadCharger**

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on charging. The recommended temperature range is 50° to 95° F (10° to 35°C).

1. Set up the QuadCharger.
2. Supply the QuadCharger with power and turn the power switch on.
3. Insert batteries into the appropriate slots.
   - The Status LED for each slot turns orange to indicate that the battery has begun a charge cycle.
4. When the Status LED turns green, the battery in the slot has completed charging.
Using the Battery Analyzer

Purpose
Using the Charge/Analyze slot helps you monitor the charge capacity of Li-ion batteries over time.

Location
The battery analyzer is located in the fourth slot - named the Charge/Analyze slot - of the ChargeBase. Only a battery placed in this slot can be run through an Analyze cycle. This slot contains Battery Capacity LEDs along the right side.

Analyze Cycle
The Analyze cycle is initiated when a battery is placed in the Charge/Analyze slot and the ANALYZE button is pressed. In an Analyze cycle, batteries are completely discharged, then recharged to capacity. The length of time it takes for a battery to complete the Analyze cycle varies depending on the initial state of the battery’s charge. Minimum time is 8 hours, maximum time is 12 hours.

Battery Capacity LEDs
The Battery Capacity LEDs are located along the right side of the Charge/Analyze slot. Each LED equates to 10% battery capacity. These LEDs display the capacity of the battery at the end of the Analyze cycle. Battery capacity is displayed as a percentage of measured capacity/rated capacity.

Status LED
The Charge/Analyze slot also contains a standard status LED in the upper, left corner of the slot. When this slot is used for regular charging, this LED operates in the usual manner; see Status LEDs on page 15-2. When this slot is being used to analyze a battery, the Status LED functions as follows:

<table>
<thead>
<tr>
<th>Status LED color</th>
<th>Indicates that the battery in the slot…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Has completed the Analyze cycle.</td>
</tr>
<tr>
<td>Flashing Orange</td>
<td>Is being analyzed.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Encountered an error during the Analyze cycle.</td>
</tr>
</tbody>
</table>

To Analyze a Battery
1. Insert the battery into the Charge/Analyze slot (the fourth).
2. Press the ANALYZE button. The Status LED flashes orange to indicate that the analyzing cycle has begun.

⚠️ The Dolphin QuadCharger is accumulating battery pack information during the entire Analyze cycle. Do NOT remove the battery until the cycle has been completed.

3. Upon completion of the Analyze cycle, the Status LED lights solid green, and the Battery Capacity Indicator LEDs display the battery’s capacity.

You can verify a battery’s capacity by installing the battery in a terminal and checking the power; see Power on page 6-12.
Mounting the QuadCharger

The Dolphin QuadCharger should be on a dry, stable surface. To easily adapt the QuadCharger to your environment, it can be mounted on a flat, horizontal surface such as a desktop or workbench, or a flat, vertical surface such as a wall.

When choosing a location, always bear in mind that

- the mounting location must allow users easy access to power switch and power connector.
- the QuadCharger should be oriented so that users can easily insert and remove battery packs and read the labels, especially for the Battery Analyzer.

Desk Mounting

All Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom panel to enable secure mounting. To mount the QuadCharger, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts and bolts, secure the DIN rail to the desk or wall.

The following graphic displays how to mount the QuadCharger to a desk:
Wall Mounting

The following graphic displays how to mount a QuadCharger to a wall:
Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions. If problems persist, please contact Hand Held Products Technical Support.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Status LED does not come on when I insert a battery pack into the</td>
<td>Check the power connections on the Dolphin QuadCharger; make sure</td>
</tr>
<tr>
<td>Dolphin QuadCharger</td>
<td>the POWER switch is ON and the battery pack is properly seated.</td>
</tr>
<tr>
<td>The Status LED lights red during charging.</td>
<td>Try to charge the battery in one of the other charging slots. If the</td>
</tr>
<tr>
<td></td>
<td>red Status LED comes on again, then the problem is associated with</td>
</tr>
<tr>
<td></td>
<td>the battery pack. If the red status stays with the charging slot, the problem is associated with the charging circuitry.</td>
</tr>
<tr>
<td>The Status LED lights red and stays on without a battery in the</td>
<td>An error occurred during the self-diagnostic test for that particular</td>
</tr>
<tr>
<td>charging slot.</td>
<td>charging pocket. Call Hand Held Products Product Service and request</td>
</tr>
<tr>
<td></td>
<td>an RMA. For additional warranty and return information, see Customer Support on page 16-1.</td>
</tr>
</tbody>
</table>

For additional warranty and return information, see Customer Support on page 16-1.
Product Service and Repair

Hand Held Products provides service for all its products through service centers throughout the world. To obtain warranty or non-warranty service, return the unit to Hand Held Products (postage paid) with a copy of the dated purchase record attached. Contact the appropriate location below to obtain a Return Material Authorization number (RMA #) before returning the product.

North America
Telephone: (800) 782-4263
Fax: (803) 835-8012
E-mail: naservice@handheld.com

Latin America
Telephone: (800) 782-4263
Fax: (239) 263-9689
E-mail: laservice@handheld.com

Brazil
Telephone: +55 (21) 2178-0500
Fax: +55 (21) 2178-0505
E-mail: brservice@handheld.com

Mexico
Telephone: +52 (55) 5203-2100
Fax: +52 (55) 5531-3672
E-mail: mxservice@handheld.com

Europe, Middle East, and Africa
Telephone: +31 (0) 40 2901 633
Fax: +31 (0) 40 2901 631
E-mail: euservice@handheld.com

Asia Pacific
Telephone: +852-2511-3050
Fax: +852-2511-3557
E-mail: apservice@handheld.com

Japan
Telephone: +813-5770-6312
Fax: +813-5770-6313
E-mail: apservice@handheld.com

Online Product Service and Repair Assistance

You can also access product service and repair assistance online at www.handheld.com.
Technical Assistance

If you need assistance installing or troubleshooting, please call your Distributor or the nearest Hand Held Products technical support office:

North America/Canada
Telephone: (800) 782-4263
Fax number: (315) 554-6705
E-mail: natechsupport@handheld.com

Latin America
Telephone: (803) 835-8000
Telephone: (800) 782-4263
E-mail: latechsupport@handheld.com

Brazil
Telephone: +55 (21) 2178-0500
Fax: +55 (21) 2178-0505
E-mail: brsuporte@handheld.com

Mexico
Telephone: (800) 835-8000
E-mail: latechsupport@handheld.com

Europe, Middle East, and Africa
Telephone: +31 (0) 40 7999 393
Fax: +31 (0) 40 2425 672
E-mail: eurosupport@handheld.com

Asia Pacific
Telephone - Hong Kong: +852-3188-3485 or 2511-3050
Telephone - China: +86 21 6361 3818
E-mail: aplechsupport@handheld.com

Japan
Telephone: +813 5770-6312
E-mail: apletechsupport@handheld.com

Online Technical Assistance
You can also access technical assistance online at www.handheld.com.

For Further Information
To download the full User’s Guide for these products, visit our website at www.handheld.com.
Limited Warranty

Hand Held Products, Inc. ("Hand Held Products") warrants its products to be free from defects in materials and workmanship and to conform to Hand Held Products’ published specifications applicable to the products purchased at the time of shipment. This warranty does not cover any Hand Held Products product which is (i) improperly installed or used; (ii) damaged by accident or negligence, including failure to follow the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) modification or alteration by the purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface connections, (C) static electricity or electro-static discharge, (D) operation under conditions beyond the specified operating parameters, or (E) repair or service of the product by anyone other than Hand Held Products or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by Hand Held Products for the product at the time of purchase ("Warranty Period"). Any defective product must be returned (at purchaser’s expense) during the Warranty Period to Hand Held Products’ factory or authorized service center for inspection. No product will be accepted by Hand Held Products without a Return Materials Authorization, which may be obtained by contacting Hand Held Products. In the event that the product is returned to Hand Held Products or its authorized service center within the Warranty Period and Hand Held Products determines to its satisfaction that the product is defective due to defects in materials or workmanship, Hand Held Products, at its sole option, will either repair or replace the product without charge, except for return shipping to Hand Held Products.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HAND HELD PRODUCTS’ RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS LIMITED TO THE REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT. IN NO EVENT SHALL HAND HELD PRODUCTS BE LIABLE FOR INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY LIABILITY OF HAND HELD PRODUCTS ARISING IN CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER SUCH LIABILITY ARISES FROM A CLAIM BASED ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE ACTUAL AMOUNT PAID TO HAND HELD PRODUCTS FOR THE PRODUCT. THESE LIMITATIONS ON LIABILITY SHALL REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HAND HELD PRODUCTS MAY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES. SOME STATES, PROVINCES, OR COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

Hand Held Products extends these warranties only to the first end-users of the products. These warranties are non-transferable.

The limited duration of the warranty for Dolphin 9500 Series is as follows:

- Dolphin 9500 and Dolphin 9550 terminals with an integrated imager are covered by a two-year limited warranty.
- Dolphin 9501 and Dolphin 9551 terminals with an integrated laser engine are covered by a one-year limited warranty.
- Touch screens are covered by a one-year limited warranty.
- Dolphin HomeBase, Mobile Base, ChargeBase, Net Base, Mobile Charger, and QuadCharger are covered by a one-year limited warranty.
- The limited duration of the warranty for batteries is one year.

Use of any battery not sold/manufactured by Hand Held Products may damage the terminal and/or the battery and will void the warranty. Batteries returned to Hand Held Products may be rejected if the battery condition does not meet factory specifications. Batteries should be returned to Hand Held Products in the original charge state in the original shipping container.

Use of any peripheral with the Dolphin terminal not manufactured/sold by Hand Held Products will void the warranty. This includes but is not limited to: cables, power supplies, cradles, and docking stations.

Use only power adapters approved for use by Hand Held Products. Failure to do so may result in improper operation or damage to the unit and will void the warranty.

How to Extend Your Warranty

Hand Held Products offers a variety of service plans on our hardware products. These agreements offer continued coverage for your equipment after the initial warranty expires. For more information, contact your Sales Representative, Customer Account Representative, or Product Service Marketing Manager from Hand Held Products, or your Authorized Reseller.